Computer Fundamentals and Office Automation

Course Designer and Acquisition Editor

Centre for Information Technology and Engineering
Manonmaniam Sundaranar University
Tirunelveli
# CONTENTS

## Lecture 1
- Fundamentals of Computers
- Classification of Computers
- Input & Output Devices
- Memory & Operating System
- DOS Commands

## Lecture 2
- User Interface
- New Features of Windows 95
- Desk Top
- Graphical Device Interface
- Dynamic Data Exchange
- Object Linking & Embedding
- Net Working.

## Lecture 3
- StartButton
- Programs
- Documents
- Setting
- Find
- Help
- Run
- Shut Down.

## Lecture 4
- Files & Folders
- Configuring Printers
- Installing Programs
- System Tools
<table>
<thead>
<tr>
<th>Lecture 5</th>
<th>62</th>
</tr>
</thead>
<tbody>
<tr>
<td>Features of MS-Word 2000</td>
<td></td>
</tr>
<tr>
<td>Getting Started</td>
<td></td>
</tr>
<tr>
<td>Components of Word Window</td>
<td></td>
</tr>
<tr>
<td>Creating Document</td>
<td></td>
</tr>
<tr>
<td>Typing Text, Saving and Closing</td>
<td></td>
</tr>
<tr>
<td>Opening an Existing</td>
<td></td>
</tr>
<tr>
<td>Printing &amp; Previewing Documents</td>
<td></td>
</tr>
<tr>
<td>Switch between Multiple Documents</td>
<td></td>
</tr>
<tr>
<td>Quitting Word.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lecture 6</th>
<th>78</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Cut, Copy &amp; Paste</td>
<td></td>
</tr>
<tr>
<td>Find &amp; Replace</td>
<td></td>
</tr>
<tr>
<td>Fonts &amp; Paragraphs</td>
<td></td>
</tr>
<tr>
<td>Styles--Bulleting &amp; Numbering Text</td>
<td></td>
</tr>
<tr>
<td>Headers &amp; Footers</td>
<td></td>
</tr>
<tr>
<td>Inserting Page numbers</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lecture 7</th>
<th>107</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Text boxes &amp; frame</td>
<td></td>
</tr>
<tr>
<td>Working with Pictures</td>
<td></td>
</tr>
<tr>
<td>Working with Objects</td>
<td></td>
</tr>
<tr>
<td>Inserting Place Comments</td>
<td></td>
</tr>
<tr>
<td>Working with Tables</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lecture 8</th>
<th>131</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working with Mail Merge</td>
<td></td>
</tr>
<tr>
<td>Working with Main Document</td>
<td></td>
</tr>
<tr>
<td>Merging Envelops &amp; Labels</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lecture 9</th>
<th>154</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding Books &amp; Sheets</td>
<td></td>
</tr>
<tr>
<td>Entering Work Sheet Data</td>
<td></td>
</tr>
<tr>
<td>Auto Fill</td>
<td></td>
</tr>
<tr>
<td>Editing Work sheet data</td>
<td></td>
</tr>
</tbody>
</table>
Lecture 10 163
- Working With Work Sheets
- Working With Ranges
- Types Of References
- Working With Formulas

Lecture 11 166
- What to Print
- Producing Charts
- Using Template
- Using View
- Linking With Work Books
- About Formula Arrays.

Lecture 12 179
- Pivot Table
- Using Scenarios To Perform What If Analysis
- Goal Seeking & Solver

Lecture 13 179
- What is Power Point
- Auto Content Wizard
- Creating Presentation
- Using Design Templates
- Creating Blank Presentation
- Inserting Objects
- PowerPoint Views
- Saving & Printing Your Works
- Working With Colors & Transitions
- About Slide Show Timings
- Navigating During Presentation

Lecture 14 212
- Introduction
- Terms and Definitions
- Database
- Tables
- Forms
- Query
### Lecture 15

- Introduction
- Starting FrontPage
- Microsoft FrontPage 2000 Controls
- FrontPage Fundamentals
- The Web and Web Pages
- FrontPage Server Extensions
- Creation your own WebPage

### Lecture 16

- Features Of Out Look
- Outlook Interfaces
- Using Calendars
- Using Tasks
- Using Notes-Binders

### Lecture 17

- Introduction
- Web Servers & Clients
- Looking at Internet Connections

### Lecture 18

- Intranet
- HTML
- Creating Html files using Office 2000
- Create Hyper Links

### Syllabus
**Lecture 1**

**Introduction to Computers**

### Objectives

In this Lecture you will learn the following:

- What is a Computer?
- Components of a computer
- Input Devices
- Output Devices
- CPU
- Primary & Secondary storage
- Hardware & Software
- OS & DOS Commands
## Coverage Plan

### Lecture 1

<table>
<thead>
<tr>
<th>Section</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>Snap Shot</td>
</tr>
<tr>
<td>1.2</td>
<td>What is a Computer</td>
</tr>
<tr>
<td>1.3</td>
<td>Fundamentals of Computers</td>
</tr>
<tr>
<td>1.4</td>
<td>Classification of Computers</td>
</tr>
<tr>
<td>1.5</td>
<td>Input &amp; Output Devices</td>
</tr>
<tr>
<td>1.6</td>
<td>Memory &amp; Operating System</td>
</tr>
<tr>
<td>1.7</td>
<td>DOS Commands</td>
</tr>
<tr>
<td>1.8</td>
<td>Short Summary</td>
</tr>
</tbody>
</table>
1.1 Snap Shot

In this lecture you will learn the Fundamentals of computers and its Classification. You will learn What are the Input Devices and Output Devices, Memory Units, OS and some DOS Commands.

1.2 What is a Computer?

A Computer is a group of electronic devices used to process data. In the 1950s, computers were massive, special-purpose machines that only huge institutions such as governments and universities could afford. Primarily, these early computers performed complex numerical tasks, such as calculating the precise orbit of Mars or planning the trajectories of missiles or processing statistics for the Bureau of the census. Although computers were certainly useful for tasks like these, it soon became apparent that they could also be helpful in an ordinary business environment.

In the 1960s, modern computers began to revolutionize the business world. IBM introduced its System/360 mainframe computer in April 1964 and ultimately sold over 33,000 of these machines. As a result of the commercial success of its System/360, IBM became the standard against which other computer manufacturers and their systems would be measured for years to come.

In the 1970s, Digital Equipment Corporation (DEC) took two more giant steps toward bringing computers into mainstream use with the introduction of its PDP-11 and VAX computers. These models came in many sizes to meet different needs and budgets. Since then, computers continue to shrink in size while providing more power for less money. Today, the most common type of computer you will see is called a personal or PC, because it is designed to be used by just one person at a time. Despite its small size the modern personal computer is more powerful than any of the room-sized machines of the 1960s.

1.3 Fundamentals of Computers

A system can be defined as a set of components that work together to accomplish one or more common goals. A Computer is nothing but a system accepting input from a user, process the same, and giving the output in the required format. In other words a computer is a machine , which can be programmed to compute. The characteristics of a computer are:
• Response to a specific set of commands called as Instructions.
• Execution of a prerecorded list of instructions called Program

1.4 Classification of Computers

There are two basic categories of computers: Special purpose and General Purpose. Special purpose computers are designed to perform a specific task such as keeping time in a digital watch or programming a video cassette recorder. In the case of General purpose computers they are adapted to perform any number of functions or tasks. Computers based on their size, cost and performance can be further classified into four types
1. Super Computers
2. Main Frames
3. Mini Computers
4. Micro Computers

Super Computers

Supercomputers are the most powerful computers made. They are built to process huge amounts of data. For example, scientists build models of complex processes and simulate the processes on a supercomputer. One such process is nuclear fission. As a fissionable material approaches a critical mass, the researchers want to know exactly what will happen during every nanosecond of a nuclear chain reaction. A supercomputer can model the actions and reactions of literally millions of atoms as they interact.

Because computer technology changes so quickly the advanced capabilities of a supercomputer today may become the standard features of a PC a few years from now, and next year’s supercomputer will be vastly more powerful than today’s.

Main Frames

The largest type of computer in common use is the mainframe. Mainframe computers are used where many people in a large organization need frequent access to the same information, which is usually organized into one or more huge databases. For example, consider the Texas Department of Public Safety,
where people get their drivers’ licenses. This state agency maintains offices in every major city in Texas, each of which has many employees who work at computer terminals. A terminal is a keyboard and screen wired to the mainframe. It does not have its own CPU or storage; it is just an input/output (I/O) device that functions as a window into a computer located somewhere else. The terminals at the Public Safety offices are all connected to a common database on a mainframe in the state capital. A mainframe computer controls the database that handles the input and output needs of all the terminals connected to it. Each used has continuous access to the driving records and administrative information for every licensed driver and vehicle in the state—literally, millions of records. On smaller systems, handling this volume of user access to a central database would be difficult and more time consuming.

No one really knows where the term mainframe originated. Early IBM documents explicitly define the term frame as an integral part of a computer: “the housing,... hardware support structures,... and all the parts and components therein.” It may be that when computers of all sizes and shapes began to appear in computer environments, the big computer was referred to as the main frame, as in the main computer, and that eventually the term was shortened to one word, mainframe.

Note :- The main difference between a super computer and a mainframe is that a super computer channels all its power into executing a few programs as fast as possible whereas a mainframe uses its power to execute many programs concurrently.

Micro Computers

Microcomputers are the smallest type of computers available and are popularly known as personal computers. Personal computers are small relatively inexpensive computers that are designed for individual users. In terms of cost, they can range anywhere from a few hundred dollars to over few thousand dollars. Personal computers are designed for word processing, accounting, desktop publishing and database management applications.

Personal computers first appeared in the late stage of 1970. One of the first and most popular computers was Apple 2, which was first introduced in 1977 by Apple Computer. During the late 1970s and early 1980s different new models
and different operating systems started appearing daily. Then in 1981, International Business Machine (IBM) entered in the fray with the first personal computer called IBM PC. It became an overnight success and was the people's choice for personal computer. One of the few companies, which survive IBM's onslaught, is Apple Computer.

Today the world of personal computers is divided between Macintosh and Personal Computers. The principal characteristics of PC's are that they are single-user systems. But they can be linked together to form a network. In terms of power there is a great variation. At the high-end, the distinction between personal computers and workstations has faded where high-end models of Macintosh and Personal Computer offer the same computing power and graphics capability.

**Mini Computers**

When Digital Equipment Corporation (DEC) began shipping its PDP series computers in the early 1960s, the press dubbed these machines minicomputers because of their small size compared to other computers of the day. Much to DEC’s chagrin, the name stuck.

The best way to explain the capabilities of a minicomputers is to say that they lie somewhere between those of mainframes and those of personal computers. Like mainframes, minicomputers can handle a great deal more input and output than personal computers can. Although some minis and designed for a single user, many can handle dozens or even hundreds of terminals.

A company that needs the power of a mainframe but cannot afford such a large machine may find that a minicomputer suits its needs nicely. The major minicomputer manufacturers include DEC, Date General, IBM, and Hewlett-Packard.

**1.5 Input devices and Output devices**

Computers would be useless if they did not provide a means to interact with users. They could not receive instructions or deliver the results of their work. Input delivers accept data and instructions from the user and output devices
return processed data back to the user. The generic term device refers to any piece of hardware.

The function of an output device is to present processed data to the user. The most common output devices are the display screen, known as the monitor and the printer. The computer sends output to the monitor when the user needs only to see the output. It sends output to the printer when the user needs a paper or card, copy. In addition, just as computers can accept sound as input they can include stereo speakers as output devices to produce sound.

Input Devices

Input devices accept data and instructions from the user, and output devices return processed data back to the user. The generic term device refers to any piece of hardware.

The most common input device is the keyboard, which accepts letters, numbers, and commands from the user. In addition, people often use a mouse, which lets them draw on the screen and give commands by moving the mouse on a flat surface and pressing its buttons. Some other input devices are trackballs, joysticks, scanners, digital cameras, and microphones.

The mouse and trackball allow you to draw or point on the screen. For playing quick-moving video games, the joystick is especially well suited. A scanner can copy a printed page into the computer’s memory, eliminating the time-consuming step of keying input manually. Digital cameras record live images that can be viewed and edited on the computer. Similarly, attaching a microphone or CD player to the computer allows you to add the sound of a voice or a piece of music.

Key Board

The keyboard resembles that of a typewriter with additional keys to handle control functions. The computer keyboard has three categories of keys:

- Alphanumeric keys
- Special keys
- Function keys
Alphanumeric keys comprise of alphabets, numbers and other characters. Special keys perform specific tasks such as Enter or Return key, Backspace key, Del key, Ins key, Shift key, Esc key etc.

The function keys are used to perform a set of operations in a single keystroke. In other words, they can be shorthand for a sequence of operations. Most programs use F1 function key for help operation.

Mouse

The mouse is now one of the most popular input devices. The mouse as the name suggests, is a small box with a round ball underneath and one or more buttons on the top. A cable attaches the mouse to the terminal or the computer. The mouse allows you to manipulate a pointer or an arrow on screen. As the mouse is rolled across a flat surface, the screen cursor too moves in that direction.

Output Devices

The function of an output device is to present processed data to the user. The most common output devices are the display screen, known as the monitor, and the printer. The computer sends output to the monitor when the user needs only to see the output. It sends output to the printer when the user needs a paper, or hard, copy. In addition, just as computers can accept sound as input, they can include stereo speakers as output devices to produce sound.

Some types of hardware can act as both input and output devices. One example is the touch screen, a type of monitor that displays buttons you can touch. The most common types of devices that can perform both input and output, however, are communication devices, which connect one computer to another - a process known as networking. Among the many kinds of communication devices, the most common are modem, which allow computers to communicate through telephone lines, and network interface cards, which let users connect a group of computers to share data and devices.
Visual Display Unit (VDU)

The unit that resembles a TV screen is what is called as the monitor or commonly known as Visual Display Unit. Most monitors use a Cathode Ray Tube (CRT) that looks like a television picture tube. There is a video controller that controls the formation of images. The video controller and memory together are called as the display adapter.

In the graphics mode, the display screen can be divided into thousands of picture elements or pixels. The number of pixels on screen determines the resolution of the monitor. In the text mode, the display adapters can display alphanumeric data and can be used to enter and retrieve letters, numbers and special characters.

Display adapters can be classified on the basis of

- Resolution
- Colour
- Display mode

The Monitors normally comes as 14", 15" or 17" in size.

Printers

Printers are a primary output device used to prepare permanent documents. Two printers commonly used with the PC are the dot-matrix printer and Laser printer.

Plotters

The graphic plotter can be used for high quality diagrams. A pen is mounted on an arm by motors along the paper up or down to makes contact with the paper. Positioning is done in the form of x and y coordinates. Different types of plotters use either a combination of paper and pen movements or only the pen moving on a fixed paper.
1.6 Memory and Operating System

Memory is the computer’s electronic scratchpad. Programs are loaded into and run from memory. Data used by the program is also loaded into memory for fast access. The most common type of memory is called random access memory or RAM. As a result the term memory is commonly used to mean RAM.

Perhaps the most important thing to remember about RAM is that it is volatile, so it needs a constant supply of power. When you turn off a computer, everything in RAM disappears. As you will soon learn this is why you frequently have to save everything you are working on to a storage device.

One of the most important factors affecting the speed and power of a computer is the amount of RAM it has. Generally, the more it can do. The most RAM a computer has, the more it can do. The most common measurement unit for describing a computer’s memory is the byte the amount of memory it tames to store a single character. When people talk about memory, the numbers are often so large that it is useful to use a shorthand term to describe the values:

- Kilobyte (KB) → 1024 bytes
- Megabyte (MB) → 1024 kilobytes
- Gigabyte (GB) → 1024 megabytes

Today’s Personal computers commonly have from 8 to 32 million bytes of memory or 8 to 32 MB.

Data processing systems often require access to a large amount of memory for which main memory is not enough. Memory can be classified into 2 types namely

- Primary
- Secondary

Programs and data are stored in the memory unit of the CPU during processing. Memory consists of a number of storage locations. A unique number called address identifies each storage location. During processing, data may be stored in any location. Primary storage or main memory is of two types.
• Random Access Memory (RAM)
• Read Only Memory (ROM)

There are certain essential functions that the computer must perform when it is switched on. For example, connections have to be established within the various components of the computer and its peripherals. A series of programs or micro programs are required to perform these low-level functions. These programs are hardwired onto the Read Only Memory (ROM) chips at the time of manufacture.

ROM is non-volatile that is when the computer is switched off, the data on these chips is not lost. When the machine is switched on, the memory, which is available to you, is called as Random Access Memory. The data can be read from and written to any location within RAM by specifying the relevant address. New data can be written onto any location, however, remember that any existing data at this location is overwritten.

Unlike ROM, RAM is volatile. When the power goes off, the data is lost. It is necessary to store the data that is important onto a secondary storage device.

Units of Storage

It is possible for a computer to function with just processing, memory input and output devices. To be really useful however it also needs a place to deep program, files and related data when it is not using them. The purpose of storage is to hold data.

It is helpful to think of storage as an electronic file cabinet and to think of RAM as an electronic worktable. When you need to work with a program or a set of data, the computer locate then in the file cabinet and puts a copy on the table. After you have finished working with the program or data, you put the new version into the file cabinet. There are three major distinction between storage and memory:

1. There is more room in storage than in memory, just as there is, ore room in a file cabinet than there is on a tabletop.
2. Storage retains its contents when the computer is turned off, whereas the programs or the data you put into memory disappear when you shut down the computer.
3. Storage is much cheaper than memory.

The most common storage medium is the magnetic disk. A disk is a round, flat object that spins around its center. Read write heads which are similar to the heads of a tape recorder or VCR float above and below the disk near its surface.

The device that holds a disk is called a disk drive. Some disks are built into the drive and are not meant to be removed and other kinds of drives allow you to remove and replace disks. Most personal computers have a non removable hard disk. In addition, there are usually one or two diskette drives which allow you to use removable diskettes. Typically a hard disk can store far more data than a diskette can, so the hard disk serves as the computer’s primary filing cabinet. Diskettes are used to load new programs or data onto the hard disk to trade data with other users, and to make backup copies of the data on the hard disk. Because you can remove diskettes from a computer they are encased in a plastic or vinyl cover to protect them from fingerprints and dust. The first diskettes, commonly used in the late 1970s were 8-inch diskettes. Because the vinyl cover was very thin, the diskette was flimsy or floppy. Hence came the name of floppy disk. Next came the 5.25 inch diskettes that were common in the early PCs. Finally the 3.5 inch diskette with its hard plastic shell appeared.

Other types of storage devices include CD-ROM drives, tape drives, optical drives removable hard drives and many others. The CD-ROM drive is the most common type after the hard and diskette drives. Compact disks or CDs are a type of optical storage device identical to audio CDs, that can store about 650MB or about 450 times as much information as a diskette. The type used in computers is called a CD-ROM, which stands for compact disk read only memory. The name implies that you cannot record over an audio CD.

Having looked at various ways of storing data and also devices that store it, let us look at the way the computer stores this data. The computer being an electronic device runs on electricity. It recognizes the flow of electricity in states of “on” or “off”. It in turn corresponds to the binary number system that has a base of two. Thus instead of 0-9, only the digits 0 and 1 are used.

Each alphanumeric character is now represented in a storage location as a combination of binary digits (0s and 1s) or bits to form a byte. A byte typically stores 8 bits. The higher units are called megabytes, gigabytes, terabytes, and petabytes.
8 bits  =  1 Byte
1024 bytes  =  1 Kilo Byte(KB)
1024 KB  =  1 Mega Byte(MB)
1024 MB =  1 Giga Byte(GB)
1024 GB  =  1 Tera Byte (TB)

**Hardware:**

When programs run, they need to use the computer’s memory, monitor, disk drives, and other devices, such as a printer, a modem, or a CD-ROM drive. The operating system is the intermediary between programs and hardware. In a computer network, the operating system also mediates between your computer and other devices on the network.

Hardware is nothing but physical apparatus or the machinery part of the computer, i.e. hard disk, floppy disk, etc…

**Software:**

Software is the part of the computer system, which enables the hardware to operate. Computer software can be divided into system software and application software. System software includes all the computer programs that run the computer, it also includes the documentation of how these programs operate. Application software includes the programs and related documentation that accomplish end-user data processing tasks.

**Operating System:**

When you turn on a computer, it goes through several steps to prepare itself for Use. The first step is a self-test. The computer identifies the devices that are attached to it counts the amount of memory available and does a quick check to see whether the memory is functioning properly. This routine is initiated by apart of the system software located in read –only memory a chip that contains brief permanent instructions for getting the computer started.

Operating system is a set of software that provides an interface between the machine and the user. An Operating System not only provides an interface between the user and the hardware, but also manages the memory, CPU, disks,
I-O management, and controls the execution of the programs. Operating System is a must for all computers ranging from mainframes and supercomputers to small personal computers.

1.7 DOS Commands

DOS is nothing but one of the operating system. At the DOS prompt the user can enter a command. DOS command can be classified into two categories.

1. INTERNAL DOS COMMANDS

2. EXTERNAL DOS COMMANDS

INTERNAL DOS COMMANDS are commands, which are used frequently and are stored in the Random Access Memory of the computer. They are also referred to as MEMORY RESIDENT COMMANDS.

EXTERNAL DOS COMMANDS are commands, which are used less frequently and are stored on the DOS Diskette. The commands are also referred to as DISKETTE RESIDENT COMMANDS.

File organization under DOS:

DOS stores data on the secondary storage devices in the form of files. A file is a collection of data, which has a certain unique name and occupies a certain amount of space (in bytes) on the disk. Each file is differentiated from the other by the file name. Thus, not two file on the disk have the same filename.

There are some rules associated with naming of files. A file name has two parts

The primary name
Extension name.

The primary name can be a maximum of 8 character and the extension name can be a maximum of 3 Characters.

Some Common DOS Commands:
The **DIR command**

The DOS directory command is used to display a list of files on a diskette. This command is an internal command.

**Format:**  

```
Dir
```

When the `dir` command is typed at the prompt it will display a list of the files contained on the default drive along with the following information:

- the size of the file in “bytes”
- the data when information or instructions were last placed in the file.
- The time when information or instructions were last placed in the file.

Let us see an example:

A> dir <Enter>

Volume in drive A is DOS  
Volume serial Number is 195E-79ec

<table>
<thead>
<tr>
<th>Filename</th>
<th>Extension</th>
<th>Size</th>
<th>Date</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>COUNTRY</td>
<td>SYS</td>
<td>17069</td>
<td>09-04-91</td>
<td>12:18</td>
</tr>
<tr>
<td>EGA</td>
<td>SYS</td>
<td>4885</td>
<td>09-04-91</td>
<td>10:10a</td>
</tr>
<tr>
<td>FORMAT</td>
<td>COM</td>
<td>14986</td>
<td>09-04-91</td>
<td>11:21</td>
</tr>
<tr>
<td>KEY</td>
<td>COM</td>
<td>32911</td>
<td>09-04-91</td>
<td>130P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23434324</td>
<td>BYTES</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>234343433</td>
<td>FREE</td>
<td></td>
</tr>
</tbody>
</table>

The first 3 lines identifies the diskette in the A drive by printing its volume label and Volume serial Number. The fourth line on words the directory listing follows.

The first column in the listing lists the filename. The second column lists the extension name. The third column gives information on the size of the file in bytes. The fourth column gives the date of creation of the file or the date when the file was last updated. The fifth column gives the time of file creation or last updation.

The last line tells how many files there are in the diskette and how many bytes of free or unused space there is on the diskette.
From the A>prompt, dir displays a listing of files on drive A. From B> prompt, dir displays a listing of files on drive B. By adding a drive letter identifier (such as A: or B: the dir command can also display a list of files on a different drive. For example, typing DIR B: at the A> prompt will list the files on B drive although the default dir is A. The dir command is also used to display information on a single file.

For example:

A>dir format <enter>

Volume in drive A is DOS.
Volume serial number is 939e-343d
Directory of A:
FORMAT COM 32323 09-09-98 12:11 a
3434 BYTES
1 File(s)

DIR command with various options

Dir /w This command displays the directory of a disk across the width of a screen.

Dir /p /p stands for the pause mode

Dir *. This lists all files with any primary name and any secondary name

Dir a*. This lists all files starting with “a” in the primary name and any extension.

Dir *. com lists all files with extension name “com”

Dir *. Lists all files with no extension name.

CLS Command:

CLS command clears the screen and the DOS prompt is moved to the top of the screen

A>cls <enter>
**Copy Command:**

COPY command is used to take another copy of a given file name.

Format:

A> copy  <source file name >  <destination file name >

Example:
A> copy text1.bas text2.bas

In the above example, the content of text.bas file will be copied into to text2.bas in the same directory. Like wise files from one floppy to another floppy also can be done.

**DEL Command:**

Del command is used to delete a file or group of files in the floppy.

Format :

A > del <file name>

Example:
A> del text1.bas

The above command, will delete the file in the name of text1.bas.

**REN command:**

This command is used to change the file name.

Format:

A> REN  <Source file name >   <New file name >

Example:
A> Ren Text1.bas  text10.bas
The above command changes the old file name text1.bas into text10.bas

**Creating & changing the Directories:**

Using MD command new directory can be created

Format:

A> md <name of the directory>

Example:

A> md basic

In the above example the MD command creates a directory in the name ‘basic’

Using RD command a particular directory can be deleted. If there is no file in a directory then only the directory will be deleted.

Format:

A> rd <name of the directory to be deleted>

Example:

A> rd basic

In the above example the RD command removes a directory in the name of ‘basic’

**Change directory:**

By using CD command the current directory can be changed.

Example: A>cd basic

After execution of the above command the prompt will be in the following format

A/>BASIC>
External Commands:

The hard disk though its name makes it sound though some times can suffer a head crash, i.e., the read/write collides with the platters destroying data. In such occasions all data on the disk is lost and irrecoverable. In order to avoid this situation the utility called BACKUP is used.

Example 1:

B> Backup C: *. A:

In the above case all files on the drive c are copied on to the diskette in drive A. All files present on the drive A diskette are lost. If additional disk are required, BACKUP will ask for them.

Example 2:

C>Backup C:*. A:/S

Will backup all files including those in sub directories (S option) onto the diskette in drive A:

Example 3:

C>Backup C:*. A:/A

Can be used if you wish to add files to diskette on the A drive rather than replacing them.

Example 4:

C>Backup C:*. A:/M

Will backup only those files, which have changed since the last backup

Restore Command:

The BACKUP command stores the files in a particular format, which can’t be retrieved through the copy command. A special command called RESTORE is used for this purpose.
Example 1:

B> RESTORE A: C:TRY.*
Will restore from the diskette in drive A, all the files that have a filename of TRY and may have any extension name.

Example 2:

C>RESTORE A: C:TRY.*/P

Gives you the option of being selective in choosing the files to be restored by prompting for each file only if there is a change in the destination file. The changes can even be attributes of the file.

Example 3:

C>RESTORE A: C: /S

Will restore all files from the disk(s) in drive C, including all subdirectories and their files.

Tree Command :

This command displays the path and optionally lists the contents of each directory and sub directory on the specified drive. It is very useful situation where the user needs to check if a particular subdirectory exists in a directory or not. Optionally it can also be used to check for files across the hard disk.

Example 1:

C>TREE [drive:]

Where the [drive] option specifies the drive that is to be searched. If this is not specified, the TREE uses the default drive.

Example 2:

C>TREE

This command will display the full path of each directory on the drive C

Example 3:

D>TREE A
Will display the full path or each directory on the drive A

Example 4:
   C>TREE /F
will display the names of files in each of the directories of the default drive C.

**Diskcopy Command :**

DISK COPY is an external command that is used to make backup copies of a disk. Additional copies of a diskette are referred to as backup copies or simply backups. Reentry of information may be avoided by copying a diskette. If information on one diskette is lost or destroyed, the user can use the backup copy.

Although there are many methods of making backups, the easiest way is by using the DISKCOPY command. The DISKCOPY command.

- Makes an exact duplicate of the original diskette
- Erases previously stored information on the target diskettes.

The diskette to be copies is referred to as the “SOURCE” and the diskette which reviews the information is called as the “TARGET”. To start the DISKCOPY process, the DISKCOPY program must be on the diskette in the default drive. Following are the steps to be followed:

- Place a diskette containing the DISKCOPY program in the default drive.
- Type the diskcopy command as follows.

  A>diskcopy A: b:<enter>
  Insert target diskette in drive B
  Strike any key when ready
  Insert source diskette in drive A.

- Remove the diskette containing the DISKCOPY program, insert the source diskette and target diskette as instructed, press any key to start the process.
At the end of the process, the computer prompts COPY ANOTHER (Y/N)? The user can answer y or n depending on whether another copy needs to be made or not.

**Diskcomp Command**:

It compares the contents of disk in the source drive and the disk in the target drive. DISKCOMP is a process that is performed generally after a DISKCOPY command to check whether the DISKCOPY process has taken place correctly or not.

DISKCOMP performs a track by track comparison of the disks. It automatically determines the number of sides and sectors per track based on the format of the source disk.

Format:

DISKCOMP <DRIVE1:><DRIVE2:>

Example:

A> diskcomp a: b:<enter>

**Format Command**:

A brand new floppy diskette or hard disk cannot be used straight away. It has to be prepared for use. The process of preparing a diskette for use by the computer is called FORMATTING. FORMAT places an electronic road map on the diskette. Diskette can be used on the computer only after they are formatted. The map contains directions to access the various parts of the floppy disk. The formatting process

- sets up “information tracks” on a diskette which will store the data
- Checks the quality of a diskette. If a defective area is discovered, the area in “locked out” from use.
- Erase information which is previously stored (if any) on the disk.

Format:

A>FORMAT <DRIVE>
Example: A> FORMAT B: <ENTER>

The FORMAT command is also used to make a BOOTABLE FLOPPY also by transferring the operating system files onto the floppy. This is done by using the /s option with the format command.

1.8 Short Summary

♣ Response to a specific set of commands called as Instructions.

♣ Execution of a prerecorded list of instructions called Program.

♣ The main difference between a super computer and a mainframe is that a super computer channels all its power into executing a few programs as fast as possible whereas a main frame uses its power to execute many programs concurrently.

♣ Hardware is nothing but machinery part of the computer

♣ Software is the part of the computer system which enables the hardware to operate.

♣ Operating system is a set of software that provides an interface between the machine and the user
Lecture 2

Introduction to Computers

Objectives

In this Lecture you will learn the following:

- What is GUI?
- New Features Of Windows 95
- Desk Top
- GDI
- DDE
- OLE
- What is Net Working?
## Coverage Plan

### Lecturer 2

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1</td>
<td>Snap Shot</td>
</tr>
<tr>
<td>2.2</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>2.3</td>
<td>New Features of Windows 95</td>
</tr>
<tr>
<td>2.4</td>
<td>Desk Top</td>
</tr>
<tr>
<td>2.5</td>
<td>Graphical Device Interface</td>
</tr>
<tr>
<td>2.6</td>
<td>Dynamic Data Exchange</td>
</tr>
<tr>
<td>2.7</td>
<td>Object Linking &amp; Embedding</td>
</tr>
<tr>
<td>2.8</td>
<td>Net Working</td>
</tr>
<tr>
<td>2.9</td>
<td>Short Summary</td>
</tr>
</tbody>
</table>
2.1 Snap Shot

In this Lecture You will learn about Graphical User Interface, Graphical Device Interface, Object Linking and Embedding as well as Features of Windows 95.

2.2 Graphical User Interface (GUI)

An User Interface that uses graphical Objects to allow the User to communicate to the computer. It increases ease of Use and its intuitive design makes learning Windows easy and fun.

**Objects of GUI**

- Window
- Icon
- Menu
- Pointer

The Graphical User Interface should be

**Easy**

That makes Windows easy to learn and Use, especially for those new to Window.

**Powerful**

That makes Window more powerful, efficient, and customizable for the experienced Window user.

**Compatible**

So that Windows is easy to learn and to use for those familiar with older versions of Windows like 3.x

**Event Driven**

Windows is an “Event Driven” OS and the user’s interaction is in terms of events and messages.
An event occurs when an user does something to interact with the OS, for example clicking a mouse is an event, closing a window is an event.

The OS identifies these events for what they signify and pass it on to the actual application towards which the event is directed in the form of a message.

It is now the responsibility of the application to take appropriate action in response to the message.

The application never directly processes these events, they have to be first received by the OS and then the specific application gets hold of the message for itself, and the OS cannot be bypassed.

2.3 New Features of Windows 95

New Improved Interface

It features the Start Button and taskbar. Click the Start button to quickly open programs, find documents, and use System Tools. Use the taskbar to switch between programs as easily as changing channels on your TV.

Windows Explorer

Windows Explorer is a powerful way to browse through and manage your files, drives and network connections.

Long Filenames

Windows 95 supports long filenames to make your files easier to organize and find.
Microsoft Exchange

You can use Microsoft Exchange to view and work with all type of electronic communications, including e-mail and faxes.

Performance

Windows 95 uses the 32-bit capabilities if Intel Pentium processor. A 32-bit processor can manage several tasks at the same time. This increases the flexibility and speed of the operating system. With Windows 95, you can format a floppy disk while you are working in a program or start a second program while you are waiting for the first to open. Programs are now handled separately, so the system will stop less often due to badly behaved programs. You can end a filed task to exit a program without having to restart the computer.

Internet Programs

Windows 95 includes the Internet Explorer web browser and Mail and News software for sending messages. NetMeeting is also included which allows you to communicate with other people on-line. Window 95 includes several other tools and utilities to make it easy to connect to and use the capabilities of the Internet.

You can share a modem with multiple programs using Windows 95. You do not have to disable your fax, e-mail or connection program to connect to the Internet and then restart the programs when you are done.

Accessory Programs

Windows 95 includes a basic word processor, a paint program, a calculator, screen savers and several games. Windows 95 also includes software that can check your drives, de-fragment your files and backup information on your computer. DriveSpace can compress, or squeeze together, the information stored on your hard drive. DriveSpace may be able to double the available free space on your drive.
Customization and Personalization

You can customize many elements in Window 95 to suit your working style, test or needs. For example, you can change the color of the desktop, change the way a window displays files or adjust the way you access commands. Window 95 includes a wide range of accessibility options for people with special needs.

Help and Wizards

You can access Windows 95’s extensive help system by pressing the F1 key. There are many troubleshooters in Help, which can help you identify and fix problems like non-functioning hardware and print error messages. Many tasks you perform, like adding a printer or installing software, use Wizards. Wizards help you perform your task by asking questions about the task that you want to perform so you will not make a mistake.

CD-ROM and Multimedia

Windows 95 allows a program provided on a CD-ROM disc to start itself. When you insert a CD-ROM disc with a multimedia program, Windows either starts the program automatically or displays a menu. Windows 95 includes graphics and other multimedia components in addition to music. Standard audio CDs start to play automatically when they are inserted.

Backing Up Your Old Files

Most Windows 95 setups are easy and trouble-free however, any time you update your computer’s operating system, it is possible that an error could occur, such as system failure due to incompatible hardware, or a power failure, that may temporarily or permanently prevent access to data.

2.4 Desktop

Desktop is the area seen when Windows 95 is started. The four main features seen in the desktop area are,

- Shortcut Icons
- Task Bar
- Start Button
• Time & Status

Shortcut Icons

An Icon is a picture in the screen representing an object. Shortcut icons allow quick access to commonly used programs, folders or documents.

Taskbar

As any number of programs/applications can be kept open at any time we can switch between the applications using the Alt + Tab key combinations. Release the Alt key when the application you want is displayed. Or you can directly switch to applications by clicking the application that is displayed at the last line of your Windows screen.

Start Button

You can start any application through this option. This is the option displayed at the bottom left corner of the screen. Either click with the mouse at this option or press Ctrl + Esc keys to invoke the Start Menu. In modern systems you can see the keyboard with a new key with the Windows Logo. You can also press this key to invoke the Start Menu.

Status and Time

Along with the taskbar the last line also shows the status of the system settings and also the system time. Just move your mouse pointer to the bottom right corner of the screen to see the status and time settings.

My Computer

My Computer can be used, to easily see everything on your computer. To browse through the listing of your files and folders, Double-click on my computer Icon on the desktop.
**Network Neighborhood**

A network represents a set of computers joined together. If the computer in use is part of a network, then the Network Neighborhood Icon appears on the screen. Double-clicking this icon can access the files and folders of other computers.

**Recycle Bin**

All files and folders, which are deleted from Windows95, are stored in the Recycle bin. Recycle bin can be used to restore files that have been deleted. Recycle bin has a pre-set size, which defines the number of files it can store. When the recycle bin is full, the files that were earlier added to it are deleted.

**Starting Programs**

You can start a program by using the Start Button.

a. Click the Start button, and then point to programs.
b. If the program you want is not on the menu, point to the folder that contains the programs.
c. Click the program.

After you start a program, a button appears on the taskbar. To switch from one running program to another, click its taskbar button.

You can use the Start button while you are working in another program. The Start button allows you to quickly start a new program without having to close or minimize the current program.

This gives access to all the applications available in the computer. Each entry in the menu represents an Application (e.g., Windows Explorer) or a group representing many applications (e.g., Accessories). The Group Entries have a black arrow at the end. Positioning on a group item exposes the items in the group. There may be group within a group.
2.5 Graphical Device Interface

Imagine writing a windows program that draws a few lines. Since Windows is graphics intensive, the programmer would have to take into account various graphics board. You imagine writing different copies of the program so that it knows the resolution of Super VGA, VGA boards, and would work according to the resolution so that the used wouldn’t feel the difference, and what would happen if one were to support printing how many types of printers and printer resolutions would one have to consider? This is where the GDI-the Graphics Device Interface comes to the rescue.

GDI provides a set of standard functions that let applications communicate with graphics devices, including displays and printers, without knowing anything about the devices. GDI functions mediate between applications and graphics devices such as display drivers and printer drivers.

GDI interprets application requests for graphic output and sends them to graphics display drivers en route to the hardware. It includes functions for advanced line, text and figure drawing, and graphics manipulation. GDI provides a standard interface for applications to use varying graphics output devices, this enables application code to be independent of the hardware devices and their drivers. GDI tailors its messages to the capabilities of the device, often dividing the request into manageable parts. For example, some devices a can understand directions to draw an ellipse; others require GDI to interpret the command as a series of pixels placed at certain coordinates. Suppose the application asks the GDI to draw a line, if the output device knew how to draw lines the GDI would ask it to do so, but of it did not, and say it knew how to plot pixels, it would simulate line drawing by calculating the pixels to be drawn and call the device’s pixel drawing function accordingly.

GDI is also the display driver’s connection to the operating system and to the applications it supports. GDI passes API requests to the graphics device drivers, and graphics device drivers can request services from GDI.

The GDI provides a number of drawing tools and objects, commonly referred to as GDI objects, such as pens which are used for drawing, brushes used to paint background etc. Some of these are built into the operating system itself and can just be picked up. These objects can also be created to suit user needs.
The applications interact with the GDI layer using a data structure called a Device Context (DC) which they obtain from the operating system. A DC is something like a virtual canvas upon which you draw without knowing what lies under the surface. This DC has to be used to perform all output. One needs to obtain a handle (a reference) to a DC and then use this handle to perform all output for e.g. drawing lines, pictures, text etc. GDI provides functions to perform these operations. For e.g.

```
HDC hDC = GetDc (hWnd); /*get handle to DC*/
Rectangle (hDC,10,10,100,200); /*draw a rectangle */
TextOut (hDC,10,10, "This is how we display text",27);
And so on.....
```

A DC is a fairly large data structure because it needs to maintain quite a lot of information. Of primary interest are handles to logical device and physical device block. The logical device is a set of core primitive functions that a GDI device driver provides. The physical device block is a data structure describing the actual capabilities of a device. The DC also has handles to the current pen, brush, font, and other GDI objects. If one wishes to use another GDI objects of one already existing, it is done by using the Select object () function.

![Diagram of Device Context Components]

Components of a device context

2.6 Dynamic Data Exchange

DDE is a means of communication between Microsoft Windows application. The link acts as a conduit for the exchange of data between the connected application. The data exchanged may either be information copied from one application to another application or commands or Keystrokes for the other application to process. DDE is the basic foundation for inter process
communication among the Microsoft Windows applications. In a DDE conversation, the application that creates the link is known as the destination application, and the application that responds is known as a source application. These used to be referred to as client and server, respectively. Any application that supports DDE can serve as either a source or a destination. One application can serve as both a destination and a source with several other applications at the same time.

2.7 Object Linking & Embedding

Out of DDE evolved OLE, Object Linking and Embedding. True to its name, OLE brought the ability to link objects to one another or to embed one object inside the other. The classic example of using OLE is the Word processor/spreadsheet combination. A reference to a spreadsheet file can be added to a word processing document. If the user was to click on the reference, the spreadsheet program that is used to edit the spreadsheet would be automatically loaded and changes could be made. In this way, the spreadsheet is linked to word processing document. With OLE, the spreadsheet can also be embedded into the word processing document.

A window that shows the contents of the spreadsheet would be contained within the document. Changes to the spreadsheet can then be made inside that window. The spreadsheet program is still used to make the changes, but this is transparent to the user. He or She never has to leave the word processor to make changes to the spreadsheet.

2.8 Net working

**What is networking?**

A computer network is a communication system, which connects two or more computers and peripheral devices, to allow sharing of resources, information, and services. Users in a network share a common pathway to communicate with each other.

Connecting a number of computers (server and workstation), using wired media (cables) or wireless media forms a computer network. Each computer
has a network interface card (NIC) installed in it and runs a piece of software (called network software) to achieve connectivity.

A group of computer that are connected together for the purpose of sharing various computer software and hardware resources like input-output devices, memory, storage devices like hard disk etc. is called Networking.

**Concept of Networking**

Networking arose from the need to share data in a timely fashion. Personal computers are wonderful business tools for producing data spreadsheets, graphics, and others types if information, but do not allow you to quickly share the data you have produced, Without a network, the document have to be printed out so that others can edit them or use them. At best, you give files on floppy disks to others to copy to their computers. If others make changes to the document there is no way to merge the changes. This was, and still is, called working in stand-alone environment.

A group of computers and other devices connected together is called a network, and the concept of connected computers sharing resources is called networking.

Computers that are part of a network can share the following:

- Data
- Message
- Graphics
- Printers
- Fax machines
- Modems
- Other hardware resources

This list is constantly growing as new ways are found to share and communicate by means of computers.

**Networking Category**

Even with these similarities, networks can be divided into two broad categories:
• Peer-to-peer
• Server-based

The distinction between peer-to-peer and server based networks is important because each has different capabilities. The type of network you implement will depend on numerous factors, including the:

• Size of the organization
• Level of security required
• Type of business
• Level of administrative available
• Amount of network traffic
• Needs of the network users
• Network budget.

**Peer-to-peer-Networks**

In a peer-to-peer network, there are no dedicated servers or hierarchy among the computers. All of the computers are equal and therefore are known as peers. Normally each computer functions as both a client and a server, and there is no one assigned to be an administrator responsible for the entire network. The user at each computer determines what data on their computer gets shared on the network.

**Peer-to-Peer Operating Systems**

In a peer-to-peer network, the networking software does not need the same level of performance and security as the networking software designed for dedicated servers. Dedicated servers function only as servers and are not used as a client or workstation. They are discussed in more detail later in this lesson. In operating systems such as Microsoft Windows NT Workstation, Microsoft Windows for Workgroup, and Microsoft Windows 95, peer-to-peer networking is built into the operating system. No additional software is required to set up a peer-to-peer network.
Server-based Networks

In an environment with more than 10 users, a peer-to-peer network with computers acting as both servers and clients will probably not be adequate. Therefore, most networks have dedicated servers. A dedicated server is one that only function as a server and is not used as a client or workstation. Servers are “dedicated” because they are optimized to quickly service requests from network clients and to ensure the security of files and directories. Server-based networks have become the standard model for networking and will be used as the primary examples throughout the rest of this kit.

As networks increase in size and traffic, more than one server on the network is needed. Spreading the tasks among several servers ensures that each task will be performed in the most efficient manner possible.

Server-Based Network Advantages

A server is designed to provide access to many files and printers while maintaining performance and security to the user. Server-based sharing of data can be centrally administered and controlled. The resources are usually centrally located and are easier to locate and support than resources on random computers. For example, in Windows NT Server, directory resources are shared through File Manager. To share a directory, highlight it and then from the Disk menu, select the Share as option.

Internet

The Internet is truly the network of networks. It is a massive collection of computer networks that connect millions of computer, people, software programs, databases, and files. The parts and players are spread around the world and interact continuously. No particular group or organization owns the Internet. It is actually a worldwide network that links approximately 20,000 other networks together.

Intranet

An Intranet is an internal corporate or organizational network that uses Internet technologies to let its employees browse and share electronic information.
remarkably easily. An Intranet is a private version of the Internet’s World Wide Web, but it’s available only to people inside the organization.

2.9 Short Summary

♣ Graphical User Interface uses graphical Objects to allow the Users to communicate to the computer.

♣ Windows is an “Event Driven” OS and the user’s interaction is in terms of events and messages.

♣ GDI provides a set of standard functions that let applications communicate with graphics devices, including displays and printers, without knowing anything about the devices

♣ DDE is the basic foundation for inter process communication among the Microsoft Windows applications

♣ OLE brought the ability to link objects to one another or to embed one object inside the another.

♣ A group of computer that are connected together for the purpose of sharing various computer software and hardware resources like input-output devices, memory, storage devices like hard disk etc. is called Networking.
### Objectives

In this Lecture you will learn the following:

- Working with Start button
- Using Options such as Find & Help
- What is the use of Control Panel Option?
- Closing the Application
# Coverage Plan

## Lecture 3

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>Snap Shot</td>
</tr>
<tr>
<td>3.2</td>
<td>Start Button</td>
</tr>
<tr>
<td>3.3</td>
<td>Programs</td>
</tr>
<tr>
<td>3.4</td>
<td>Documents</td>
</tr>
<tr>
<td>3.5</td>
<td>Setting</td>
</tr>
<tr>
<td>3.6</td>
<td>Find</td>
</tr>
<tr>
<td>3.7</td>
<td>Help</td>
</tr>
<tr>
<td>3.8</td>
<td>Run</td>
</tr>
<tr>
<td>3.9</td>
<td>Shut Down</td>
</tr>
<tr>
<td>3.10</td>
<td>Short Summary</td>
</tr>
</tbody>
</table>
3.1 Snap Shot

In this lecture you will learn about how to use windows 95 OS such as How to start a program, Find a specific files, How to customize Windows and much more.

3.2 Start Button

The Start button act as a launch pad for lot of things you want to do with Windows 95.

Using this menu

- You can start application.
- You can change settings of your computer
- You can find files
- You can get help

3.3 Programs

A Program is nothing but an executable application. In Windows there are so many Exe files. When you click start button, there is one option called programs that appears. If you move the mouse pointer over there, you will be able to see that the programs option that gets highlighted. If you click the program option
again one more sub menu will appear. It will have all the applications such as
Microsoft Visual Studio, Accessories, etc., These applications may also have sub
menus. If you click on these options, then the corresponding applications will
run.

![Image](image_url)

Fig above Represent the Run Paint Application.

3.4 Documents

Document is an option when you invoke Start button, which contain the latest
documents such as word, html files, asp etc. If you click the menu, the
corresponding application will be executed. If you want to clear the document,
select the task bar properties by placing the mouse in the status bar and right
click your mouse in which you open the Start Menu Programs and Click the
Clear Button, it will clear all the documents.

3.5 Settings

Settings is another option in the Start button, if you click this option three sub
menu’s will appear as follows:

- Control Panel
• Printer
• Task Bar

**Control Panel**

If you click this option, you can find large number of Icons such as Add / Remove programs, Add New Hardware, Date / Time, Modems, Systems, Mouse, etc., If you want to modify any properties in the system then you can use the Control Panel. The above Figure represents the Icons in the control Panel Option.

**Printers**

The above Figure Represents the Printers Object
If you click this options then the Printers dialog box appears, where you can add a new printer and customize your printer setup.

**Task Bar**

![Task Bar Properties](image)

If you click the Task bar menu then the following Fig will appear, where you can customize your task bar according to your view.

### 3.6 Find

Find is yet another option in the Start button from which you can find the Files or Folders. Windows usually have a lot of Files as well as Folders. If you want to search a particular Folder or File, it is very difficult to find them out. To overcome this, Windows is having the Find menu option. Searching for Files and Folders are based on three criteria.

- Name & Locations
- Date Modified
- Advanced

**Name & Locations**
If you enter the desired File or Folder either in the full form or in the Partial form, then click the Find now button and it will display the file and it’s location. The Figure below shows the all document file which are in the C Directory.

Date Modified

This option allows you to search files between two particular dates or months. This Fig shows Date Modified option

Advanced

This Advanced option is used to find out file, where you can specify the size of the file, name of the file etc.
3.7 Help

Windows 98 has extensive help to know about Windows. To see Help, click the Start button and click the Help option.

This Fig Represents the Help in Windows.
3.8 Run

The Run Command on the Start button offers an alternative method to start applications or open some other files. The Run command is most often used to Install new Software from CD or Floppy Disk.

![Run Command](image)

This Fig shows the RUN option.

3.9 Shut Down

This option is used

- To Shut Down your System.
- To Restart the computer
- To Restart in DOS mode
- Close all programs and log your System.

![Shut Down Windows](image)

This Fig Shows the Shut down Windows.
Minimize or maximize or Close

In all application there are three buttons in the Right most corner. If you click the first button, it is used to Minimize your application and the middle button is used to Maximize your application and the last button is used to close your application.

3.10 Short Summary

♣ The Start button act as a launch pad for lot of things you want to do with Windows 95.
♣ Program option is used to run many applications.
♣ Document option is used to know the latest application
♣ Find option is used to search a particular File in the System.
Lecture 4

Introduction to Windows

Objectives

In this Lecture you will learn the following:

• Working With Folders
• Printer
• Installation
• System Tools
## Coverage Plan

### Lecture 4

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1</td>
<td>Snap Shot</td>
</tr>
<tr>
<td>4.2</td>
<td>Files &amp; Folders</td>
</tr>
<tr>
<td>4.3</td>
<td>Configuring Printers</td>
</tr>
<tr>
<td>4.4</td>
<td>Installation Programs</td>
</tr>
<tr>
<td>4.5</td>
<td>System Tools</td>
</tr>
<tr>
<td>4.6</td>
<td>Short Summary</td>
</tr>
</tbody>
</table>
4.1 Snap Shot

In this lecture you will learn about Windows Folders, How to install Hardware and Software in OS and the benefits of Windows System Tools.

4.2 Files & Folders

In Windows all kind of files are stored in Folder. Folder is nothing but collection of files.

In order to work with Windows Environment, it is necessary to understand about Folders.

In windows Explorer you can see many folders in the left side with the +sign. If you click the + sign, it will be enlarged and all the sub folders inside the main folder will be shown.

The + sign becomes – sign. If you click the sub folder, then the files inside the folder will be shown in the right pan.

Create a New Folder

- To Create a New Folder you have to select the Windows Explorer as shown in Fig.
• Then Windows Explorer will be invoked as shown in Fig. Where you can find two panes, one is in the left side and the other one is in the right side. Select the right pane.

• Now Right Click the Mouse button this will create a Pop up menu, where you select the New option then select the New Folder as shown in Fig.

• This will create a New Folder in the right pane, with default New Folder option, and you can specify the Name of the New Folder. Here we are going create a new folder called Lecture 1

• Since it is created in the desktop it is going to be located in the name of Lecture 1 in the desktop.
Copy a File to a Folder

- To copy a File to a Folder, First select the desired file in the Windows Explorer, and select the file in the Right Pan as shown in Fig, right click the File, then select the copy menu.

- It will copy all the contents from the file to clipboard for some time being.

- Select the Destination Place. Suppose if you want to paste the file in the desktop that is created in the last exercise, then click the folder in the Desktop named Lecture 1.

- Right click the mouse button, it will invoke a pop up menu where you select the paste option (By default paste option only available and not the cut or copy option) as shown in Fig

- If you click the paste option then the file will be pasted in the Lecture 1 Folder as shown in Fig.
The Figure shows copied list1 Excel File.

**Delete a File or Folder**

- Suppose if you want to Delete a File or Folder, then Select the File or Folder, right click the Mouse and it will open a pop up menu where you can select the Delete Option.

- Then the particular File will be deleted and sent to the Recycle Bin.

- If you want to reuse the particular file, open the Recycle Bin and Select the Restore option.

- By confirming the deletion of the file in Recycle Bin, the file will be deleted permanently.

**4.3 Configuring Printers**

Windows 95 offers significant improvements to printing in particular, to the way you set up a printer to print from Windows.

**Setting Up a Printer**

Setting a printer is easy and fast, with the Add Printer Wizard, step-by-step printers setup Program. Before you begin to setup printer make sure your printer is connected to your system and that you know the make and model of your printer connected. If you want your printer to be shared over the network,
you may also need to know the path to it. Or you can browse for the printer in Network Neighborhood and then double-click its icon to set it up.

• Click the Start Button, point to Settings and then click Printers.

![Printers window]

• Double-click Add Printer

![Add Printer Wizard]

• This Wizard will help you to finish the Installation procedure for the Printer.
4.4 Installation Programs

**Installing Application Program**

- To Install an Application Program in your system, Select the Start button and press the setting Option where you select the control panel inside which select the Add/Remove Program icon.

- Click the Install button
- Then the Wizard will lead you to install the particular application to your system.
Installing Hardware

• To Install a Hardware to your application click the Start button, click the Settings option then click the Control Panel, where you select the New Hardware icon menu.

![Add New Hardware Wizard](image)

This Wizard will help to Install a New Hardware to your System such as Modems, Printers, etc.,

4.5 System Tools

To Enter into the System Tools Click the Start button, click the programs then click the Accessories. The Fig represent the way to System Tools

It is having

• Compression Agent
• Disk De-fragmentor
• DriveSpace
• Scandisk
Drive Space

If you need more room on your hard disk, you can use DriveSpace to compress the disk and free up more space.

To find DriveSpace, click the Start button, point to Programs, point to Accessories, and then point to System Tools.

If DriveSpace is not on your computer, look up "installing, Windows components" in the Help Index.

Disk De-fragmentor

You can use Disk De-fragmentor to optimize your disk so that the files and unused space are arranged efficiently. This makes your programs run faster and your files open more quickly.

To find Disk De-fragmentor, click the Start button, point to Programs, point to Accessories, and then point to System Tools.

If Disk de-fragmentor is not on your computer, look up "installing, Windows
components" in the Help Index.

**Scan Disk**

You can use scandisk to check your hard disk for errors and to fix problems that are found.

To find scandisk, click the Start button, point to Programs, point to Accessories, and then point to System Tools.

If scandisk is not on your computer, look up "installing, Windows components" in the Help Index.

**Compression Agent**

Compression Agent is used to compress the disk and make more space in the Disk.

**Paint Brush**

You can create, modify, or view pictures by using Paint, a program that replaces Paintbrush from Windows version 3.1. Paint contains many new features, including a movable toolbox and color box, and print preview.

To find Paint, click the Start button, point to Programs, and then point to Accessories.

If Paint is not on your computer, look up "installing, Windows components" in the Help Index.

This Fig shows How to use Paint Brush
4.2 Short Summary

- In Windows all kind of files are stored in Folders.
- Folder is nothing but collection of lot of files
- Windows Explorer is used to see all Files and Folders in Windows.
- Windows 95 offers significant improvements to printing –in particular, to the way you set up a printer to print from Windows.
- System Tools containing Compression Agent, Disk De-fragmenter, Drive space and scandisk.
Lecture 5

Introduction to Word 2000

Objectives

In this Lecture you will learn the following:

- About Word document
- About File Creation
- About Handling Multiple files
- Printing the Documents
- Quitting Word
Coverage Plan

<table>
<thead>
<tr>
<th>Lecture 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1 Snap Shot</td>
</tr>
<tr>
<td>5.2 Features of MS-Word 2000</td>
</tr>
<tr>
<td>5.3 Getting Started</td>
</tr>
<tr>
<td>5.4 Components of Word Window</td>
</tr>
<tr>
<td>5.5 Creating Document</td>
</tr>
<tr>
<td>5.6 Typing Text, Saving and Closing</td>
</tr>
<tr>
<td>5.7 Opening an Existing Document</td>
</tr>
<tr>
<td>5.8 Printing &amp; Previewing Documents</td>
</tr>
<tr>
<td>5.9 Switch between Multiple Documents.</td>
</tr>
<tr>
<td>5.10 Quitting Word</td>
</tr>
<tr>
<td>5.11 Short Summary</td>
</tr>
</tbody>
</table>
5.1 Snap Shot

In this Lecture You will learn about MS Word 2000, one of the very useful components of Office 2000. This will guide you how to create a new document, working with documents and saving the documents.

5.2 Features of MS-Word 2000

Word is the most popular word processor on the Market. Word 2000 helps you painlessly create

- Letters
- Proposals
- Web pages
- Business Plans
- Resumes
- Novels
- Graphics

5.3 Getting Started

You can start Word 2000 in several ways

- Click the Office 2000 Shortcut Bar’s New Office Document button and double click the Blank Document icon to create a new document.

- Click the Office 2000 Shortcut Bar’s New Office Document button and open a word 2000 template or start a word wizard.

- Click the Office 2000 Shortcut Bar’s Open Office Document button and select an existing document you want to edit

- Use the Windows Start menu to start Word 2000 by selecting Microsoft Word from the program menu.
• Select a Word 2000 document from the Windows Start menu’s Documents option.

• Click the Office 2000 Shortcut Bar’s Word 2000 button to create a blank document.

5.4 Components of Word Window

This section describes the file handling processes. The file handling processes discussed are:

• Bits
• Creating and saving a new file
• Opening an existing file
• Saving a file under a new name
• Saving a file for use with another word processing program
• Importing a file created by another word processing program
• Inserting an existing file into the body of the current document

5.5 Creating a New File

Creating a new file is the first step in working with a new document. A new file may be created by clicking on File / New or the New Blank Document
button on the Standard toolbar, then choosing an appropriate template. The New dialog gives you a choice of many different document templates to choose from. Besides the templates provided with Office 2000, you may find additional templates at a Microsoft web site. Choose a template that is most consistent with the ultimate objective of your document. A Blank Document template has no specific format, although it does have default settings for such document attributes as font type and font size, which you can change to suit your needs. Also, from the new dialog, you may create a new template. This is a powerful tool that gives you the ability to capture and easily recall document formats used on a regular basis.

![New dialog](image)

5.6 Typing Text, Saving and Closing the Document

Once the New Document opened you can enter the text in the Edit Window.

**Saving a New File**

To save a file (or template), select File / Save or press the Save button. The File / Save menu selection and Save button save the file with its current name and file type. The default name is Document X, where X is an integer whose value depends upon the number of new files already opened in the current work session. The default file type is the Word 2000 .doc type.
Saving a File under a New Name

The File / Save As choice allows you to save your document under a new name and/or document type. You can save the file with a new name by changing the filename in the File name text box. Also, you can change the file type by choosing a different type from the Save as type text box.

The Save As dialog includes the following elements: A menu box with options like save, cancel, options and save versions

The History icon displays the documents and subdirectories of recently saved documents. Selecting a subdirectory from here will save the document in that subdirectory.

The My-Documents icon saves the document in the C:\My Documents directory.

The Desktop icon saves the document to the Desktop directory.

The Favorites icon saves the document in whichever Favorites subdirectory you choose. A favorite subdirectory may be added to favorites by selecting tools located near the top right of the Save as dialog and choosing Add to Favorites.
The Web Folders icon saves the document in the My-Computer \Web Folders directory.

The Save in: drop-down box allows you to choose the directory/subdirectory other than the current working directory where the file can be saved. Click on the down arrow to choose another location.

Also, clicking on the up arrow just to the right of the Save in: box will take you up one place in the subdirectory hierarchy.

If you want to save the document as a web document, you can click on the Search the web button which will start Internet Explorer and connect you to the Internet.

The Delete button will delete the subdirectory or file that is highlighted when the button is clicked.

The Create New Folder button allows the user to place the saved document into a new directory (folder).

The List button allows the user to select a particular file/directory and the information is displayed in the main dialog box.

The Tools button has a drop-down menu list that includes several file management processes and usage options.

Delete deletes a file or directory.

Rename allows a file or directory name to be changed.

Add to Favorites will add the highlighted file or directory to the Favorites icon.

Map Network Drive allows the user to save files on a remote network drive.

Properties displays file or directory information.
Saving a File for Use with Another Word Processing Program

The Save as type: drop-down text box includes many different file types that the document can be saved as.

We need to just click on the box’s down arrow and choose the document type desired. Documents can be saved as file types:

- Word document (*.doc)
- web page (*.htm;*.html)
- rich text format (*.rtf)
- text (various types) (*.txt)
- Windows Write—various versions (*.wri)
- Word for Windows—various versions (*.doc)
- Word for Macintosh—various versions (*.mcw)
- Word for MS-DOS (*.doc)
- WordPerfect various versions (*.doc)
- Works for Windows various versions (*.wps)

When you are ready to finally save the file, click on the Save button located on the bottom right side of the Save dialog. Or, if you change your mind, click on Cancel.

Closing Document

Once you finalize your task in document, you can close your word window either from the file menu or you can use the right most close button to close the document.

Hands-on Activities

This activity demonstrates the file handling procedures.

Creating and saving a New File

In this activity you create a small document file and save it with a name of your choice. Begin by starting Windows.
1. Start Word by clicking on Microsoft Word in the Start / Programs group (or click the Word button on the Office Shortcut bar).

2. Notice that Document1 is the default document name. The default style is Normal and the current font is Times New Roman 10 point.

3. Click the Show / Hide button (on the top toolbar) to display control characters including spaces, carriage returns, and tabs.

4. Change the size to 12-point and delete the 10-point carriage return: <Ctrl+>] <Del>.

5. Set the top, bottom, left, and right margins to 1 inch: Pick File / Page Setup (or double-click the horizontal strip above the ruler), type 1" in the Top, Bottom, Left, and Right margin text boxes <Enter>.

6. Type the following paragraph and press <Enter> at the end: This document is being typed using the Normal style. The font is Times New Roman. The point size is set to 12 points, where there are 72 points per vertical inch. All margins (top, bottom, left, and right) have been set to 1". Finally, nonprintable characters are displayed by clicking the Show/Hide button on the Standard toolbar.

7. Save the document with the name my first: Click File / Save, type my first <Enter>. Notice that the assigned name of your document is now displayed on the Microsoft Word title bar at the top of the screen. The file extension .doc is automatically assigned by word. Windows lets you type descriptive names that can be as long as 254 characters and include space.
You may use the Properties selection of the File menu, i.e., File / Properties, to view information about the document. You may also add descriptive information here, which can later be viewed using the File / Properties menu selection. Descriptive information can help you determine what’s in the document at some future date.

8. Type this is my first document in the Comments box. Then click OK to save the properties information.

5.7 Opening an Existing Document

To open an existing file, select the File / Open menu selection or press the Open button. Notice the shortcut icons on the left side of the Open dialog. At the top of the dialog, there is a directory drop-down box allowing you to choose files from directories / subdirectories other than where you are currently located. To go to another file location, just click on the down arrow and choose the next option.

The Favorites icon opens another dialog allowing you to select documents from directories / subdirectories far removed from where your current working directory may be. Of course, you must place your favorites in the Favorites location by going to the directory of interest, then clicking on Tools.
**Importing a File Created by Another Word Processing Program**

Word 2000 comes with filters that convert documents derived from other sources into the Word 2000 format, allowing you to import documents from a wide variety of sources and change them in Word 2000.

Begin by clicking File / Open.

At the bottom of the Open dialog, there is Files of type: drop-down text box.

Click on the text box down arrow and see the different file formats that Word accommodates.

When the format of interest is selected, all files with that type extension become visible in the Open dialog.

Other document formats are converted when the file desired is highlighted in the Open dialog box, then opened by clicking on Open at the bottom right side of the dialog.

Word converts the file to the Word 2000 format, then presents the document to the user in the familiar Word program ready for use.

**Hint:**

Rich text files can take a long time to convert and save when working with them in Word. Convert already existing .rtf files to Word (.doc) and work with new documents in Word format. Only convert to rich text format as a final step.

**Inserting an Existing File into the Body of the Current Document**

Word can insert a whole file inside a current working document. The document is inserted wherever the cursor is currently at. Begin by clicking on Insert / File to open the Insert File dialog. Choose the file of interest and press the Insert button on the bottom right of the dialog box. If you change your mind, click on Cancel.
5.8 Printing and Previewing Document

In this Section you have briefly used the File / Page Setup menu selection when you adjusted all page margins to one inch. Using the Format menu is another way to control the appearance of your document. Review the following information and then perform the hands-on activity.

Pages

Pages are formatted using the File / Page Setup menu selection to open the Page Setup dialog. The Page Setup dialog includes the Margins, Paper Size,
Paper Source, and Layout tabs from which you may adjust the appropriate page features.

**Paragraphs**

The Format / Paragraph menu option brings up the Paragraphs dialog box, which provides independent control over indents, spacing, and text flow. Indents and spacing options control the indentation from the left and right margins, line spacing, the indent level of the first line (paragraph indent), and the indent level of the second and subsequent lines (hanging indent). Text flow options control the way a selected paragraph interacts with adjacent text elements and page breaks. For example, you can change the right and left margins of an individual paragraph, keep the paragraph together (prevent it from being split by a page break), change the line spacing, and set different spacing before and after the paragraph. A typical use of a uniquely formatted paragraph might be an embedded note. For emphasis, notes are often indented from the left and right margins and sometimes receive additional spacing before and/or after the text of the note.

**Sections**

General format settings, such as the normal margins and tab settings, are applied to the whole document, from the current point forward, or to a section where the document is subdivided into two or more sections. The Insert / Break menu option is used to insert both page and section breaks. Using the Break dialog box, you can begin a new section on the same page (click the Continuous button) or on a new page (click the Next page button). The Break dialog box is shown in the following illustration.

Note that you can delete both page and section breaks using the Del key. Once you establish two or more sections within a document, you can vary the margins, line spacing, and even the number of columns within each section independent of the others. Therefore, when using multiple formats within a document, be sure to insert a section for each unique format.

If you insert multiple-column text within a single-column document, the column operation automatically creates a new section for the selected text. This eliminates the need to insert a section break before selecting and converting a passage to columnar text.
Hands-on Activity

The following activity uses some Sample document located in the /MSOffice /Files folder. You use the File / Page Setup, Format / Paragraph, and Insert / Break menu selections to modify the appearance of the document.

1. Start the Word program and display the blank Document X page.
2. Use File / Open to load the Sample document file.
3. Use pgup and PgDn or the vertical scroll bar to examine this two-page document.
4. Use File / Page Setup and set all four margins to 1 inch.

Note: In the following step you use two new commands:

Edit / Select All selects the entire document (use the shortcut Ctrl+A).

Then use Ctrl+] to increase the type size of the selected passage by one point. (Ctrl+[reduces the type size.)

5. Select the entire document and change the point size to 12: <Ctrl+A> <Ctrl+[> <Ctrl+]>. Press <Down Arrow> to deselect the document.

6. Place the cursor at the beginning of the word NOTE; center the word by pressing <Ctrl+E>.

7. Indent the note text 1 inch from the left and right margins using the Format / Paragraph menu selection as follows:

   a. Select the note text (drag it with your mouse).
   b. <Alt+O> P 1 <Tab> 1 <Enter>.
8. Select and then use the Columns button on the top toolbar to make the terms and definitions portion of the document two-column as follows:

   a. Highlight some text, pressing <Shift> and dragging down until the above referenced selection is highlighted.

   b. Click on the Columns button and select two columns (click on the second column in the pop-down illustration). This creates two additional sections within your document.

9. Compare your document to the following illustration to see how sections are used for multiple formats within the same document. (Click View / Print Layout menu selection, then click File / Print Preview. Then use the Multiple Pages button and drag 1 x 2 Pages.)

10. You can use PRINT option to print the Document

**5.9 Switch Between Multiple Documents.**

With Word 2000, you can work with multiple documents. You could be typing a letter to a friend and composing that memo to your out-of-state office before the mail runs, for example.

Instead of closing your letter, click the toolbar’s new button to create a blank document. The new document appears on top of your letter. Switch between the letter and your memo by selecting the filename from the menu bar’s Window option. In most instances, only one document is active (visible on the screen) at one time. When you issue a Close or save command, Word 2000 closes or saves the active document.
5.10 Quitting Word

By selecting Exit command from the File menu or by using the close button i.e., Rightmost button of the Word Window, the user can quit Word.

5.11 Short Summary

♣ Word is the Most popular word processor on the Market

♣ A new file may be created by clicking on File / New or the New Blank Document button on the Standard toolbar, then choosing an appropriate template

♣ The File / Save As choice allows you to save your document under a new name and/or document type

♣ The Page Setup dialog includes the Margins, Paper Size, Paper Source, and Layout tabs from which you may adjust the appropriate page features.
# Customizing Word Documents

## Objectives

In this Lecture you will learn the following:

- About Copying, pasting a text
- About Changing Fonts, Paragraphs
- About Creating Bullets and Number
- About Page Setting
- About Headers & Footers
## Coverage Plan

### Lecture 6

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td>Snap Shot</td>
</tr>
<tr>
<td>6.2</td>
<td>Editing Text Using Cut, Copy &amp; Paste</td>
</tr>
<tr>
<td>6.3</td>
<td>Find &amp; Replace</td>
</tr>
<tr>
<td>6.4</td>
<td>Styles, Fonts and Font Sizes</td>
</tr>
<tr>
<td>6.5</td>
<td>Creating Lists and Number Headings</td>
</tr>
<tr>
<td>6.6</td>
<td>Creating Headers &amp; Footers</td>
</tr>
<tr>
<td>6.7</td>
<td>Inserting Page Breaks, Page Numbers, Bookmarks, Symbols and Dates</td>
</tr>
<tr>
<td>6.8</td>
<td>Short Summary</td>
</tr>
</tbody>
</table>
6.1 Snap Shot

- This section introduces you to basic editing features, including the commands used to insert, delete, move, and copy text. Firstly the insert and delete features are described. Then move and copy (or cut and paste) features are described.

- This section also introduces you to a powerful and frequently used word processing feature i.e. searching for a specified word, text passage, number, symbol, paragraph style, etc. The search (or find) text is often referred to as the **find string**. You can also specify a replacement string. In addition to finding conventional characters and numbers, you can also find special characters and symbols, such as tabs and paragraph symbols. You can even use wildcards, or substitution characters (such as ? and *), in your search strings.

- This section guides you through the use and creation of document styles and the selection of type fonts and font sizes. First, styles, fonts, and font sizes are introduced. Then a hands-on activity is provided to give you experience with the management of styles and to see how fonts and font sizes are controlled.

- In this section you will learn to format individual paragraphs, how to indent, and how to position text beyond the left margin. This section guides you through another text formatting feature i.e. the creation of lists. It also describes the **Format / Bullets and Numbering / Outline Numbered** selection, which is used to automatically apply numbers to paragraph headings and outlines.

- This section guides you through the Use of Headers and Footers.

- This section guides you through some uses of the Insert menu. In particular, you learn how to insert page breaks, page numbers, special symbols, and dates and times into your documents.

- This section also handles the Inserting Page numbers in your word document

6.2 Editing Text using Cut, Copy & Paste
**Insert and Overstrike**

Word is normally in the insert mode. As text is typed, following text is pushed to the right and down. You can put word into the overstrike mode by pressing the <Ins> or <Insert> key on the keyboard. OVR is displayed on the status bar at the bottom of the screen when in overstrike. Press <Ins> or <Insert> again to put Word back into the insert mode.

**Cutting, Copying, and Pasting**

Text is cut by selecting it and either using Edit / Cut or pressing <Ctrl+X>. This removes the selected passage from the screen and puts it on the Windows clipboard, from which it can be pasted. Similarly, text is copied to the clipboard by selecting it and either using Edit / Copy or pressing <Ctrl+C>. Copied text remains in the original position, while cut text is removed.

The clipboard is a designated portion of memory where cut or copied text or graphics are stored. Paste is used to insert the contents of the clipboard into a document or another Windows application. Text or a graphic image that resides on the clipboard is inserted into a document at the cursor position by using Edit / Paste or pressing <Ctrl+V>.

Text or a graphic image is moved or copied with these simple key sequences:

- Ctrl+X: Cut
- Ctrl+C: Copy
- Ctrl+V: Paste

**Delete**

Delete a passage of text by selecting it and pressing <Del> or <Delete>. Delete one character at a time by putting the cursor on the character and pressing <Del>. You can delete words using the following sequences:

- Ctrl+Del: Delete next word
- Ctrl+Backspace: Delete previous word
Selecting Text

Select text by dragging it with the mouse. You can also select a word by double-clicking it. Optionally paragraphs are selected by triple-clicking. You can select multiple words, lines, or paragraphs by holding <Shift> while moving the cursor with an arrow key or picking the different passages with your mouse. Marking text is accomplished by dragging it with the mouse or by holding the <Shift> key while pressing any key that moves the cursor including:

Home  left margin
End    margin
PgUp   one screen up
PgDn   one screen down
Ctrl+PgUp top of screen
Ctrl+PgDn bottom of screen
Arrow key up, down, left, or right
Ctrl+Home top of file
Ctrl+End bottom of file
Ctrl+Right Arrow next word
Ctrl+Left Arrow previous word
Ctrl+A entire document

Shortcut Menu

You can display a shortcut editing menu by pressing the right mouse button.

You can then pick the desired operation.
The shortcut menu is intended to save time, as it puts commonly used editing operations at your fingertips. It eliminates the need to move the mouse to the top of the document to pull down a menu.

**Hands-on Activity**

In this activity you use the insert, overstrike, cut, copy, and paste commands with the Some Sample Document.

1. Start Word and open any Sample Document.

2. Position the cursor at the beginning of the first line and type your name; notice how the following text is pushed ahead of the inserted text.

3. Press **<Home>** to move to the beginning of the line, then press **<Ins>** or **<Insert>** on the keyboard to put Word into the overstrike mode.

4. Retype your name and notice that the typed characters overstrike the existing ones.

5. Select the first paragraph (drag it with the mouse or use **<Shift+Down Arrow>**).

6. Cut the selected passage with **<Ctrl+X>;** notice that it disappears.

---

**SAMPLE2.DOC**

**INTRODUCTION TO COMPUTERS**

A Computer is a group of electronic devices used to process data. In the 1950s, computers were massive, special-purpose machines that only huge institutions such as governments and universities could afford.

**NOTE**

Computers were certainly useful for tasks like these, it soon became apparent that they could also be helpful in an ordinary business environment.

---

**SAMPLE2.DOC**

**INTRODUCTION TO COMPUTERS**

**NOTE**

Computers were certainly useful for tasks like these, it soon became apparent that they could also be helpful in an ordinary business environment.
7. Move to the end of the document using <Ctrl+End>.

8. Paste the cut text from the clipboard with <Ctrl+V>; notice that it is inserted at the cursor position. (You have achieved a move operation.)

9. Select the paragraph immediately preceding the moved passage.

**Tip:** You can select lines and paragraphs by putting the mouse cursor outside the left margin until it turns into an arrow. Then click to select the line to the right. Drag to select multiple lines or double-click to select the paragraph.

10. Copy the selected passage as follows:

   a. Press <Ctrl+C> to copy the selected passage to the clipboard.
   b. Press <Ctrl+Home> to move to the beginning of the document.
   c. Press <Ctrl+V> to paste the copied passage from the clipboard.

11. Press <Alt+F4> and click No to exit Word without saving.

### 6.3 Finding and Replacing Text

**The Edit / Find Menu Selection**

The **Edit / Find** menu selection displays the Find and Replace dialog.

This dialog box is also displayed using <Ctrl+F>, <Ctrl+H> for Replace, or <Ctrl+G> for Go To. Notice the Replace and Go To tabs. Also notice that you can click a more or less button to display or hide the search options. Each of the search options within the Find and Replace dialog box is explained on the following page.
Find what: — Accepts the characters or word you want to find.

Search: (Up/Down/All)—Search forward (from cursor position down) or backward (from cursor position up), or search entire document.

Match case — Find only those words that match the upper- and lowercase of the Find what value exactly as typed.

Find whole words only — Eliminate interior strings, such as the in the word their, from the search specification.

Use wildcards — Check this box if you intend to use question marks or asterisks (?) and *) as wildcards. This lets you search variations of the same text string. For example, the finds three, those, and there. St.* finds all words like St. Paul, St. Petersburg, St. Croix, and St. Augustine. In addition to being able to use conventional wildcards, other pattern matching symbols are also available. See Finding Special Characters later in this section.

Sounds like — This check box helps you find words that sound like the search string. For example, you can find merchandise and merchandize, color and color, and Ann and Anne.

Find all word forms — Replace different word forms such as “walk” with “run” and “walking” with “running.”

Find Next button — Click to find the next occurrence of the find string.
**Cancel button**—Click (or press <Esc>) to cancel the find operation and return to the document.

**More/Less button**—Click to display or hide search options and the No Formatting, Format, and Special buttons.

**No Formatting button**—This button is active when the Find what string is formatted as bold, italic, and/or underline. (You can apply standard character formats to your search strings.) When clicked, it removes all formatting from the search string.

**Format button**—Pick a font, paragraph setup (alignment, indentation, etc.), language attribute, or style (normal, Heading 1, etc.). This isolates the Find what string to more specific parameters, eliminating unwanted finds from the operation.

**Special button**—Pick special symbols (such as tabs and paragraph marks), annotations, graphics, and much more from a displayed list.

**The Edit / Find and Edit / Replace Menu Selections**

The Edit / Find menu selection (or the Find folder of the Find and Replace dialog) is used to display the Find options. Find next lets you find the next occurrence from the cursor of the “Find what:” value. The more buttons allows you to choose search criteria such as case and wildcards.

The Edit / Replace menu selection (or the Replace folder of the Find and Replace dialog) is used to display the Replace options. Replace lets you replace the “Find what:” value with a “Replace with:” value. The Replace dialog is shown here.

Pressing <Ctrl+H> also displays this dialog box. Notice that this dialog adds three additional features to the Find dialog box:

**Replace with**—Enter the replacement string here.

**Replace button**—Click to replace the current find.
Replace All buttons—Click to replace every occurrence of the search string without user intervention.

Finding Special Characters (Advanced Search Criteria)

You can find special characters and use wildcards with Word’s Find and Replace operations using the Special button to display special characters. In addition to these, Word features advanced search criteria used for what is often referred to as pattern matching. Check Use wildcards to take advantage of the pattern-matching feature.

Character Description

?  Wildcard for a single character; ca? finds the words cab, cad, cat, etc.; not available in Replace.

*  Find a string; t*e finds the, these, those, tease, tee, etc.

[ ]  Find one of the specified characters; sh[ou]t finds shot or shut.

[-]  Find a single character within a range; [b-e]at finds bat, cat, date, and eat.

{n}  Find exactly n occurrences of the preceding character string; re{2}? Finds reed and reel but not red.

{n,}  Find at least n occurrences of the preceding character string; re{1,}? Finds reed, reel, and red.

{n,m}  Find from n to m occurrences of the character or string; 3{1,4} finds 30, 300, 3000, and 30000.

@  Find one or more occurrences of the previous character or string; ho@t finds hot and hoot.

<(beg)  Find the beginning of a word; <(pre) finds words like prefix, prepare, and previous.
(end)> Find the end of a word; (ing)> finds words like dining, thing, sing, sting, etc.

\* Find the asterisk character; to find an asterisk, precede it with the backslash character to prevent it from being interpreted as a wildcard.

\2\1 Used in the Replace with box; to transpose the expression also ran to ran also, type (also)(ran) in the Find what box and \2\1 in the Replace with box.

**Hands-on Activity**

In this activity you use Find and Replace operations to familiarize yourself with how they work.

1. Start Word; use File / Open to open any Sample Document.

2. Press <Ctrl+F> to open the Find and Replace dialog and type the in the Find what area.

   Click the Find Next button several times until the words otherwise and therefore are found. Then click the Cancel button.

3. Press <Ctrl+Home> to return to the top of the file. Repeat step 2, only this time click on the More button, then put a check mark in the Find whole words only check box. Note how otherwise and therefore are skipped. Click Cancel.

4. Press <Ctrl+F> and locate a paragraph mark (created by pressing <Enter>). Click More / Special and select Paragraph Mark from the pick list to put ^p in the Find what box. Click the Find Next button. Notice how the found
paragraph mark is highlighted. Click the Cancel button and then press \textless Ctrl/Home\textgreater to return to the top of the document.

The paragraph mark ( ) appears as the control code \textasciitilde p in the Find what: text box of the Find and Replace dialog.

5. Use Edit/Replace (or press \textless Ctrl+H\textgreater) to replace the with thx: Type the in the Find what box and type thx in the Replace with box.

Then click the Replace All button. Word replaces the words and displays a message box saying Word has finished searching the document and 64 replacements were made. Click OK and then click the Close button. Notice how occurrences of the are replaced with thx. (You can press \textless Ctrl+Z\textgreater to undo the replace operation.)

6. Press \textless Alt+F4\textgreater and click No to exit Word without saving any changes.

6.4 Styles, Fonts and Font Sizes

Styles

Word comes with a number of built-in styles that are applied to both document headings and normal text. Styles are accessed in the Style box at the left edge of the Formatting toolbar. Look at the Style box illustration at right.
Most large documents make use of many different heading levels, just as a Roman-style outline has levels such as:

I
   A
      1
         a

The levels are typically used to subordinate information under different subject headings. As you can see, Word accommodates this need by providing users with built-in heading styles named Heading 1, Heading 2, and so on.

**The Importance of Styles**

Styles are applied by placing the cursor on a heading or passage of text and then selecting the desired style name from the Formatting toolbar’s Style dialog.

You can create styles of your own and add them. Just format a selection, highlight it, click on the style box, and type a descriptive style name. This can be saved to the global normal. dot template using the Format / Style menu selection and corresponding dialogs. It’s just as easy to change existing styles. For example, many users find the default 10-point font size is too small and change it to 12 points. You can also change the heading styles to suit your personal taste.

Applying heading styles is extremely important if you plan to use the Master Document and Outline views (see the View menu). The use of heading styles is also required when generating an automatic table of contents or table of figures (see Insert / Index and Tables), as Word relies on the style levels for format control.
You can also use the Style Gallery selection of the Format menu to select a supplied style for the creation of memos, fax sheets, letters, and more. Use Format /Style to add, delete, and change existing style templates.

**Creating and Modifying Styles**

To create a style, simply format a paragraph using the desired margins, alignment, font, and font size selections. Then:

1. Select the paragraph by highlighting it with the mouse.

2. Use the Format / Style menu selection and click the New button to display the New Style dialog.

3. Type a meaningful name in the Name box and click OK in the first dialog. Click Apply to save the style, then click Cancel to discard it.

4. Change styles using the Style dialog’s Modify button, which displays the following choices. (Notice that the Format button pick list is active.)
Use the Format button to modify the font, size, paragraph settings, borders, and more using corresponding dialogs. If you wish, you can use the Shortcut Key button to assign a shortcut key sequence to your new style. You can also use the Modify button to assign a shortcut key sequence to existing styles. This is intended as a time saver and is optional.

5. Once the format is set to your liking, click **OK** and check the format information in the Description area.

6. When finished, click the **Apply** button to save the style with the current document or click **Close** to avoid saving the style.

**Style Creations Shortcut**

You can also create a new style by selecting a paragraph containing the style parameters you want. Then:

1. Pick the Style box (left edge of the Format toolbar) with your mouse.

2. Type a meaningful style name.

3. Press <Enter> to finish adding the new style to your list.

**Deleting a Style**

Delete an unwanted style using the Format / Style selection. Just pick the style name in the Style dialog Styles list and click the Delete button. Finally, click Close to exit the dialog.

**Copying Styles to Other Documents**

You can use the Style dialog box to copy a new style to a template file. For example, you may want to put a Note title style in the Normal.dot template. Begin by opening the document in which the new style is available. Then open the Style dialog. Note that you can change the List setting to pick styles from different sources. When set, click the Organizer button to display the Organizer dialog box.
Pick the desired style name and click Copy to copy the style from the selected source document to the template. As you can see from the preceding dialog box illustration, you can also delete and rename styles here as well. Rename is often used to make a style name more descriptive or to eliminate conflicting names.

**Fonts**

Available fonts depend on the installed printer and Windows applications. If you are using Windows 95/98 with Microsoft TrueType fonts, you have a nice starter set. You can also install additional fonts by purchasing available font packs. Some applications, such as Microsoft Publisher and Corel Draw, add many new fonts to Windows. If you have a PostScript printer, you may have several built-in printer fonts. Regardless of the installed printer, a type style usually requires several fonts to round out an entire font family. For example, you may have a normal, bold, and italic font. Therefore, Times New Roman normal, **bold**, and *italic* count as three fonts.

Fonts are changed by picking the font box and then pressing the Down Arrow to view a list of font names. Then pick the desired font name. You can type the first letter of a font, such as C, to move to the beginning of those fonts that start with the letter C. To change the font in an existing passage, simply highlight it and pick a new font name.
Font Sizes

Font sizes are increased or decreased using the Font Size box on the Formatting toolbar. The down arrow displays different numbers that correspond to point sizes (a point is 1/72 of an inch). You can pick a new size from the displayed list. You can also:

- Increase the font size of a selected passage one point at a time with <Ctrl+>.
- Decrease the font size of a selected passage one point at a time with <Ctrl+[>.

Type Styles (or “Attributes”)

Type attributes include normal, bold, italic, and underline. The default attribute setting is normal. You can change the attribute of existing text by selecting it (so that it is highlighted) and then clicking the B, I, or U button on the formatting toolbar. If you are a keyboard person, you can also use one of the following key sequences to achieve the same result:

- Ctrl+B      Boldface
- Ctrl+I       Italic
- Ctrl+U     Underline
To enter new text in the desired attribute, select the attribute button or key sequence and type the text. Click the button again or press the key sequence to turn off the attribute.

**Changing Case**

Word offers you a quick way to change uppercase to lowercase and initial capitals (first letter capitalized). To change case, select a passage of text and use the Format / Change Case menu selection to use the Change Case dialog. Or press <Shift+F3>. The first keypress changes the passage from all lowercase to an initial capital followed by lowercase. The second keypress changes it to all capitals. Pressing <Shift+F3> again changes the selection back to all lowercase.

**Hands-on Activity**

In this activity you use the Sample2.doc file with the Font Style, Font, and Font Size commands described above.


2. Use the **File / Page Setup** menu selection to set all margins to 1" and click **OK**.

3. Press **<Ctrl+A>** to select all. Then click the **Font Size** down arrow on the Formatting toolbar and pick **12** points.

4. Put the cursor on the first paragraph. Pick the **Style** box, type **Norm12**, and press **Enter**.

5. Notice that Norm12 is displayed in the Style box at the left end of the Format toolbar.

**Note:** The Norm12 style is now attached to the Sample2.doc. If saved, it can be copied to the global Normal.dot template using the Format / Style menu selection’s Organizer dialog.

6. Highlight the entire first paragraph of the document.

7. Click the **Arial** font (or another available font) on the Formatting toolbar. Notice how the paragraph changes.
8. With the passage still selected, pick 8 from the Font Size list. Notice how the font size of the selected passage changes.

9. Select the centered Sample2.doc title at the top of the first page, and press <Shift+F3> to change the case from uppercase to lowercase to initial capitals and then to uppercase again.

10. Exit Word with <Alt+F4> and pick the No button to avoid saving the changes.

6.5 Creating Lists and Numbering headings

Word makes list creation and conversion simple. You can convert lines of text into numbered lists or procedural steps. Word automatically assigns the proper numeric sequence to a series of selected passages. Similarly, Word lets you select one or more paragraphs (or lines) of text and then convert the selected passage into a bulleted list. The Format / Bullets and Numbering menu selection lets you modify the bullet style or the numbering sequence.

The fastest way to create a numbered or bulleted list is to use the Numbering or Bullets buttons on the Format toolbar. Once text is selected, simply click the appropriate button to automatically convert your list to the desired form.
Handson Activity

The following activity guides you through the creation of numbered and bulleted lists. It also shows you how to change the number sequence and bullet style, and how to exchange numbers for bullets and bullets for numbers.

1. Start Word and open any Sample document.

2. Select the text in a Paragraph.

3. Click the Numbering button; notice how numbers 1 through 4 are automatically inserted to the left of the text.

4. Select the Format / Bullets and Numbering menu selection's Numbered tab and select the a., b., c., format. Click OK and see how the numbers are changed to letters.

Tip: The Customize button of the Numbered tab is used to select additional numbering formats as well as the spacing.

1. Start Word and open any Sample Document.
2. Position the cursor at the beginning of the first line and type. Notice how the following text is pushed ahead of the inserted text.
3. Press <Home> to move to the beginning of the line, then press <Insert> on the keyboard to put Word into the overstrike mode.
4. Retype your name and notice that the typed characters overstrike.

5. With the original passage still selected, click the Bullets button. Notice how the letters are replaced with bullets.

6. Use the Bulleted section of the Bullets and Numbering dialog box to change the bullet to a filled rectangle (the upper right selection box).

7. Click OK and notice the new bullet character.
Classification of Computers

a. Super Computers
b. Main Frames
c. Mini Computers
d. Micro Computers

- What is a Computer?
- Components of a computer
- Input Devices
- Output Devices
- CPU
**Heading Numbering**

When you use different heading styles from the style box, i.e., Heading 1, Heading 2, etc., you can apply heading numbers using the Outline Numbered tab of the Bullets and Numbering dialog. Here, multilevel outlines and indentations are automatically applied. Just pick the style you want to use and click OK.

**Tip:** Styles are created, changed, and applied from the Style box on the Formatting toolbar. Just click on the text element and then choose the desired style.

8. Press `<Alt0+F4>` and click No to exit Word without saving your changes to the Sample2.doc file.

### 6.6 Creating Headers and Footers

A header is a text that appears at the top of each page (or the pages you select, such as all Even pages) in your document. Footer appears at the bottom of your pages. You don’t have to add headers and footers to each page – Word 2000 enables you to type them just once and it automatically add them to each page.

A Header contains text that appears at the top of your document pages. Footer contains text that appears at the bottom of your document pages.

**To add a header or footer, follow these steps:**

- Select View, Header and Footer to display the Header and Footer toolbar, as well as outline boxes where you can type the header and footer text.

- Type your header text. If you want to type footer text, click the toolbars switch between Header and Footer button to display the footer text box and type your footer text, click the appropriate toolbar buttons.

- Click the Close button to anchor the header or footer in your document.

Word 2000 normally dims header and footer text so that you can easily distinguish between the header, footer, and the rest of your document text.
when editing your document within the Page Layout view. If you want to specify that the header (or footer) appears only on certain pages, select the File, Page Setup option and adjust the Headers and Footers values. You must be in the Page Layout view to see headers, footers, footnotes, and endnotes in their proper places in the page.

Adding Footnotes and Endnotes

A footnote differs from footer in that a footnote appears only at the bottom of the page on which you include it. Word 2000 inserts a footnote reference in the text where you choose to insert the footnote; If you later add text to the page so that the footnote reference moves to the next document page, Word 2000 automatically moves the footnote as well. Therefore, the footnote always appears on the page as its reference.

Footnotes contain text that appears at the bottom of the page on which its corresponding footnote reference appears.

To insert a footnote, follow these steps:

1. Select insert, footnote. Word 2000 displays the Footnote and Endnote dialog box shown in fig.
Endnotes are footnotes that appear at the end of your document rather than at the bottom of each page. Click the option you want to add, Footnote or Endnote.

**Note:**

1. Endnotes are footnotes that appear at the end of your document, each with its own endnote reference number that appears in the document.

2. If you want 2000 to number the footnote (or endnote) sequentially starting with 1, click OK. If you want to use a different symbol for the number, click Custom mark and enter the reference you want to use.

3. Type the footnote (or end note) and click your mouse on the body of the document to resume editing.

Remember that you must display the Page Layout view to see headers, footers, footnotes, and endnotes in their proper places on the page. If you display your document in Normal view, Word 2000 displays the supplemental notes in a separate window.
6.7 Inserting Page Breaks, Page Numbers, Bookmarks, Symbols and Dates

The Insert Menu

The Insert menu, shown here, includes a number of selections. Once you know its uses, a substantial amount of power is placed at your fingertips.

This section deals with a few of the Insert menu’s capabilities. Following sections address the remainder of the menu items. Below is a list of what each of the menu selections does. Then a hands-on activity guides you through the use of several of these.

Break—Inserts a page break, column break, or section breaks at the current cursor position.

Page Numbers—Inserts a page number and controls the format, position, and value.

Date and Time—Inserts the current date and/or time. Pick the format from a list.
AutoText—Inserts frequently used words, names, or titles or displays the AutoCorrect dialog. AutoCorrect automatically corrects common typographical errors, automatically numbers lists, replaces certain strings with equivalent symbols, such as (r) with ®, and much more.

Field—Inserts selected information (from a pick list) at the current document location. Used to merge an equation, table of contents, index, selected data in another file, etc., into the current document.

Symbol—Inserts a selected symbol from a displayed list of fonts and a corresponding symbol table.

Comment—Inserts a comment and activates the comment pane, in which a comment can be recorded about a selected passage. Double-clicking a comment symbol displays the corresponding comment. Word automatically assigns sequential comment numbers as each is added.

Footnote—Inserts a footnote reference at the current cursor position.

Caption—Inserts a figure or table captions above or below a selected object.

Cross-reference—Cross references headings, bookmarks, footnotes, endnotes, equations, figures, and tables to corresponding items such as page numbers, paragraph numbers, heading numbers, captions, footnote and endnote numbers, etc.

Index and Tables—Used to create and edit an index, table of contents, table of figures, or table of authorities (bibliography-style references).

Picture—Inserts a picture (graphic file) into the displayed document.

Text Box—Inserts a text box (framed text) within a document. Ideal for side bars in newsletters and brochures.

File—Inserts a named file at the current cursor position; displays a pick list of filenames.

Object—Inserts a picture, equation, drawing, chart, worksheet, or another object from other applications.
**Bookmark**—Inserts a reference point in a document. Once inserted, use Edit / Go To in order to jump to a selected bookmark.

**Hyperlink**—Applies a hyperlink to a selected passage of text within the current document. Hyperlinks provide direct access to web sites on the Internet.

**Bookmarks**

You can insert one or more invisible bookmarks into your documents using the Insert / Bookmark menu. A bookmark can be a letter, number, or passage of your choice. The Bookmark dialog box lets you add or delete bookmarks as needed. Once a bookmark is established, use Edit / Go To (or press <Ctrl+G>) to select and “jump” directly to the designated bookmark. You create and use a bookmark in the following hands-on activity.

**Hands-on Activity**

1. Start Word and open any Sample Document.

2. Move to the blank line following the centered title “Sample” and insert the current date as follows:
   a. Click Insert / Date and Time to display a pick list.
   b. Pick a date format you like, such as Month, Day, Year (or Day, Month, Year if you’re outside the U.S.), and click OK.
   c. Notice how the system date is inserted at the current cursor position.

3. Use **Insert / Page Numbers** to place page numbers at the bottom right of each page; your Page Numbers dialog box should look like the following one before clicking OK.

4. Press <Ctrl+End> to move to the bottom of page 2; then press <PgDn> until the page number (page 2) comes into view to verify that page numbers have been inserted.

**Note:**

The Format button within the Page Numbers dialog box displays a Page Number Format dialog box. Use this box to change the page number style, i.e., 1, 2, 3; A, B, C; i, ii, iii; etc., and to start the page number sequence at a value greater than 1.
5. Move to the beginning of the word “ ” near the bottom of the first page. Press `<Ctrl+Enter>` and notice that you have inserted a manual page break. (You can also use **Insert / Break** to display the Break dialog box as an alternate method.)

6. Select the text of the NOTE near the beginning of the document.

7. Use the **Insert / Bookmark** menu selection and enter note in the Bookmark name text box. Click **Add**; this establishes a bookmark named “note.”

8. Press `<Ctrl+End>` to move to the bottom of the document. Now jump back to the bookmark named “note” by pressing `<Ctrl+G>` (for Go To), pick **Bookmark** from the list, check that “note” is displayed, and click **Go To**.
9. Click **Close** to exit the Find and Replace dialog.

10. Press `<Ctrl+End>` to jump to the bottom of the document. Press `<Enter>` twice. Now insert the pound sterling symbol as follows:

   a. Use Insert / Symbol, select “(normal text)” in the Font text box, and choose the £ symbol (on my screen it is the fourth row, fourteenth column). Click Insert and press <Esc> to close the dialog box.

   b. Notice how the £ symbol is inserted at the cursor position.

11. Press `<Alt+F4>` and click **No** to exit Word without saving the changes to your document.

### 6.8. Short Summary

♣ The Page Setup dialog includes the Margins, Paper Size, Paper Source, and Layout tabs from which you may adjust the appropriate page features.

♣ The clipboard is a designated portion of memory where cut or copied text or graphics are stored.

♣ Fonts are changed by picking the font box and then pressing the Down Arrow to view a list of font names.

♣ Word comes with a number of built-in styles that are applied to both document headings and normal text.

♣ Word automatically assigns the proper numeric sequence to a series of selected passages.

♣ A Header contains text that appears at the top of your document pages. Footer contains text that appears at the bottom of your document pages.
Lecture 7

Working with Objects, Comments, Tables

Objectives

In this Lecture you will learn the following:

- Inserting Objects
- Drawings
- Place Comments
- Working with Tables
Coverage Plan

Lecture 7

7.1 Snap Shot
7.2 Working with Text boxes & frame
7.3 Working with Pictures
7.4 Working with Objects
7.5 Inserting Place Comments
7.6 Working with Tables
7.7 Short Summary
7.1 Snap Shot

In this lecture you will learn about working with Inserting objects, inserting drawing, in place comments and it will guide you how to familiarize these things.

Word includes a set of drawing tools when you display the Drawing toolbar. This is done using either the View / Toolbars menu selection or by clicking the Drawing button on the Standard toolbar.

7.2 Working with text boxes and frames

A text box is an open rectangle that is placed within a document using the Insert/ Text Box menu selection. You can type text within the text box. The text can be rotated 90 degrees for special effects. One text box can be linked to a following, empty text box so that text that overflows the boundaries of the first text box continues into another designated text box. Text boxes can contain pictures as well as text, and therefore can be used like a frame. Text box borderlines and colors are changed or removed using the Colors and Lines tab of the Format Text Box dialog (accessed from the Format menu).

Previous versions of Word made use of frames. Readers who are familiar with frames should know that a text box and can be quickly converted to a frame. Selecting a text box and clicking the format does this. Then select the Text Box tab and click the Convert to Frame button. Word’s menu selections and dialog boxes often vary with the current selection. For example, when you select a frame, Format / Frame replaces Format / Text Box. Word 2000 frames are similar, but not identical, to earlier Word frames. For example, precise scaling of a graphic object is no longer possible using the percentage readout on the status bar.

Both text boxes and frames can be clicked and dragged, resized, and even copied and deleted just like any other object within a Word document. You can also select a passage of text and use Insert / Text Box to put the selected text inside a text box. Finally, the Drawing toolbar includes a Text Box button, making it easy to put a drawing inside a text box. Once a text box is inserted into your document, you can select it and use the Format Text Box dialog box, which is displayed using the Format / Text Box menu selection, to set a number
of controls including text wrapping, position, and the distance to adjacent elements.

There are a number of available cursors associated with frames and other inserted objects.

**Note:**

After clicking Insert / Text Box, you will see the cursor at the place you chose to place the text box. The mouse pointer will change to crosshairs, which is your prompt to left-click and drag the crosshairs to dimension the size of the text box. The Text Box dialog shown becomes visible when you select the text box by clicking on it.

A cross hair cursor is used to insert and size a frame. Handles are filled squares located in the corners and on the center of each side. This tells you that the text box or frame is selected and ready for modification. When active, it can be resized, repositioned, deleted, cut, or copied.

A double-headed arrow is used to stretch the text box or frame horizontally, vertically, or diagonally. Placing the cursor near a handle changes it into a double-headed arrow. You can crop out unwanted white space or images by pressing the `<Shift>` key while dragging a handle in or out. Cropping is a technique used to take out unwanted background areas. Press the `<Ctrl>` key to adjust opposite sides by the same amount.

The crossed double-headed arrow cursor is used to move the text box or frame. When the cursor changes to a crossed double-headed arrow symbol, you can pick a text box or frame with a mouse click and drag it to a new location within your document. You can also cut and paste a frame to move it to another location in your document or, for that matter, to another document using drag and drop.

An anchor symbol indicates the paragraph to which a text box or frame is tied. If the line moves when preceding text is inserted or deleted, the text box or frame moves with the paragraph to which it is anchored.
Charts and pictures, which are typical objects, are automatically loaded into resizable frames of their own. You can also put an object within a text box or frame to achieve text runarounds, in which the text of your document wraps around an object, such as a picture or chart. There are a number of runaround settings to choose from. The hands-on activity shows you the effect of runarounds.

The text box borders are controlled by the Colors and Lines tab of the Format Text Box dialog. You can also use the Format / Borders and Shading menu to adjust the appearance of borders. The combination of the Format Text Box and Borders and Shading dialogs gives you a large number of options for borders, colors, interior fills, and shading.

The following hands-on activity guides you through the creation and editing of text boxes and borders. It also introduces you to text box links.

### 7.3 Working with Pictures

**The Drawing Toolbar**

Once you click the Drawing button, the Drawing toolbar is displayed along the bottom of your screen. Here, you can select tools that allow you to draw lines, boxes, and circles. Other tools let you draw such things as maps or “Mr. Sun.” Following is an illustration of the Drawing toolbar and a brief description of each tool.

**Draw**—Select a control from a drop-down box to group/ungroup, arrange the order, nudge, align, rotate, apply a grid, etc., to one or more selected objects.
Select Objects—Select one or more objects by either clicking or dragging a box around them.

Free Rotate—Click a drawing object and then click this button. Drag a corner to rotate the selected drawing object.

AutoShapes—Select one of many shapes including lines, arrows, flowchart symbols, stars and banners, and callout.

Line—Drag a line by picking the starting point and dragging to the endpoint.

Arrow—Click and then drag an arrow onto the page.

Rectangle—Drag a rectangle or square with this tool. Pick one corner and drag to the opposite corner, then press <Shift> and drag to draw a perfect square. Use Line Style and Line Color tools to change the line weights and colors. Use Fill Color to change the interior (fill) color.

Oval—Draw a circle or an oval by selecting the tool, placing the cursor at a desired point, and dragging the circle or ellipse. Press <Shift> while dragging the circumference to create a perfect circle. Use Line Style and Line Color tools to change line weights and colors.

Text Box—Drag a text box onto the page into which you can type and rotate text.

Insert WordArt—Start the WordArt add-in to create a WordArt text object. Use the drop-down box to select a style. Type the text in a displayed WordArt window and click OK. You can also highlight text before clicking the WordArt button.

Insert Clip Art—Open the Insert ClipArt dialog to insert clip art at the current cursor position.

Fill Color—Change the interior color of a drawing object such as a rectangle, circle, freeform shape, or callout box.

Line Color—Change the color of a line, rectangle, circle, arc, callout box, etc.
Font Color—Change the font color using a drop-down palette box.

Line Style—Change the line style including such characteristics as thickness, double lines, etc.

Dash Line—Change or apply a dashed line to one or more selected lines by choosing one from a drop-down box.

Arrow Style—Change or apply an arrow style to a selected line or arrow by choosing one from a drop-down box.

Shadow—Apply a shadow effect to the selected object from a drop-down box of shadowed objects that correspond to the selected object.

3-D—Apply a 3-D effect to the selected object from a drop-down box of 3-D shapes that correspond to the selected object.

Hands-on Activity

In this activity you open a blank document (Document1.doc) and create and edit a drawing.

1. Start Word and display a blank document.

2. Use the File / Page Setup / Margins menu selection to set all margins to 1". Close the Margins dialog.

3. Click the Show/Hide ( ) button as necessary to hide paragraph marks and other special symbols.
4. Click the Drawing button to display the Drawing toolbar.

5. Use the Line and Text Box tools to draw and annotate the simple map shown in the following Word-produced illustration. Be sure to adjust the sizes of the text boxes by dragging them so that interior text fits properly.
**Tips:**

Use the following tools to draw the map. Set all text to Times New Roman. Thicken the lines to 2-1/4 pt using the Line Style tool. Insert the four-point star using **AutoShapes / Stars and Banners**. Make the star gray using the Fill Color tool on the Drawing toolbar. Remove the lines from around the text boxes using **Format / Text Box / Colors and Lines**, and selecting **No Line** in the **Line Color** text box. (The cursor must be inside the text box before the Format menu selection will enable the Text Box option.) Use **Format / Text Direction** to rotate the 9th Street text 90 degrees. Select each text box and use the Draw button’s **Order / Send to Back** options. Use the Ctrl+Arrow keys to nudge the text into place next to the streets.

6. Click the **Select Objects** (the leftmost arrow on the Drawing tool bar) tool and drag a selection box around the four-pointed star and the N and S text boxes.

7. With handles visible on all three objects, use **Draw | Group** to combine the three selected objects into a single group.

8. Click the **Select Objects** tool again and drag a selection box around the entire drawing so that all items are selected.

9. Use **Draw / Group** to combine all items into a single group. This allows you to move the entire drawing in unison when it is placed with text on the page.
10. Press `<Alt+F4>` and click **No** to exit Word without saving your drawing document.

### 7.4 Working with Objects

Objects are pictures, charts, worksheets, and other elements typically created by other applications. Word is supplied with several add-in applications, two of which are described here—WordArt and the Equation Editor. In addition, this section shows you how to access Microsoft Excel worksheets from within Word, as well as Paintbrush pictures.

To use WordArt and Equation Editor, they must have been selected when you first ran Word (or Microsoft Office 2000) Setup. Otherwise, run Setup and add them now if you want to learn how to use them. Once installed, they are accessed by using the Insert / Object menu selection. (You can also access WordArt from the WordArt and Drawing toolbars.) If you did not install these applications and have no interest in learning about them, move on to Section 25 where you learn how to automate repetitive tasks with macros.

**WordArt**

The WordArt program is used to create, insert, and edit fancy type in your documents. WordArt adds additional display-style type fonts that are ideal for brochures, fliers, and even presentations. With WordArt, you can create vertical, slanted, and curved text for eye-catching headings and banners.

WordArt is started from an open Word document using Insert / Object and then picking Microsoft WordArt 3.2 from a displayed list of objects. You’ll see other types of objects that are created and saved by other programs. These include drawings, charts, graphs, worksheets, macrosheets, documents, and even Paintbrush pictures. Word has the ability to convert these objects and use them in your Word documents.

When Microsoft WordArt 3.2 is selected, the full WordArt editing screen is displayed.

Here, you enter or edit text in the Enter Your Text Here dialog box. Use the WordArt toolbar to achieve a number of special effects.
The operation of each toolbar button is described in the following list in left to right order.

**Shape** — Pick the shape of the text, such as Plain Text, Slant Up, or Circle.

**Font** — Choose a font from a drop-down pick list.

**Size** — Choose a font size; Best Fit automatically adjusts text to fit the available area.

**Bold** — Bold the displayed type.

**Italic** — Italicize the displayed type.

**Even Height** — Make all letters the same height regardless of capitalization.

**Flip** — Turn WordArt text on its side.

**Stretch** — Spread the text horizontally and/or vertically to fit the available space.

**Align** — Align text centered, left, or right.

**Spacing Between Characters** — Spread and shrink the space between characters.

**Special Effects** — Rotate the text by entering the degrees of rotation or use the slider control to change the shape.

**Shading** — Pick a fill pattern for the WordArt text.

**Shadow** — Display a list of special effects with shadows for the WordArt text.
As you can see, WordArt offers many powerful features for emphasizing your written communications with special sizing, stretching, rotation, font selection, shading, and more. If you wish to insert a special symbol, such as a trademark or Wingding symbol, click the Insert Symbol button at the bottom of the Enter Your Text Here dialog. The displayed symbols use the current font. Use the Update Display button to change the displayed WordArt text in your document. Once the WordArt text suits you, click on the underlying document (away from the Enter Your Text Here dialog box and WordArt toolbar) to return to the normal document screen. Just like other inserted objects, WordArt objects are inserted at the cursor position. You can double-click on the WordArt text to restart WordArt for further modifications. The hands-on activity at the end of this section guides you through the use of WordArt.

**Microsoft Equation 3.0 (the Equation Editor)**

Like Microsoft WordArt 3.2, the built-in Equation Editor is also accessed using the Insert / Object menu selection. Pick Microsoft Equation 3.0 from the displayed list of application objects. Either double-click Microsoft Equation 3.0 or click OK to start the Equation Editor. When the Equation Editor is active, you see a screen similar to the following illustration.

At this point you are ready to create an equation. Notice the Equation toolbar and the new menu items. The toolbar buttons are used to pick Greek and math symbols, equation fences (or boundaries), and a number of other items typically
used in equations. The name of each button is listed on the following page for your information. Following the button list is a brief description of each menu.

**Equation Editor Menus**

The Equation Editor menus are used to select fonts, sizes, boldface, italics, and much more. Following is a brief overview of the purpose of each menu.

**File**—This menu performs the same basic file operations as the Word File menu.

**Edit**—Choices are typical of Edit menus, including Undo, Cut, Copy, Paste, Clear, and Select All.

**View**—This menu provides different zoom selections. It also lets you Show All and Redraw the current equation. Redraw is helpful if you delete an element and a residual image remains.

**Format**—Here, you can align equation elements left, center, right, or on an equal or percent sign. You can also control the spacing between lines for superscripts and subscripts and between matrix elements. A matrix selection lets you control the format of a mathematical matrix consisting of rows and columns of values.

**Style**—This menu is used to apply a specific style to a selected group of elements or to elements typed following the style selection. Styles include:

**Math**—Choose function or variable font automatically based on selection.

**Text**—Use to apply standard text fonts and character styles.

**Function**—Use to apply function fonts and character styles to one or more characters or symbols.
Variable — Use to apply variable fonts and character styles to one or more characters or symbols.

Greek — Use to apply Greek fonts and character styles. Also accessed with <Ctrl+Shift+G>. You can use <Ctrl+Shift+G> to enter the next characters typed as Greek, or to convert a selection from normal text to Greek text.

Matrix-Vector — Also accessed with <Ctrl+Shift+B>, this selection is used to apply vector fonts and styles to selected characters.

Other — Use to apply another font and to designate it as bold or italic.

Define — Use the displayed dialog box to define the fonts to be used with each of the style selections. You can also use a Bold and Italic check box to designate the use of normal, bold, or italic.

Size — Apply an appropriate size to one or more selected elements including Full, Subscript, Sub-Subscript, Symbol, and Sub-Symbol. Other lets you choose a point size, while Define lets you modify the sizes of equation elements.

Window — This menu item is identical to Word’s document Window menu in which you can move between documents, arrange (or tile) the open Word documents in separate windows, or split the active document into two working panes.

Help — This menu item is like other Help selections, as it provides helpful information about Equation Editor features and operation.

In the hands-on activity at the end of this section you use the Equation Editor to prepare an equation in a practice document. This experience should be sufficient to encourage your continued use of this powerful Word utility program.

The Equation Toolbar

Look at the Equation toolbar illustration. When you click one of the buttons on the Equation toolbar, an additional series of buttons is displayed. Select your templates, symbols, and special characters by holding down the left mouse button until your choice is highlighted; then release the button and the selection
is displayed in the outlined equation object area. You can control the placement of equation elements by highlighting them and then using `<Ctrl+Arrow Key>` to move them up, down, left, or right. Use the Size / Subscript menu selection to create a subscript/superscript-size character. Then nudge the character into position. Space between equation elements is added using the Spaces and Ellipses button. The Equation Editor does not accept normal Spacebar entries unless you select Text from the Format menu. Once an equation is set, click on the document to insert it in your document. To return to the Equation Editor, just double-click on the equation object.

The following math symbol templates are available in Word 2000. Explore the various buttons to see what symbols are available.

---

**Excel Worksheets**

If Excel is installed on your system, either independently or as part of Microsoft Office 2000, Word gives you direct access to the power of Excel worksheets. This is done by first positioning the text cursor at the desired insertion point within your document. Then click the Insert Microsoft Excel Worksheet button on the Standard toolbar. Drag the number of rows and columns and release the mouse button. The example here shows a 4 x 4 cell worksheet.

After a brief period (depending on your processor speed and the amount of available memory), a blank Excel worksheet appears in your document. In addition, the Excel menu and toolbar are displayed.

At this point you can create or load a stored worksheet file. Although the use of Excel 2000 is not the focus of this part of the book, the following hands-on activity guides you through the use of Excel. For an in-depth Excel tutorial, see Part 3 of this book.
**Working with Other Objects**

In addition to accessing WordArt, Equation, and Excel Worksheet objects, you can also use the Insert / Objects menu selection to create new files or use existing files produced by other Windows-based programs. When you import an existing file, it can be updated using the originating program. For example, if you use the Create from File section of the Object dialog box to insert a Paintbrush picture, you can later use Paintbrush to edit the picture and automatically update the picture in your Word document. This is an example of object linking.

When you use the Create New tab of the Object dialog box, you can create a new object within the current document. Once active, you can create a new worksheet, picture, graph, etc. This lets you run the application directly from Word without having to move out of Word to start the application.

You can also use the Create from File tab to import existing files. Once inserted in your document, the inserted material becomes an integral part of your document. Just double-click it to launch the application for editing.

The hands-on activity guides you through the insertion of a Paintbrush picture. This activity is typical of how files created by other programs can be used in your documents.
Hands-on Activities

In the following activities you create and embed WordArt, equation, and Excel objects into a document. Then you create and insert a Paintbrush picture object. If you have not installed WordArt, the Equation Editor, or Excel, skip the activities relating to the missing program(s) and move to the next one. Be sure to end your activity by performing the Paintbrush Object activity.

1. Start Word and display the blank Document1 screen.

2. Type Object Document; press <Ctrl+E> <Enter> <Ctrl+L><Enter> <Enter><Enter>; then press <Up Arrow> once.

3. Perform the following activities that make use of the programs installed on your computer, i.e., WordArt, Equation 3.0, or Excel.

Insert Microsoft WordArt 3.2 Object

1. Use Insert / Object, pick Microsoft WordArt 3.2, and click OK.

2. Backspace to delete the text in the Enter Your Text Here box. Type Microsoft <Enter> WordArt <Enter> Object. Then click the Shape down arrow and select the Button (Pour) shape (third row, fourth column).

3. Pick the Font down arrow and pick a script font such as Brush Script MT.

4. Pick the Border button (rightmost button on the toolbar), pick Normal, and click OK.

5. Click on the underlying document. Then drag the WordArt object to the center of the page.

Insert Microsoft Equation 3.0 Object

1. Use Insert/Object, pick Microsoft Equation 3.0, and click the OK button to start the Equation Editor.
2. Type the equation shown here using the indicated steps.
   a. Type XC=
   b. Pick the Fraction and Radical Templates button on the bottom row of the Equation toolbar, select the fraction template (the first template), and release the mouse button.
   c. Type 1, press <Tab>, then type 2.
   d. Pick the pi character (use the Greek lowercase button—rightmost character on the fourth row).
   e. Pick the Fraction and Radical Templates button again, select the square root symbol (the one with the interior dashed box fourth row, first column), and release the mouse button.
   f. Type FC to complete the equation entry.
   g. Select (highlight) the C in XC. Then pick Size/Subscript from the menu bar.
**Insert Microsoft Excel Object**

1. Pick the **Insert Microsoft Excel Worksheet** button on the Standard toolbar. Drag a 4 x 4 cell area and release the mouse button.

2. Use your mouse or an arrow key to select each cell, type the information as shown below, and press **<Enter>** after each entry.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Item</td>
<td>1st Half</td>
<td>2nd Half</td>
<td>Year</td>
</tr>
<tr>
<td>2</td>
<td>Income</td>
<td>448</td>
<td>534</td>
<td>=SUM(B2: C2)</td>
</tr>
<tr>
<td>3</td>
<td>Expense</td>
<td>467</td>
<td>472</td>
<td>=SUM(B3: C3)</td>
</tr>
<tr>
<td>4</td>
<td>Profit/Loss</td>
<td>=B2-B3</td>
<td>=C2-C3</td>
<td>=SUM(B4: C4)</td>
</tr>
</tbody>
</table>
Note:

To view the formulas in the cells, click on Tools / Protection and then on Protect Sheet; check all check boxes. Close the Protection dialog box. Now, click on Tools / Options / View / Window Options and click on Formulas.

3. Drag cells A1 through D4 so they are highlighted. Then use Table / AutoFit / AutoFit to Contents to automatically adjust all column widths.

4. Compare your Excel display to the following illustration.

5. Click away from the worksheet and toolbar to move back to your document.


Insert Microsoft Paintbrush Object

1. Use the Insert / Object selection, pick Paintbrush Picture, and click OK. Notice how Windows Paintbrush runs inside Word.

2. Draw an overlapping rectangle and circle (look at the following example).

![Excel Spreadsheet Example]

a. Click the Rectangle tool, drag a rectangular shape, and release the mouse button.

b. Click the Ellipse tool. Starting at the upper left-hand corner, drag a circular shape over the rectangle and release the mouse button.

c. Click on the underlying document to return to Document1. Notice how the Paintbrush picture object is automatically inserted in the document.
d. Press the Crop button on the Picture toolbar and crop out (remove) the excess space around the drawing.

Notice how this activity demonstrates the “seamless” integration of several Windows 95/98 applications.

Exiting Word

1. Before exiting Word, you may wish to start one or more of the controlling programs for the embedded objects by double-clicking on the objects.

2. When you are finished experimenting with your document, press <Alt+F4> and click No to exit Document1 without saving the practice material.

7.5 Inserting Comments

You can insert the date and time at the cursor's current position. Select Insert, Date and Time, and select the date and time format from Word 2000’s selection list. If you click the Update Automatically option, Word 2000 constantly updates the date and time; if you leave the Update Automatically option unchecked, Word 2000 keeps the original date and time in the document.

One of the most interesting items that you can insert in a Word 2000 document is a comment. A comment does not print, but shows up on your screen highlighted in yellow so that you are sure to see it.

Suppose that you want to remind yourself to do something later when you edit the document, such as format the title with information you will do a research before writing yourself a comment! The comment acts like a yellow sticky note. The comment stays attached to your text, but you can read or remove the comment whenever you want.

To insert a comment in your text, select Insert, Comment. Word 2000 displays the comment’s annotation window, as shown in Fig.
Word 2000 names each of your comments using your initials (found in the document property settings). After you type your comment and click Close, Word 2000 attaches the comment to your text and indicates the comment by highlighting the anchor text in bright yellow and inserting the comment name inside square brackets. Comments provide a convenient method for leaving messages for coworkers inside documents that you edit as a team.

Subsequently, when you edit your document, you will see the yellow comments. If you right click the comment, Word 2000’s pop-up menu enables you to edit (or read) the comment, or delete the comment from the text.

7.6 Working with Tables

Word 2000’s report-creation power shines when you see how easily you can create customized tables of information inside Word 2000. Tables are collections of information organized in rows and columns. Tables might contain numbers, text, even graphics, or combinations of any of these. Each row and column intersection is called a cell. When you use both Word 2000 tables, Embedded worksheets enable you to report financial data from within Word 2000.
Creating a New Table

To create a new table, perform these steps:

1. Select Table, Insert Table. Word 2000 displays the Insert Table dialog box, as shown fig.

2. Specify the number of the numbers of columns and rows your table will need. You can change these values later if you need to. Estimate on the high end, however, because it is easier to delete additional rows and columns than to add them.

3. Enter a column width, or leave the column Width field set to Auto if you want Word 2000 to guess the table’s width. You can change a table’s column width at any time (even after you enter data). You can request that Word 2000 automatically adjust each column’s width to the widest data in the column by selecting the AutoFit to contents option. The AutoFit to window option adjusts the column widths equally within the table’s size if you resize the window that holds the table.

4. When you are creating your first table, press enter. After you get used to creating tables, you can click AutoFormat buttons to select from a list of predefined table formats, as shown in the Fig.

5. Click OK (or press Enter) to close the dialog box. Word 2000 creates your table and outlines the table’s cells in a grid format.
Traversing the Table

One of the easiest ways to enter data in a table’s cell is to click cell (which moves the text cursor to the cell) and type. As you type past the cells right margin, Word 2000 wraps the cell and increases the row height (if needed) to display the complete cell contents.

When you begin typing data, notice that Word 2000’s automatic formatting might not match the table’s data; perhaps one of the columns is too narrow or too wide. Use your mouse to adjust the size of a row or a column’s width by clicking and dragging one of the table’s four edges in or out. You can also expand or shrink individual columns and rows by dragging their edges.

Although you can click a cell with your mouse every time you want to enter or edit the contents of that cell, the table cursor-movement keystrokes come in handy because you can traverse the table without ever removing your hands from the keyboard.
Inserting New Columns and Rows

Not creating enough rows or columns for your table is one of the first table problems you will encounter. To insert or delete rows or columns, select a row or column and right click your mouse.

Suppose that you need to insert a column. Select the column that will appear after the new column by pointing above the column until the mouse pointer changes to a down arrow. Select multiple columns by dragging your mouse to the right after you have selected one column. Right-click your mouse to mouse to display a pop-up menu. The menu will be different depending on whether you have selected a row or column first. Select Insert Columns, and Word 2000 inserts a new column before the selected columns command.

To highlight a row, point to the margin left of the row; Word 2000 highlights the entire row. Drag your mouse down or up to select multiple rows. When you right-click your mouse, the pop-up menu contains an Insert rows and a Delete Rows command.

7.7 Short Summary

מעניק A Comment is Word 2000 document message that you can see onscreen but that does not print.

♦ Tables are collections of information organized in rows and columns. Tables might contain numbers, text, even graphics, or combinations of any of these.

♦ A cell is a single table entry.

♦ WordArt offers many powerful features for emphasizing your written communications with special sizing, stretching, rotation, font selection, shading, and more.
Lecture 8

Mail Merging Word Document

Objectives

In this Lecture you will learn the following:

• Mail Merge Documents
• Creating Merged Documents
• Creating Master Documents
• Printing Envelops or Labels
## Coverage Plan

### Lecture 8

<table>
<thead>
<tr>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.1 Snap Shot</td>
</tr>
<tr>
<td>8.2 Working with Mail Merge</td>
</tr>
<tr>
<td>8.3 Master Main Document</td>
</tr>
<tr>
<td>8.4 Merging Envelops &amp; Labels</td>
</tr>
<tr>
<td>8.5 Short Summary</td>
</tr>
</tbody>
</table>
8.1 Snap Shot

This lecture introduces you the concept of Mail Merging and how it is powerful for Word, and it also deals with creation of main document.

8.2 Working with Mail Merge

The Tools Mail Merge menu selection is used to merge a list of information, such as names, addresses, and phone numbers (called data or data source) into what is called a main document. The main document contains merge fields into which data is placed. The main document is created using the Mail Merge Helper dialog box. The data document can be a database file, a table with rows (records) and columns (fields), or a comma-delimited ASCII text file, in which each line represents a record and the commas are used to separate (or delimit) one field from another. You can also use the Address Book in Microsoft Outlook as a data resource.

![Envelopes and Labels](image)

**Mail Merge Toolbar**

The Mail Merge toolbar contains the tools necessary to perform mail merge functions. Each tool is explained as follows:

**Insert Merge Field**—select data fields desired in merged heading.
**Insert Word Field**—insert various decision-making prompts for selecting specific merge records.

**View Merged Data**—displays the main document merged with information chosen from the data records.

**First Record**—displays the main document merged with information from the first data record selected for merging.

**Previous Record**—displays the main document merged with information from the selected record.

**Go To Record**—displays the main document merged with information from the selected record.

**Next Record**—displays the main document merged with information from the next data record selected for merging.

**Last Record**—displays the main document merged with information from the last data record selected for merging.

**Mail Merge Helper**—used to produce form letters, mailing labels, envelopes, catalogs, and other types of merged documents.

**Check for Errors**—reports errors in the main document or the data source that may prevent merging.

**Merge to New Document**—runs the mail merge and places the results in a single, new document.

**Merge to Printer**—runs the mail merge and prints the results.

**Start Mail Merge**—opens the Mail Merge dialog.

**Find Record**—searches for specific data records within a selected field.

**Edit Data Source**—opens the Data Form dialog where mail merge data can be viewed and edited one record at a time.
Here’s how the general Mail Merge process works.

1. Open a new blank document.

2. Create your data by either typing it into a table or by importing it from a database, spreadsheet program, or ASCII text file. Look at the following example. Notice how column or field headings are placed in the first row; these are used to identify each data element in the main document.

<table>
<thead>
<tr>
<th>FName</th>
<th>LName</th>
<th>Address</th>
<th>City</th>
<th>State</th>
<th>Zip</th>
<th>Telephone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bala</td>
<td>Murugan</td>
<td>93 Bharathi Nagar</td>
<td>Tirunelveli</td>
<td>TN</td>
<td>NIL</td>
<td>0462-532226</td>
</tr>
<tr>
<td>Nancy</td>
<td>Spivey</td>
<td>523 Bern Lane</td>
<td>Sattler</td>
<td>TX</td>
<td>77545</td>
<td>210-263-7111</td>
</tr>
<tr>
<td>Bernard</td>
<td>Runyan</td>
<td>121 Medical St</td>
<td>Dallas</td>
<td>TX</td>
<td>75205</td>
<td>512-238-9090</td>
</tr>
</tbody>
</table>

Note:
Do not put any leading characters prior to “Title.” That is, make sure there are no spaces or carriage returns, etc.

1. Save the data document (in the example, Mrgdata.doc is used as the filename).

2. Click the New button (or use File / New) to open another new document; then use Tools / Mail Merge to display the Mail Merge Helper dialog.

3. Click the Create button to display a list of Mail Merge choices.
4. Pick Form Letters (or another appropriate choice).

5. Pick the Active Window button to use the displayed blank document.

**Note:**

You may open a new document in another active document by selecting New Main Document.

In this case, Document11 is shown in the illustration in Step 8; Document2 is more likely if you’ve only opened two new documents. In any case, the document number will be the number associated with the number of new documents you have opened in this session of Word, and is really immaterial. (You could also pick an existing form letter document here if one were prepared.)

5a. Use the Get Data button of the Mail Merge Helper dialog to specify the data resource you want to use. Click on Open Data Source….

5b. Select the appropriate data source file in the Open Data Source dialog (Mrgdata.doc in this example), then click the Open button.

5c. Select the proper field delimiter by clicking the Field delimiter down arrow and highlighting the appropriate delimiter (separator). If your data source uses tabs to delimit (separate) the data fields, then highlight Tab, click on OK, and click on Close.

**Note:**

If you previously attempted to perform a mail merge operation with the data source, you will not necessarily see the Header Record Delimiters dialog. It only appears the first time you use the file as a data source and then only if you are not using the default delimiters.
5d. Click on the Edit Main Document button.

6. Now create a main document that resembles the following one, using the Insert Merge Field button to pick and insert the merge field names at the cursor position. Be sure to insert spaces and punctuation as needed.

7. Use File / Save and give the new document a name, such as Mrgmain.doc. Then click the Mail Merge Helper button on the Mail Merge toolbar to check the names of the Main Document and Data Sources filenames. Click the Merge button if the filenames are correct.

8. Use the View Merged Data, Next Record, and Previous Record buttons to see how the data looks when merged.

9. If, after checking for errors, all is well, you are ready to print your document to your printer or to a file. The default name of the merged document is Form Letters1. Closing this document returns you to the main document where the Mail Merge toolbar is displayed. From here you can use the appropriate button on the Mail Merge toolbar to print or examine your data.

Merge documents can be used for a variety of purposes. In addition to form letters, you can also create telephone directories, customer lists, inventory reports, and much more, you can read information into Word from other programs including databases and spreadsheets. You can also read ASCII files into a data document. These file types all serve as data files that are frequently used by a main mail merge document.

**Hands-on Activity**

In this activity you print the TextBox2.doc file. Then you create and print a mail merge document.
1. Start the Word program; click the **Open** button on the toolbar and open the **TextBox2**.

2. Prepare your printer for printing; then click the **Print** button on the toolbar to print the document.

3. Use **File / Close** to close the TextBox2.doc file.

4. Click the **New** button on the Standard toolbar to open a blank Document2.

5. Type the following data fields in a 6 x 6 table. Then save it as **Clubdat.doc**. (Or use Insert / File and pick Clubdat.doc from the \MSOffice\Files folder to save time.)

6. Click the **New** button again to open a second document. Now use **Tools / Mail Merge** to display the Mail Merge Helper dialog.

7. Click the **Create** button, pick **Form Letters**, and then click the **Active Window** button to choose the open document as the main document.

<table>
<thead>
<tr>
<th>Mrms</th>
<th>Fname</th>
<th>Lname</th>
<th>Address</th>
<th>CSZ</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mr.</td>
<td>John</td>
<td>Simmons</td>
<td>123 Jogging Dr.</td>
<td>Austin, TX 78058</td>
<td>(512) 345-0987</td>
</tr>
<tr>
<td>Ms.</td>
<td>Linda</td>
<td>Garcia</td>
<td>1412 Elk Road</td>
<td>Denver, CO 58675</td>
<td>(303) 569-0987</td>
</tr>
<tr>
<td>Mr.</td>
<td>Tom</td>
<td>Johnson</td>
<td>36 Polynesia</td>
<td>Naples, FL 39037</td>
<td>(813) 468-0980</td>
</tr>
<tr>
<td>Ms.</td>
<td>Denise</td>
<td>McEvoy</td>
<td>44 5th Avenue</td>
<td>New York, NY 01220</td>
<td>(212) 444-5555</td>
</tr>
<tr>
<td>Mr.</td>
<td>Hernando</td>
<td>Mendez</td>
<td>12 Boeing Dr.</td>
<td>El Paso, TX 76905</td>
<td>(915) 514-5432</td>
</tr>
</tbody>
</table>

8. Click **Get Data**, select **Open Data Source**, select **Clubdat**, and click **Open**. Then click the **Edit Main Document** button.

9. Type the following text. (Do not type bracketed items.) Position your cursor and then use the **Insert Merge Field** button to display and insert the indicated mail merge field names into your main document.

```
March 19, 2000
<<Mr ms>> <<Fname>> <<Lname>>
<<Address>>
<<CSZ>>
Dear <<Fname>>,
This letter is to inform you
```
10. Click the **Mail Merge Helper** button to verify the filenames.

11. Try several of the buttons on the Mail Merge toolbar including the View Merged Data, Next Record, Previous Record, Check for Errors, Edit Data, Mail Merge, Find Record, and Edit Data Source buttons to determine their effect.

12. If you wish, use the **Merge to Printer** or **Merge to New Document** buttons to see the finished results.

13. Click the **Save** button to save the Main Document as **Clubmain.doc**.

14. Press **0<Alt+F4>** to exit Word. You may wish to save the documents for later referral.

### 8.3 Master Document

Word’s master document feature, which is accessed using View / Outline, is used to combine two or more documents into a larger, fully paginated document. An ideal use for the master document feature is to integrate and control the pagination (page numbers, headers, footers, etc.) of several documents containing chapters of a book into a single, multi chapter book. Master documents put the pages of each subdocument (such as a chapter) in the proper sequential order, i.e., 1 to n. You can also use Insert / Index and Tables to prepare a complete table of contents, table of figures, table of authorities, and an alphabetical index.

Changes to subdocuments within a book often move headings and words contained in your alphabetical index to different pages. The new page numbers associated with moved elements are automatically adjusted. Just delete the old table or index and rerun the table of contents and re-index to capture the changes. This eliminates the need to edit your book’s front matter (list of tables) and indexes every time you make a change. If you create large, multi chapter documents, becoming proficient with Word’s master document feature will save you a lot of time.

Each new subdocument within a master document is put in a separate section. You can use the Layout tab of the Page Setup dialog to control the way your sections behave. For example, you may want each section to begin on an odd-
numbered, right-hand page; have a running header on every left-hand page of the book and unique chapter headers on the right-hand pages; and use small Roman numerals in the front matter (title page, copyright page, and contents pages) and regular Arabic numerals in the balance of the book. It is easy to obtain these effects when you use the Master Document and Section features available in Word.

The outlining and Master Document Toolbars

When you display a document in the Outline view, the Outlining and Master Document toolbars appear.

Use the Outlining toolbar to apply different heading levels or body text to selected headings, paragraphs, and lists. The Outlining toolbar begins with the Promote button and includes all the buttons to the right until the Master Document View button. The Master Document toolbar begins with the Master Document View button and includes all the toolbar buttons to the right. Use the Master Document toolbar to manage subdocuments that comprise the master document under construction.

You can display the button names in the usual manner. Just put your mouse pointer on a button to display a descriptive label. Look at the status bar at the bottom of your screen to see additional information about the button. Following is a description of each of the buttons on the Outlining and Master Document toolbars. These toolbars are displayed when you choose View / Master Document.

Outlining Toolbar

This toolbar promotes, demotes, and applies different heading styles to one or more selected list elements or paragraphs.

Promote — Increase the selected paragraph to the next higher heading level, i.e., promote a “Heading 3” to a “Heading 2.”
**Demote**—Decrease the selected paragraph to the next lower heading level, i.e., demote a “Heading 1” to a “Heading 2.”

**Demote to Body Text**—Change the selected heading to Normal (or body text).

**Move Up**—Move the selected heading or paragraphs ahead of the preceding heading or paragraph.

**Move Down**—Move the selected heading or paragraphs below the following heading or paragraph.

**Expand**—Display the next lower level headings and/or paragraphs by selecting a heading and clicking the Expand button.

**Collapse**—Hide the next lower level headings and/or paragraphs by selecting a heading and clicking the Collapse button.

**Show Heading 1 through 7**—Click the 1 through 7 button to display those headings at and higher than the selected level. For example, if you wish to display headings 1, 2, and 3, click 3.

**All**—Display all heading levels.

**Show First Line Only**—Show only the first line of text of each paragraph.

**Show Formatting**—Show or alternately hide heading formats; when hidden, headings are shown as normal text.

**Master Document Toolbar**

**Master Document View**—Display or hide the Master Document toolbar buttons.

**Collapse or Expand Subdocuments**—Collapse or expand the display of subdocuments within the master document.

**Create Subdocument**—Insert a new subdocument within the current master document.
Remove Subdocument—Remove the selected subdocument from the master document.

Insert Subdocument—Open a document and insert it as a subdocument.

Merge Subdocument—Merge two or more adjacent subdocuments as a single subdocument.

Split Subdocument—Divide a subdocument into two subdocument sections.

Lock Document—Lock the selected subdocument to prevent changes. Also, use this button to unlock the document when changes are required.

Using Master Document

Following is a step-by-step approach for creating a book (or similar multi-chapter document) that is created by using several smaller documents. The procedure also guides you through creating a table of contents and index.

Note:
The following procedure makes use of existing documents. These are inserted into the master document as subdocuments. You can also create and edit new and revised documents directly into a master document. Hence, there are many ways to create and save master documents. You may wish to experiment with the Master Document toolbar until you find the method you like best.

Document Creation

1. Create and save each section or chapter of a book as an individual document. End each document with a carriage return. Be sure to assign a descriptive name, such as Chap01.doc, Chap02.doc, etc. Using sequential names sorts them within the active file folder, making each subdocument file easy to find.

2. Open a new document after all individual chapter documents have been created and saved.

3. Click View / Outline to display the Outlining and Master Document toolbars.
4. Click the Insert Subdocument button, pick the first document in sequence, and click OK.

5. Press <Ctrl+End> to go to the end of the first document. Backspace so that you delete the section break at the bottom of the inserted document.

6. With the cursor on a new line (at the end of the first section), click Insert Subdocument again.

7. Pick the second document to be inserted and click OK. The first two subdocuments are inserted.

8. Again, delete the last section break and put the cursor on a new line at the bottom of the last section. Then insert the third subdocument as above.

9. Continue inserting your subdocuments in the proper order until all are included within your master document.

**Starting Each Section on a New Page**

Now set the Layout tab of the Page Setup dialog as shown so that each section starts on a new page.

**Tip:**

In this procedure you start each new subdocument on a new page. However, if you want to start each subdocument (or “chapter”) on a right-hand page, as is the practice with many printed books, select Odd Page instead of New Page. Right-hand pages are always odd-numbered. Conversely, even-numbered pages are always on the left-hand side when the book is lying open. Check Different Odd and Even if you want to alternate the copy and/or placement of headers and footers. Check Different First Page if you want to omit a header and/or footer on the opening page of each subdocument (or chapter).

1. Move to each subsection and set the Layout tab of the File / Page Setup dialog as shown in the following illustration.

2. Be sure that every subdocument (or chapter) has been set up so that each of your sections starts on a new page. Also check the Different Odd and Even
and Different First Page check boxes. If you think you missed a section, it’s easy to check. Simply put the cursor in the subdocument and display the Page Setup dialog to display your settings. Change as necessary.

3. Click the Print Preview button on the Standard toolbar to ensure that every subdocument starts on a new page.

Adding Headers and Footers

In the preceding section you provided for different odd and even pages and first pages using the check boxes. With these settings in place, you can add alternating headers and footers.

1. Use the View / Header and Footer menu selection to enter header and footer text.

2. Use Align left for even-numbered headers and footers and Align Right for odd-numbered headers and footers.

3. Go to the first page of the first subdocument that uses Arabic page numbers. Then move to the footer (using View / Header and Footer).

4. Click the Page Numbers button on the Header and Footer toolbar to insert a page number.
5. Use the Insert / Page Number menu selection to set the first number to 1. Set the Alignment to outside. Click the Format button and select the number style and starting value. Click OK twice to close both dialogs.

6. Set the page number font, point size, and weight (bold, italic, etc.) to your preferences.

7. Close the Header and Footer toolbar. Then use Page Preview to examine each page number and its placement. Make adjustments as necessary.

**Tip:**

You can use the Page Setup button on the Header and Footer toolbar to make any necessary page layout adjustments. Pay particular attention to the Same As Previous button to ensure that unwanted header or footer information is not carried over from the previous section.

8. Once the headers and footers are properly adjusted and examined, you are ready to create a table of contents.

**Creating a Table of Contents or Figures**

If your section headings and titles use the styles on the Formatting toolbar, then creating an automatic table of contents is easy.

Once styles are applied to all headings (such as Heading 1, Heading 2, etc.), place the cursor at the position where the table of contents should begin. Then use the Insert / Index and Tables menu selection to display the Index and Tables dialog. Click on the Table of Contents tab, and select the format you like (check it in the Preview box). Use the Options and Modify buttons if you wish to change the order, add more heading levels, or insert a custom heading style. Click OK once all is set up to your liking.

To create a table of figures, use the Table of Figures tab is used in the Index and Tables dialog.
Creating an Alphabetical Index

It is an easy matter to mark various text entries for inclusion in an alphabetical index. Indexes are normally found at the end of a multi chapter document.

First, find and highlight (drag) the word or phrase you want to include. Then use the Insert / Index and Tables menu selection to display the Index and Tables dialog. Click the Index tab. Then click the Mark Entry button. The selected word or phrase is displayed as the Main Entry on the Mark Index Entry dialog as shown here.

Click Mark on the Mark Entry Index dialog (or Mark All to find every occurrence of a word or phrase). Then click Close and move to the next word to be indexed.

**Tip:**

You can type alternate forms of the word or phrase to help your readers locate information. You can also use subentries that are printed below a main word, such as:

Potato
  - Baked
  - Boiled
  - Fried

Place the cursor at the index insertion point within your document, then use the Index tab of the Index and Tables dialog to pick the format you want to use. Click OK; the index is compiled and inserted in the specified format.

**Hands-on Activities**

**Inserting Subdocuments**

1. Use the View / Outline Document menu selection to display the Outlining and Master Document toolbars.

2. Click the Insert Subdocument button on the Master document toolbar, select the Basics00.doc companion file, and click Open.
3. Press `<Ctrl+End>` to move to the end of the document.

4. Put the cursor on a blank line at the extreme bottom of the document. Be sure that there is a carriage return on the line above the cursor. Then click **Insert Subdocument**, select Basics01.doc, and click **Open**.

5. Repeat steps 3 and 4 and insert the remaining files Basics02.doc through Basics06.doc. Respond by clicking **No to All** when the Title 1 Style already exists dialog is displayed.

**Starting Each Section (or Subdocument) on an Odd-Numbered, Right-Hand Page**

6. Go to each subdocument and set the **Layout** tab of the **Page Setup** dialog as shown here:

**Inserting Headers and Footers; Putting Page Numbers in the Footers**

7. Go to the beginning of the first subdocument. Use the **View / Print Layout** menu selection.

   a. Use the **View / Header and Footer** menu selection to display the Header and Footer toolbar.

   b. Click the **Switch Between Header and Footer** button to move to the footer of the title page (first page of the first subdocument).

   c. Click the **Insert Page Numbers** button on the Header and Footer toolbar.

   d. Click **Format Page Number** and set the page number value to small Roman letter `i`. (This is the convention normally used for the front matter of a book.) Click **Start at** and verify that it is `i`.

   e. Click **OK**. Then click **Close** to close the Header and Footer toolbar.

   f. Use **Insert / Page Numbers** and set the Alignment to **Outside**. Make sure **Show number on first page** is not checked.
8. Go to the beginning of the second subdocument (named “Section 1”). Repeat 7a through 7f above, setting the Page Numbers dialog as shown in the two illustrations shown here. (This starts the first section with page number 1 on an odd-numbered, right-hand page.)

![Page Numbers dialog](image)

9. Go to the beginning of each of the remaining subdocuments. Repeat 7a through 7f above, setting the Page Number Format dialog as shown in the illustration at right. (Note that these continue the page numbering scheme from the previous sections. Also, each new section starts with an odd number.)

**Tip:**

When even-numbered pages are blank (called a blank back), they are skipped. For example, if page 7 has a blank back, blank page 8 is skipped. Page 9 starts the next section on an odd-numbered, right-hand page.

![Page Number Format dialog](image)
Construct a Table of Contents

10. Go to the second page. Move the cursor to the blank line following the word “Contents.”

11. Use the Insert / Index and Tables menu selection and click the Table of Contents tab.

12. Click the Options button. Set the TOC Level numbers opposite the Available Styles as listed below. Scroll down to the Heading 1 heading and put 1 in the TOC Level box. Be sure that all unused headings are blank except for those shown in the following list.

<table>
<thead>
<tr>
<th>Available Styles</th>
<th>TOC Level</th>
<th>Available Styles</th>
<th>TOC Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title 1</td>
<td>1</td>
<td>Heading1</td>
<td>2</td>
</tr>
<tr>
<td>Heading2</td>
<td>3</td>
<td>Heading3</td>
<td>4</td>
</tr>
</tbody>
</table>

13. Click OK. Your dialog should resemble this one:

14. Click OK again to compile the table of contents. When completed, you have a full table of contents with heading names, dot leaders, and page numbers.

Tip:
If you make changes and want to recompile the table of contents, click on the table of contents with your mouse to select it. Delete it (with Del). Then repeat steps 11 through 14 as necessary to recompile the table of contents to the current document configuration.

Construct an Alphabetical Index:

15. Select ten or twelve headings, words, and phrases for inclusion in an alphabetical index as follows:

   a. Drag the first selection so that it is highlighted (such as “Seeing what’s on your computer”).
b. Using the Insert / Index and Tables menu selection, click the Index tab and click Mark Entry. Your dialog should resemble the following one:

![Index and Tables dialog](image)

C. Click Mark to identify the entry for your index.

d. Close the dialog and continue selecting and marking entries until you have selected ten or twelve. Notice that “XE” field codes are inserted following each selection.

**Tip:**
You can also position your cursor, use the Insert / Field menu selection, and use the dialog as shown here to manually enter your index entries.

16. Place the cursor on the line following the word “Index” in the last subdocument.

17. Use the Insert / Index and Tables menu selection and click the Index tab.

18. Select the Classic format as shown in the following illustration and click OK to compile the index.

19. Notice that the index is inserted at the cursor position.

**Examine the Paginated Document Using Print Preview or By Printing It**

20. Press <Ctrl+Home> to go to the top of the document.

21. Click the Page Preview button on the Standard toolbar.
22. Display two to four pages at a time using the **Multiple Pages** button.

23. Page through the document checking the layout and page numbering. If you wish, you can click the **Print** button to see the actual output.

**Finishing Up**

This completes the master document activity. As you can see, master documents are ideal for creating large, multi chapter documents. Now you can exit Word without saving or, if you prefer, save the document for additional experimentation. When saved, sections are automatically locked to protect the integrity of the document. Use the Lock Document button on the Master Document toolbar to unlock each subdocument when changes are required. If you have time for another practice activity, try adding alternating right- and left-hand headers. Here, add the book title to left-hand page headers and the section number to the right-hand page headers. Put the headers at the outside of each page. You should also omit headers from the first page of each section, which is a common publishing practice. You may also want to see how easy it is to promote and demote heading styles using the Outlining toolbar. Just put the cursor on a paragraph heading and click the buttons to see how they work.

### 8.4 Merging Envelopes & Labels

There is nothing quite as pathetic as receiving a perfectly printed letter, with gorgeous fonts and graphics, in an envelope where the sender scrawled the address by hand. Unless of course, it’s the pitiful sight of watching someone run an envelope through a typewriter when a laser printer is right alongside. After you learn how easy it is to create envelopes and labels with Word, you will never need that typewriter again.

**Printing a single Envelope**

You can create a single envelope from information on a letter or in its own document.

**Creating a single Envelope**

1. Open the letter for which you want to create an envelope and select the recipient’s address.
2. Choose the Tools menu, select Envelops and Labels, and click the Envelops tab. The selected text appears in the Delivery address box.

3. If necessary, type your address in the Return address box.

4. The default format is a standard U.S # 10 envelope. To select a different format, click the Options button.

5. Choose the Add to Document to insert the envelope at the top of the active document. Click Print to send the envelope directly to the printer.

**Printing Labels**

Word users can take advantage of three main label-printing options. You can print a single label, a sheet of the same label, or labels that corresponds to a mail merge data source.

**Printing a Single Label or Sheet of Labels**

1. From any document, choose the Tools menu, select Envelops and Labels, and click the Labels Tab. The Envelops and Labels dialog box appears.

2. In the Address box, enter the information you want to appear on the label.

3. In the Print box, select Single label, and then enter the row and column number for the label on which you want to print. This technique allows you to use a sheet of preprinted labels repeatedly without wasting any.

4. Click the Options button and specify the manufacturer and product number for the style of labels you are using; then click OK>

5. To send the label directly to the printer, click the Print button. To create a new Word document with the correct formatting for your label, click the new document button.
8.5 Short Summary

♣ The Tools / Mail Merge menu selection is used to merge a list of information, such as names, addresses, and phone numbers (called data or data source) into what is called a main document.

♣ Word’s master document feature, which is accessed using View / Outline, is used to combine two or more documents into a larger, fully paginated document.
Lecture 9

Microsoft Excel

Objectives

In this Lecture you will learn the following:

- Features of Excel 2000
- Working with Excel
- Auto fill
- Editing Contents in Excel Sheet
## Coverage Plan

### Lecture 9

<table>
<thead>
<tr>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.1</td>
</tr>
<tr>
<td>9.2</td>
</tr>
<tr>
<td>9.3</td>
</tr>
<tr>
<td>9.4</td>
</tr>
<tr>
<td>9.5</td>
</tr>
<tr>
<td>9.6</td>
</tr>
</tbody>
</table>
9.1 Snap Shot

In this activities you will understand the Features of Excel 2000, how to enter data in to it, and how to use Auto Fill utilities, and how to edit work sheet

Features of Excel 2000

Excel 2000 has been called a Word Processor for Numbers. With Excel 2000, you can create numerically based proposals, business plans, business forms, accounting worksheets, and virtually any other document that contains calculated numbers.

If you are new to electronic worksheets, you will probably have to take more time to learn Excel 2000’s environment than you had to learn Word 2000 Excel 2000 starts with a grid of cells in which you place information.

Fig represents the Excel Windows

9.2 Understanding Workbooks and Worksheets

Excel 2000 enables you to create and edit workbooks. A workbook holds one or more worksheets (sometimes called spreadsheets or just sheets). A worksheet is a collection of rows and columns that holds text and numbers. Anytime you create, open or save an Excel 2000 file, you are working with a workbook. The
workbook approach keeps you from having multiple files that relate to the same project instead, you can have all worksheets related to the same project in the same workbook (in one *.xls file). Your workbook name is the Excel 2000 name you assign when you save Excel 2000 worksheets and workbooks in HTML format if you want to maintain file type consistency and if you ever want to embed your data in a Web page.

**Note:**

A Workbook is a collection of Worksheets stored in a single file. A workbook is useful for grouping a single project’s worksheets together.

A Worksheet is an Excel 2000 table-like document containing rows and columns that holds data and formulas.

**Types of Worksheets**

Blank Excel 2000 workbooks contain three worksheets name sheet1, sheet2, and sheet3, as shown in Fig. When you click a sheet’s tab, Excel 2000 brings that sheet into view. If a workbook contains several worksheets, you might have to click one of the sheet-scrolling buttons to view additional worksheet tabs. Each column has a heading; heading names start with A, B and so on. Each row has a heading, starting with 1, 2 and so on. The intersection of a row and column, called a cell, also has a name that comes from combining the row name and column number, such as C4 or A1. A1 is cells, but you can turn off gridlines at any time from the Tools, Options, View page option labeled Gridlines. When you save a worksheet, you actually save it in an Excel workbook, which can hold multiple worksheets. By default, each new Excel workbook starts out with three blank worksheets; you can add new worksheets, delete an existing one, and rename or rearrange worksheets to suit your needs.

**Note:**

A cell is the intersection of a row and column into which you enter text or numbers. A cell address is the column letter and row number location of the cell; B6 is the cell address for a cell located at column B and row 6.

**9.3 Entering Worksheet data**

Often, entering worksheet data requires nothing more than moving cell pointer to the correct cell and typing the data. The various kinds of data behave differently when entered, however, so you should understand how Excel 2000 accepts assorted data.
Excel 2000 can work with the following kinds of data:

- Labels: Text values such as names and addresses.
- Numbers: Numeric values such as 34, -291, 545.67874, and 0
- Formulas. Expressions that compute numeric results (some formulas work with text values as well)
- Special formats: Date and time values

**Entering Text**

If you want to put text (such as a title or a name) in a cell, just place your cursor in the cell and type the text. Excel 2000 left-justifies the text in the cell. As you type, the text appears both in the cell and in the Formula bar. Remember that the Name box to the left of the Formula bar displays the name of the cell into which you are entering data. When you press Enter, Excel 2000 moves the cell pointer down one row.

If you press Esc at any point during your text entry, Excel 2000 erases the text you typed in the cell and restores the original cell contains.

If your text is wider than the cell, Excel 2000 does one of the two things depending on the contents of the adjacent cell to the right:

- If the adjacent cell is empty, Excel 2000 erases the text you typed in the cell and restores the original cell contains

- If the adjacent cell contains data, Excel 2000 truncates (cuts off) the wide cell to show only as much text as fits in the cell’s width. Excel 2000 does not remove the unseen data from the cell: however, the adjacent cell, if that cell contains data, always displays instead.

**Note:**

*A label is text data inside an Excel 2000 cell*
**Entering Numbers**

Excel 2000 accepts numeric values of all kinds. You can type positive numbers, negative numbers, numbers with decimal points, zero-leading numbers, numbers with dollar signs, percent signs, and even scientific notation (a shortcut for writing extremely large and small numbers) Excel 2000 right-justifies numbers inside cells. You can change the format for a single cell or for the entire worksheet.

**Entering Dates and Times**

Excel 2000 supports almost every national and international date and time format. Excel 2000 uses its AutoFormat feature to convert any date or time value that you type to a special internal number that represents the number of days since midnight, January 1, 1900. As with all Office 2000 products, Excel 2000 is Y2K –compliant meaning that Excel 2000 automatically displays all dates the user enters with four-digit year values by showing the full year. Excel 2000 should have little problem with the millennium change. Although this strange internal representation might not make sense now, you use these values a lot to compute time between two or more dates.

**Using Formulas**

Without formulas, Excel 2000 would be little more than a word processor for tables of information. When you use formulas, however, Excel 2000 becomes an extremely powerful time saving planning, budgeting, and general-purpose financial tool.

A Formula is a calculation that produces a result. Formulas can include math operators, numbers, cell addresses, and range names.

**9.4 Auto fill**

Nothing is more tedious than entering a long sequence of numbers or dates in a column. So let Excel handle the drudge work. As the name implies, its AutoFill feature can automatically fill in information as you drag the mouse through a range. You can use AutoFill to enter the days of the week, months of the year, any series of numbers or dates, and even custom lists that you create.

Before you can use AutoFill, however, you need to learn to reorganize Excel’s fill handle. Select any cell or range, and you will see a thick border around the selection.
Look in the lower-right corner of the selection for a small black square. That’s the fill handle. When you point at the fill handle, the mouse pointer turns to a thin black cross. Drag in any direction to begin filling in values.

**Incrementing a series of Numbers or Dates**

What kind of list can you create using AutoFill? The answer depends on what you enter in the first cell. A table shows what you can expect when you use AutoFill.

**Using AutoFill to Create a List**

<table>
<thead>
<tr>
<th>Start with this value</th>
<th>To Fill in this List</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>April</td>
<td>Months</td>
<td>April, May, June,...</td>
</tr>
<tr>
<td>Jan</td>
<td>Abbreviated months</td>
<td>Jan, Feb, Mar,...</td>
</tr>
<tr>
<td>Thursday</td>
<td>Days of the week</td>
<td>Thursday, Friday,...</td>
</tr>
<tr>
<td>30-May</td>
<td>Date series</td>
<td>30-May, 1-May, 1-Jun,...</td>
</tr>
<tr>
<td>Q3</td>
<td>Calendar quarters</td>
<td>Q3, Q4, Q1,...</td>
</tr>
<tr>
<td>Chapter 1</td>
<td>Any text plus a number</td>
<td>Chapter 1, chapter 2,...</td>
</tr>
</tbody>
</table>

**Customizing AutoFill**

When you click the fill handle and drag, the selection gets bigger and includes more cells. When you release the mouse button, Excel fills every cell in the selection with values.

- Click in the cell above the first column and enter the first item in the list, Jan.

- Click in the cell that contains Jan to make active, and then point to its fill handle. When the mouse pointer turns to a black cross, hold down the left mouse button and drag the selection to the right across the row.

- As you drag, watch for Screen Tips, which display the values AutoFill will enter in the selection.

- When the selection includes 12 cells, release the left mouse button.
If you enter a single number in the first cell and then drag the fill handle, Excel simply repeats the value in every cell you select. AutoFill behaves the same way if you enter text, like ABC. To force AutoFill to enter a simple series of numbers, hold down the Ctrl key as you drag—you will see a plus sign next to the fill handle to signal that you have changed to a new autofill mode. Your list starts with the original number and increases by one throughout the selection.

What do you do when you want to count by twos, tens, or millions? If you select two or more cells at the beginning of a list that uses a special increment (like 2,4,6 or 10,20,30) and then drag fill handle, Excel uses that increment to AutoFill the selected area. You can also enter a date series such as every other day or every fourth month. So if you want to count by 10s, enter the numbers 10 and 20 in adjacent cells, and then select both cells and drag the fill handle to extend the selection; AutoFill adds 30,40,50, and so on. If you enter Jan and Mar in adjacent cells, then select both cells and drag the AutoFill handle, Excel adds Jul and Oct and starts over with Jan.

9.5 Editing Worksheet Data

Changing or Erasing Value and Text

Because of the nature of worksheets, erasing worksheet data differs from erasing word processing data. Other information on the worksheet can heavily depend on the erased data, as you see in the next hour’s lesson. When you want to erase a cell or selection content, first decide which of the following kinds of erasure you want to perform.

- Erase the selection and send the contents to the Clipboard
- Clear only a portion of the selection, such as its formatting, comment, or data value.
- Completely erase the selection and all formatting and notes attached to the selection.
- Erase the selected cells and their position so that other cells in the row move left or cells below move up.

If you want to delete the selected cell’s data, press Delete, Excel 2000 retains any formatting and comments that you had applied before you deleted the data.
If you want to more selectively erase a cell, select the Edit, Clear command and select from one of the five options listed here.

- The All option delete the entire selection, including the contents, format, and attached comments

- The Formats option erases only the selection’s format; you can get rid of a cell’s special formatting and revert to a general format without changing or erasing the contents of the cell.

- The Contents option deletes the cell contents but leaves the formatting and comments intact.

- The Comments option deletes any special comments that appear in the selected cells.

- The Hyperlinks option removes any Internet-based references within the cell.

### 9.6 Short Summary

- Excel 2000 has been called a Word Processor for Numbers

- A Workbook is a collection of Worksheets stored in a single file

- A Worksheet is an Excel 2000 table-like document containing rows and columns that holds data and formulas.

- You can use AutoFill to enter the days of the week, months of the year, any series of numbers or dates, and even custom lists that you create.
Lecture 10

Microsoft Excel

Objectives

In this Lecture you will learn the following:

- Working With Worksheets
- Working With Ranges
- Types Of Ranges
- Working With Function
**Coverage Plan**

**Lecture 10**

10.1 Snap Shot
10.2 Working With Work Sheets
10.3 Working With Ranges
10.4 Types Of References
10.5 Working With Formulas
10.6 Short Summary
10.1 Snap Shot

In this Lecture you will learn about working with work sheets, Ranges and Formulas.

10.2 Working with Worksheets

The basic building block of Excel is the worksheet – a two dimensional grid whose rows and columns define individual cells. Within each cell you can enter numbers, text, date and time information, or references to other cells. Most importantly, cells can contain mathematical and logical formulas that calculate and display results based on data you enter. Formulas in a worksheet can draw from Excel’s enormous library of built-in function to perform everything from elementary arithmetic to sophisticated number-crunching, including statistical and financial analysis. To visually explain the relationship between numbers, you can also display data in an Excel worksheet as a chart.

A well-designed worksheet can be as simple as a list of names or checkbook transactions, or as complex as the financial model for a major multinational corporation. In either case, you begin with a blank sheet.

When you start Excel by using its shortcut on the Start menu, the program automatically opens a new, blank Excel workbook with the temporary name Book 1. To create another new workbook, click the New button, or use the keyboard shortcut Ctrl + N. Each new workbook gets a similar generic name Book2, Book3, and so on.

When you save a worksheet, you actually save it in an Excel workbook, which can hold multiple worksheets. By default, each new Excel workbook starts out with three blank worksheets; you can add new worksheets, delete an existing one, and rename or rearrange worksheets to suit your needs.

An index tab at the bottom of each worksheet identifies the sheet by name. When you open a new workbook, each sheet has a generic name: Sheet1, Sheet2, Sheet3, and so on.
10.3 Working with Ranges

A range is any combination of cells that you select, generally so that you can enter data or include the cells in a command or formula. In a broader sense, whenever you move about in the workbook, you are selecting a range, because the cell or range on which you stop is the selected, or active, cell. In Excel, you can work with two types of ranges:

**Single Sheet or 2-D**

A group of adjacent cells that are contiguous (within a rectangle) in a single worksheet, such as B5:D25. This is the type of range you work with most frequently.

**Multi Sheet or 3-D**

A range that spans multiple sheets, usually contiguous, in the workbook so that the same 2-D range is referenced on each sheet. For example, you could define a range on Sheet1 to Sheet4, which includes the cells in A5:F15 on each sheet. You refer to that range as Sheet1:Sheet4!A5:F15. You can also work with a non-contiguous range, which consists of multiple ranges.

**Selecting a Single-Sheet Range**

Watch the Name box when selecting a range of cells; it displays the number of rows and columns a small window near the mouse pointer displays the number of rows or columns you are selecting. You will also find that the row and column headings for a selected range take on the appearance of pressed buttons, which helps to define the extent of the range.

You can select a single-sheet (2D) range in several ways.

- Click a corner cell of the range and then Shift+Click the diagonally opposite corner.
- Click and drag over the range from corner to corner with your mouse
- Choose Edit then press Go To (Press F5 or Ctrl+G), and enter the range you want to select in the Go To dialog box.
Select one corner of the range, hold down Shift, and then use the arrow keys to select the rest of the range.

Click once within a column or a row heading to select an entire row column.

Click and drag over the headings or use Shift+Click to select a range of rows or columns.

To select data in a single column or row, select one cell at the top or bottom of the data. Then hold down Shift and double-click one side of the active cell to select all contiguous cells in that direction. With the keyboard, press Ctrl+Shift and an arrow key to select the contiguous cells in that direction.

**Selecting a Multi-Sheet Range**

On occasion you might want to select a range that includes more than one sheet, for example, to include in a report. To select a multi sheet (3D) range on contiguous sheets, first select the 2-D range on the first worksheet of the range, such as A5:F15. Then hold down Shift and click the Sheet tab for the last sheet of the range, such as Sheet3.

**References make Formula**

The true power of Excel 2000 shows when you use cell addresses and range names in formulas. All the following are valid formulas. Cell addresses or range names appear throughout the formulas.

\[ \frac{(Sales \ Totals)}{Num \ Of \ Sales} \]
\[ C4 * 2 - (Rate \ * .08) \]
\[ 7 + LE51 - (Gross - Net) \]

When you enter formulas that contain range addresses, you can either type the full address or point to the cell address. If you want to include a complete named range in a formula, select the entire range and Excel 2000 inserts the range name in your formula. Often, finding and pointing to a value is easier than locating the address and entering the exact address.

If, for example, you are entering a formula for cells that are close to formula’s cell, when you get to the place in the formula that requires a close cell, don’t type the cell address; instead, point to the cell. If you have entered a formula such as \(7 + \), instead of typing a cell address of LE51, Excel addresses for you. Immediately after typing the cell address for you. Immediately after typing the
cell address for you, Excel 2000 enters the cell’s address for you. Immediately after typing the cell address for you, Excel 2000 returns your cursor to the formula so that you can complete it.

After you assign a name to a cell, you don’t have to remember that cell’s address when you use that cell in formulas. Suppose that you are creating a large worksheet that spans many screens. If you assign names to cells when you create them, cells that you know that name is made easier. Instead of locating that cell to find its address, you need only to type the name when entering a formula that uses that cell.

### 10.4 Types of References

**Relative Versus Absolute References**

The first time you move or copy a formula, you might be surprised to see that Excel automatically changes some cell references in your formula. Is this a bug? Not at all; it’s an example of how Excel formulas help you build powerful worksheets without a lot of typing.

By default, cell and range references within a formula use relative addresses. Although Excel stores the exact location of the cells to which the formula refers, it also takes careful note of where those cells are located in relation to the cell that contains the formula. When you copy or move that formula, Excel automatically adjusts cell references to reflect their position relative to the new location.

Let’s say you have a column of numbers in cells B1 through B20 and you’ve created a formula in B21 that totals cells.=SUM (B1:B20). If you copy that formula to cell C21, Excel assumes you want to total the numbers in column C, so it adjusts the formula accordingly, to =SUM (C1:C20). If you move a formula three rows down and five columns to the right, Excel adds three to each row number and counts five letters higher in the alphabet for each cell or range address in the new formula. Thus, a reference to D5 changes to 18.

What happens when you store a scrap of crucial information, like the current interest rate, in one particular cell? You want all formulas on your worksheet to use the value entered in that cell whenever they make an interest related calculation. If you use relative references, every time you move or copy a
formula that refers to this cell, the reference points to the wrong address. The solution? Use an absolute address to tell Excel not to adjust the reference when you move or copy a formula.

To specify an absolute address, use dollar signs within the cell address. When you type $A$4 as part of a formula, for example, Excel looks for the value in cell A4 even if you move the original formula or copy it to another location.

You can mix and match relative and absolute addresses in a formula, or even in the same address. For example, $A4$ tells Excel to leave the column address at A when you move or copy the formula, but adjust the row address relative to the new location.

10.5 Working with Formulas

Using Functions

Designing the basic row-and-column structure of your worksheet and entering data are only the first steps. To really take advantage of Excel’s number-crunching capability, you can create formulas that help you analyze and summarize all that data. Excel formulas let you perform simple arithmetic, compel calculations, and logical tests. Better, yet they allow you to update the underlying numbers or create alternative scenarios, instantaneously recalculating the results without tedious retyping.

When you enter text or numbers in a cell, Excel assumes you’re entering a value (sometimes referred to as a constant). The program displays values exactly as you type them adjusting the display only if the cell includes any formatting settings. When the first character you type is an equal sign, however, Excel knows you’re entering a formula. Excel stores the formula in the cell, but it displays the result of the formula. When you type =950-21, you’re telling Excel, “Subtract 21 from 950 and show the result in the cell.” If you select the cell, you see the formula itself displayed in the formula bar, where you can click to edit.
Fig This Excel is used Formulas.

When you see a cell that begins with the number sign (#), that’s Excel’s way of telling you that it cannot calculate a result for your formula. You may see any of seven possible error codes. To remove the error message and display the results you expects, you have to fix the problem.

Either by editing the formula or changing the contents of a cell to which the formula refers.

Using Functions to Create More Powerful Formulas

Asking Excel to do only simple addition or multiplication is like hiring a Harvard MBA to balance your checkbook. Yes, you can and will use simple Excel formulas to add columns of numbers, but its biggest asset is its repertoire of mathematical, financial, statistical, and logical functions. Excel 2000 can crunch numbers using more than 200 functions, from simple averages to complex trigonometric formulas.

What You Can Do with Functions

You can find hundreds of predefined functions in Excel, including esoteric ones designed for financial analysts and statisticians. The following table includes a sampling of the most commonly used functions to see the complete list, use the Formula Palette, described later in this chapter.
## Commonly Used Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>What it Does</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sum (number1, Number 2....)</strong></td>
<td>Calculates the total of all the values in parentheses</td>
<td>SUM (C4:C24) Displays the total of all the numbers in cells C4 through C24, ignoring blank cells.</td>
</tr>
<tr>
<td><strong>(number 1, number 2...)</strong></td>
<td>Calculates the average of a group of values.</td>
<td>AVERAGE (C4:C24) Displays the average of all the numbers in cells C4 through C24, ignoring blank cells.</td>
</tr>
<tr>
<td><strong>COUNT (value 1, Value 2...)</strong></td>
<td>Counts the number of cells that contain numeric values.</td>
<td>COUNT (C4:C24) If every cell in this range contains a value, the result will be 21.</td>
</tr>
<tr>
<td><strong>MAX (number1, Number 2...)</strong></td>
<td>Find the highest and lowest numeric value in the list.</td>
<td>MAX (C4:C24) Displays the highest numeric value in the list, ignoring text labels and blank cells.</td>
</tr>
<tr>
<td><strong>MIN (number 1, Number 2...)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MONTH (serial1 Number) and week day</strong></td>
<td>Displays only the month or day of the week for a given Day (serial 1-number). Excel automatically converts it to a serial number and so on.</td>
<td>WEEKDAY(9/29/2005) Sunday = 1, Monday = 2, and so on.</td>
</tr>
<tr>
<td><strong>PROPER (text) AND UPPER (text)</strong></td>
<td>Capitalizes you type just the first letters or all text Respectively.</td>
<td>PROPER (“MACMILLAN) computer publishing”) changes the first letter of each word to a capital letter in this case Macmillan Computer Publishing.</td>
</tr>
<tr>
<td><strong>ROUND (number, Num digits)</strong></td>
<td>Off to a given number of digits.</td>
<td>ROUND (3.1415926, 2) Rounds to two decimal places, or 3.14.</td>
</tr>
<tr>
<td><strong>TODAY</strong></td>
<td>Displays today’s</td>
<td>DATEVALUE</td>
</tr>
</tbody>
</table>
Date in this cell.             ("12/25/2001")-TODAY  
Calculates the number of  
Days between now and  
Christmas, 2001 displaying  
The result as a number.

Using Logical Functions

Some of the most useful functions are the logical functions. You can find countless practical uses for Excel’s most popular logical function, IF. The following is the syntax of the IF functions.

= IF (logical_test,value_if_true,value_if_false)

List say you’ve created a worksheet that you use to create invoice. You want to reward your best customers with a 10 percent discount, and you want Excel to apply the discount automatically.

Normally, you would use the SUM functions in the cell where you display the grand total. If you use the if function instead, you can ask Excel a simple true-or-false question: Did this customer spend more than $1,000 this month? Then you provide two sets on instructions one for Excel to use if the answer is yes, the other if the answer is no.

The If function uses three arguments the logical test, the value if true, and the value if false, the first two arguments are required, but the third arguments is optional. In the invoice example, assuming that the subtotal was in cell D24, you would fill in the following formula: IF(D24>1000,D24*90%,D24). The first argument the logical test, checks to see whether the value in D24 is greater than 1000. If that condition is true, Excel uses the second argument and calculates 90 percent of the subtotal, effectively passing along a 10 percent discount. If the logical test is false, Excel uses the third argument and displays the value shown in cell D24.

Using the Formula Palette to Avoid Errors

If you know the exact syntax of a function, you can enter the function and its argument a in the active cell, just remember to start with an equal sign. But what do you do when you’re not sure which arguments go with a specific
function? Use Excel’s Formula Palette to help you enter the function and all its arguments.

To open the Formula Palette, you must first position the insertion point in the cell where you want to add a formula.

**Using the Formula Palette to Enter Function**

1. Click the Edit Formula button = (the equal sign just to the left of the Formula bar). Excel inserts an equal sign in the Formula bar, position the insertion point to its right and opens the Formula Palette just below the Formula bar.

2. If the name of the function you want to use appears in the Function Box, click to enter it into the Formula bar. To see additional choices, click the drop-down arrow to the right of the Function Box.

3. To choose from a master list of all available functions, choose More Functions from the bottom of the drop-down list. The Paste Function dialog box appears.

4. Select a category from the list on the left, choose a function from the matching list on the right, and then click OK. Excel adds the function to the Formula bar and expands the Formula Palette to show separate text boxes for each argument.

5. Click within the first argument box and fill in the required data. To add cell references by pointing and clicking, first click the Collapse Dialog button to roll most of the Formula Palette up and out of the way. Next, select the cell or range to use for the selected argument, and then click the Collapse Dialog button again to continue.

6. Repeat step 5 for other required arguments and optional arguments.

7. After entering all required arguments, click OK to paste the complete function into the current cell, or click Cancel to start over.
**Entering Cell and Range References**

When you create formulas you choose exactly how to enter reference to cell and range addresses. To enter a cell address in a formula, type its column letter and two number, with no separation between them. (Don’t worry about capital letters, if you enter a52 in a formula, Excel converts the entry to A52 when you press Enter.

To specify a range of data, enter the address of the cell that defines the top left corner of the range, followed by a colon (:) and the address of the cell that defines the lower right corner of the range. Enter B2:M20, for example, to refer to all the cells in columns B through M that are also in rows 2 through 20. To refer to all the cells in row or column, use only the single coordinate. Thus, 2:2 refers to all the cells in row 2, and C:E includes all the cells in columns C through E.

You can also enter any cell or range reference in a formula by pointing and clicking. Start typing the formula and then click in the worksheet to enter the reference to a single cell. Drag through several cells to select a range and insert it into a formula.

**10.6 Short Summary**

- A range is any combination of cells that you select, generally so that you can enter data or include the cells in a command or formula.

- There are two types of references one is Relative and the other one is Absolute.

- Excel 2000 can crunch numbers using more than 200 functions, from simple averages to complex trigonometric formulas.
Lecture 11

Microsoft Excel

Objectives

In this Lecture you will learn the following:

- Specifying What to Print
- Working With Chart
- Working With Template
- Custom View
- Linking Work Books
- Using Arrays
Coverage Plan

Lecture 11

11.1 Snap Shot
11.2 What to Print
11.3 Producing Charts
11.4 Using Template
11.5 Using View
11.6 Linking With Work Books
11.7 About Formula Arrays
11.8 Short Summary
11.1 Snap Shot

In this lecture you will learn about what to print, how to use Charts, Templates, View in Excel. And You will learn about Linking with work books and about Arrays.

11.2 What to Print

This section describes the printing process to familiarize you with the normal steps. The File menu has four selections that are used with printing. These are Page Setup, Print Area, Print Preview, and Print.

Page Setup—This selection displays a four-part dialog that is used to lay out your page. Click the appropriate tab to display the corresponding dialog.

Page—Use this dialog box to set page orientation, scaling, and paper size.

Margins—Use this dialog box to set the left, right, top, and bottom margins, the distance from the edge of the page to headers and/or footers, and page centering. Click Options to select paper, print quality, fonts, and device options.

Header/Footer—If you wish to use headers and/or footers, use this dialog, illustrated on the following page, to create and position the text. The Custom buttons provide the ability to insert the page number, date, time, filename, or tab name. You can also arrange the header/footer information at the left, center, and/or right.
Sheet—Use to set the print area, repeating row and column titles, and page printing order, i.e., down, then over or over, then down. You can enter a print area by clicking the button in the Print area box and then dragging the desired cell range. Row and column titles can also be entered by picking the desired cells. You can also print gridlines, column and row headings, and comments, and set black and white and draft quality printing. Finally, you can create and place comments.

Print Area—Print Area is used to select or to clear the current range of selected (highlighted) cells.

Print Preview—Print Preview is used to display an image of the printed page before you send it to your printer.

Note the Print section of the Page Setup dialog has several options including Gridlines. Depending upon the complexity and purpose of the intended printout, gridlines may be useful or even necessary. Click on the Gridlines check box if you want gridlines.

Notice that Print Preview gives you direct access to the Print and Page Setup dialog boxes. The other buttons let you page through a large worksheet, zoom (enlarge or reduce the display), display and adjust margin guidelines, close the preview, and display Help.

Print—Use this dialog to specify the pages to print and the printer to use, and to print your work.

You can also access the Print Preview dialog box here. The Printer area at the top of the Print dialog is used to select a printer when more than one is installed. With some printers, you can pick the paper tray and either portrait (vertical) or landscape (horizontal) page orientation. Because you can access the Print Preview dialog box, you can start with this selection, perform all necessary preview and setup operations, and then print your workbook.

11.3 Producing Charts

A chart provides a visual representation of the values contained on a worksheet. To create a chart, select a range of cells containing both labels and numeric values. Then either use Insert | Chart or the Chart Wizard button on the
Standard toolbar. Either approach produces identical results. Note that the
dimension of charts depends on selected data.

First, select the range of cells containing the labels and values that you want
reflected in your chart. Then start the Chart Wizard and make the desired
adjustments to the selected range of cells, chart type, legends, and title. Click
the Finish button to display the chart on the underlying worksheet. You can
also click on the chart to display handles. When the handles are displayed, you
can resize the chart or drag it to a new location. Click on specific objects within
your chart, such as the title or legend, to make changes.

**Hands-on Activity**

The best way to see how easy it is to create charts using Excel is to create one
yourself. In this activity, you create a simple sales and expense table and then
chart the information using Excel’s Chart Wizard.

1. Start Excel and then type the information as shown in the illustration shown
   here.

2. Select ranges A1:C1 and A2:A4 simultaneously and set them to boldface:
   Select [A1:C1], press and hold <Ctrl>, select [A2:A4], release <Ctrl>, click
   the **Bold** button.

   **Tip:** <Ctrl+B>, <Ctrl+I>, and <Ctrl+U> are shortcut keys for boldface, italics,
   and underline.

1. Select the range A1:C4 and use **Format** | **Column** | **AutoFit Selection** to

2. With A1:C4 still selected, click the **Chart Wizard** button. Look at the
   following dialog.
Tip: If you click Finish now, Excel displays a chart using default values. Continue using <Next> so you can see the available Chart Wizard dialog boxes.

1. Close the Office Assistant if it is open. Then click **Press and Hold to View Sample** to preview the chart.

2. Click **Next** to view dialog 2 of 4. Here you can change the data range and the series. Examine the two tabs to see how the series, labels, name, and values are established.

3. Click **Next** to view dialog 3 of 4. Type the Chart title, Category (X) axis, and Value (Y) axis as shown in the following illustration.

4. Click **Next** to view dialog 4 of 4. Here, you can place the chart in either a new sheet or on an existing sheet by picking the option button and corresponding name.

5. Click **Finish** to place the chart with your data on Sheet1.
6. Now compare your chart to the following illustration.

7. Save the workbook: `<Ctrl+S>` type Charting `<Enter>`.

**Note:** You can change the chart using the Chart menu. This menu is available when you select the chart. Here, you can change the chart type as well as add gridlines, change colors, and much more.

8. Spend a few minutes experimenting with the Chart menu selections. In particular, check the folders of the Chart Options dialog.

9. Close the Chart Options dialog and double-click the chart to display the Format Chart Area dialog, which is used to change chart colors and patterns, text fonts, and other chart properties.

**Tip:** You can also double-click specific objects on your charts to display corresponding dialogs that are used to change different features.

10. This completes the charting activity. Close any open dialogs and press `<Alt+F4>` to exit Excel. Click **No** to exit without saving your experimental changes.

### 11.4 Using Template

The Template Wizard with Data Tracking add-in creates a template that links selected cells in a workbook to fields in a database. When you base a new workbook on the template and enter data in the linked cells, Microsoft Excel creates a new record in the database and copies the data to the corresponding data fields when you save the workbook.

For example, suppose that you want to track work-related injuries from multiple manufacturing sites that are connected by a network. First, create a form on a worksheet that requests the information needed for each injury report. Then use the Template Wizard to create a template from the form and link the template to a central database. When workers fill out a new injury report based on the template, they create both a "hard copy" report and a corresponding record in the database.

The Template Wizard with Data Tracking does the following:
• Automatically adds data from existing workbooks  If existing workbooks contain data you want to include in the new database, the Template Wizard can automatically add the data. However, the locations of data in the existing workbooks must match the locations of cells you select for the data fields. For example, if in step 3 of the Template Wizard you indicate that the field Employee ID is entered in cell $D$4 of the sheet named Personal_Data, all existing workbooks must contain the employee number in the cell Personal_Data!$D$4. If the data locations do not match, incomplete or blank records might be added to the database.

• Allows storage in your choice of databases  The database can be a Microsoft Excel list, or a Microsoft Access, Microsoft FoxPro, or dBase database for which you have installed the necessary ODBC driver and other data access components. Store the database in a network location that all users of the form have access to.

• Allows record updates and report creation  You can create reports from the saved data or use it as you would any database. To change the data in a record, you can reopen and edit the saved copy of the form that is associated with that record. If you delete the copy of the form, the corresponding record is retained in the database and any future updates to the record must be done with the database program. You can delete the record as you would any record in that type of database.

You can make templates easy to access  To make the template available to all users, store the template on an accessible network location. Then create a shortcut to the template, and have users copy the shortcut to the Templates folder. The Templates folder is in the folder in the Microsoft folder.

Create a form template that copies worksheet data to a database

If the Template Wizard command is not on the Data menu, you need to install the Template Wizard with Data Tracking add-in before you can perform this procedure.

1. Open the workbook in which you'll enter the data you want to copy to a database.
2. Enter labels for the data you want entered on the worksheet. Enter each label in a cell above or to the left of the cell that contains the data. The labels will be used as field names in the database.

3. On the Data menu, click Template Wizard.

4. Follow the steps in the wizard.

**Note** The database you link to the form template can be a Microsoft Excel list, or a Microsoft Access, Microsoft FoxPro, or dBase database for which you have installed the necessary ODBC driver and other data access components.

### 11.5 Using Views

Custom views change the way workbooks, worksheets, objects, and windows are displayed. You can define sets of particular display and print settings and save them as views. Then you can switch to any of the views whenever you want to display or print the workbook in a different way.

**What can be stored in custom views?** The stored settings include column widths, display options, window size and position on the screen, window splits or frozen panes, the sheet that is active, and the cells that are selected at the time the view is created. You can also optionally save hidden rows, hidden columns, filter settings, and print settings.

The custom view includes the entire workbook. If you hide a sheet before a view is added, Microsoft Excel hides the sheet each time you show the view.

**Before you create a view** Set up the workbook to appear the way you want to view and print it. If you include print settings in a view, the view includes the defined print area or the entire worksheet if the sheet has no defined print area.

**Create a view**

1. Change the settings that you want to save in the view.

Learn about setting that are saved when you create view
On the View menu, click Custom Views.
1. In the Name box, type a name for the view

2. Under Include in view, select the options you want.

Tip  When you display a view, Microsoft Excel switches to the sheet that was active when you created the view. Because Excel lists all views in the workbook in the Custom Views dialog box, include the active sheet name in the name of a view to make it easier to identify.

11.6 Linking with Work Books

Workbooks can be linked to permit consolidation of values from supporting workbooks to a master workbook. For example, you may maintain workbooks for different stores, operating divisions, or sales regions. Similarly, different worksheets within a single workbook can be used to accomplish the same result. The revenue and expense data computed in each of the divisional or regional worksheets can be combined to provide an overall view of how the top entity is performing. This section presents both approaches: the consolidation of workbooks and the consolidation of different worksheets within a single workbook.

Excel also lets you link worksheets to non-Excel documents. This feature makes use of the built-in dynamic data exchange (DDE) and object linking and embedding (OLE) capabilities that are part of most current Windows applications.

For example, Microsoft Word 2000 features an Excel button on its toolbar. Clicking this button lets users embed (or insert) a full-featured worksheet within the body of a document. You can also copy worksheet data or charts to the Windows clipboard and then paste the contents into a Word document. This same capability exists with other Microsoft Office 2000 programs such as Microsoft Access and PowerPoint.

One of the advantages to pasting a linked object, i.e., paragraph, table, or chart, is that changes to the source file are reflected in the pasted object. The dynamic linking eliminates the need for you to make a change in two places. To achieve the linkage, copy a selected passage to the Windows clipboard, position the
cursor within your worksheet, then use Edit | Paste Special and pick Paste or Paste link to finish the job. Once the object is pasted, you can double-click it to edit the source.

**Establishing Workbook Links**

You can point to values in supporting workbooks as if they were part of the current workbook. This is done by specifying a supporting workbook name and sheet and a cell or range of cells. For example, the expression

=’C:\MSOFFICE\FILES\ATSALES.XLS\SHEET1’!B3

points to the value in cell B3 of Sheet1 of the ATSALES workbook. Note that the disk drive and directory are also included. The drive and directory can be dropped if the workbook is in the same folder as the current one. In addition to using cell coordinates, you can use cell or range names. Names, such as GrandTotal, are assigned by selecting one or more cells and then using Insert | Name | Define.

**Consolidation**

Consolidating values from multiple workbooks is a fast way to derive the sum, product, standard deviation, or some other relationship between two or more identically structured worksheets. It combines, or consolidates, all numeric entries in a selected range. A detailed consolidation of each division’s sales and expenses is a good example. Consolidation differs from linking. Linking extracts data from one or more supporting workbooks. Consolidation combines values using a function such as Sum, Count, Average, Max, Min, Product, etc. Perform the following consolidation activity to see how it works.

1. Open the Excel program with blank Book1 displayed.
2. Select B3 and display the Consolidate dialog box: [B3] <Alt, D, N>.
3. Use the following procedure for each of the six designated workbooks. Be sure that the Sum function is displayed in the Function box. The filenames and formula entries are listed below.
   - ATSALES.XLS!B3:F18
   - NCSALES.XLS!B3:F18
   - NESALES.XLS!B3:F18
PASALES.XLS!B3:F18
SESALES2.XLS!B3:F18
SWSALES.XLS!B3:F18

a. Use the Browse button and double-click on the specified workbook name.
b. Type the rest of each formula and click Add.
c. Repeat steps a and b for the rest of the workbooks.

4. Exit Excel without saving: <Alt+F4> and click No to exit without saving.

Tip: If you want to use other functions, such as Average, Min, or Max, you can easily return to the Consolidate dialog box, change the function setting, and click OK. The new results are calculated and displayed. You can also display the titles in the top row and leftmost column by including them in the cell range and clicking an X in the Top Row and Left Column check boxes.

11.7 About Formula Arrays

An array formula can perform multiple calculations and then return either a single result or multiple results. Array formulas act on two or more sets of values known as array arguments. Each array argument must have the same number of rows and columns. You create array formulas in the same way that you create other formulas, except you press CTRL+SHIFT+ENTER to enter the formula.

Calculate a single result Sometimes Microsoft Excel must perform several calculations to generate a single result. For example, the following worksheet shows that a company has regional offices in Europe and North America and that each region has three product divisions. To find the average revenue per product division for Europe in 1992, you would need to use an array formula.

Cell C16 contains the array formula

=AVERAGE(IF(C5:C14="Europe",D5:D14)), which finds the cells in the range C5:C14 that contain the text "Europe" and then averages the corresponding cells in the range D5:D14.

Calculate multiple results To calculate multiple results with an array formula, you must enter the array into a range of cells that has the same number of rows and columns as the array arguments. In the following example, given a series of
three sales figures (in row 5) for a series of three months (in row 3), the TREND function determines the straight-line values for the sales figures. To display all of the results of the formula, it is entered into three cells in row 6 (C6:E6).

When you enter the formula =TREND (C5:E5,C3:E3) as an array formula, it produces three separate results, based on the three sales figures and the three months.

Use constant values  You can also use an array formula to calculate single or multiple results for a series of values that have not yet been entered on the worksheet. Array formulas accept constants in the same way that non array formulas do, but you must enter the array constants in a certain format. For example, given the same three sales figures in the preceding example, you can project the sales figures for the next two months.

Use the formula =TREND(C5:E5,,{4,5}) to project the fourth and fifth values in the monthly sequence based on the first three values.

11.8 Short Summary

♣ A chart provides a visual representation of the values contained on a worksheet.

♣ Unlike traditional databases, Microsoft Excel saves each instance of the template rather than just using the template as an entry point for adding information directly to the database.

♣ When you display a view, Microsoft Excel switches to the sheet that was active when you created the view. Because Excel lists all views in the workbook in the Custom Views dialog box, include the active sheet name in the name of a view to make it easier to identify.

♣ Workbooks can be linked to permit consolidation of values from supporting workbooks to a master workbook.

♣ An array formula can perform multiple calculations and then return either a single result or multiple results.
Lecture 12

Pivot Table, Scenario Manager, Goal Seeking

Objectives

<table>
<thead>
<tr>
<th>In this Lecture you will learn the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Understanding Pivot Table</td>
</tr>
<tr>
<td>• What If Analysis Using Scenario Manager</td>
</tr>
<tr>
<td>• Understanding Goal Seeking &amp; Solver</td>
</tr>
</tbody>
</table>
## Coverage Plan

### Lecture 12

<table>
<thead>
<tr>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.1 Snap Shot</td>
</tr>
<tr>
<td>12.2 Pivot Table</td>
</tr>
<tr>
<td>12.3 Using Scenarios to Perform What-If Analysis</td>
</tr>
<tr>
<td>12.4 Goal Seeking &amp; Solver</td>
</tr>
<tr>
<td>12.5 Short Summary</td>
</tr>
</tbody>
</table>
12.1 Snap Shot

In this lecture you will learn about the usage of Pivot Table and Using Scenarios Manager to perform what-if analysis and using Goal seeking and solver.

12.2 Pivot Table

A pivot table is used to summarize and view information in different ways. In the following activity, you open a workbook as shown from the fig. This is a tabulation of the number of sales calls made and resulting sales and sales amounts made by the members of the New York area sales team. Each team member has a geographical area in and around the New York City area. In the following activity, you create a pivot table so you can summarize the information by area.

1. Start Excel and open the Pivot file, that table resembles the following screen illustration.

2. Position the cell pointer in A1 and use Data|PivotTable Report to summarize sales information by each area as follows:

   [A1] <Alt, D, P>; examine the dialog box.
   a. Click Next>. Notice that the area A1:E13 is selected.
Tip: Whenever you want to change the range, just click the text box button, drag the desired range of cells, and press <Enter>.

a. Click Next> and Layout. Now drag the displayed title buttons (Area, Calls, Sales, and Amount) located on the right side of the dialog box into the row (Area) and column (Calls, Sales, Amount) data areas as shown in the following illustration. Note that “Sum of” is added by Excel.

1. Click OK then click Options. Use the default options shown in the screen illustration. Notice the name of the pivot table is PivotTable1. You can have more than one pivot table in a worksheet.

2. Click OK, then click Next>. Now examine the following dialog illustration. Leave it as is to place the pivot table on a new worksheet. This adds Sheet4 to the workbook that contains the pivot table.

3. Click Finish. Now examine the resulting pivot table to see how each area is summarized.
Tip: You can use the Pivot Table toolbar to select and group/ungroup two or more region areas. You can also display or hide individual items using the toolbar’s Show Detail and Hide Detail buttons. And you can use the toolbar to select data to chart. These features provide a powerful analytical tool when you want to get the most information out of your data.

12.3 Using Scenarios to Perform What-If Analysis

When you use an Excel workbook to analyze historical data you have the luxury of relying on numbers that aren’t going to change. When you know how much you sold and how much you spent last quarter, it’s easy to construct a formula to describe the spent last quarter, it’s easy to construct formula to describe the overall results. But what do you do when it’s time to prepare a forecast of what might happen next quarter? Because the numbers aren’t in yet, you have to make your best estimate of sales and expense, and hope you’re right. Predicting the future is never easy, just ask anyone who’s ever handicapped a horse race or invested in the stock market.

One of Excel’s advance workbook design features is ideal when you need to prepare forecasts. After you create your basic worksheet layout, you can define different scenarios and enter data separately for each one. By switching between scenarios you can watch the bottom line change and even change the bars and columns in charts.

Scenarios help you plan the future when you’re uncertain about some of the assumptions that go into your worksheet. Excel experts call this what if analysis. As the owner of a ski resort, for example, you might prepare a forecast with different scenarios to answer questions such as “what if we don’t get any snow before Thanksgiving?” and “What if we get a big storm of Christmas and none can drive up from the city?” By plugging in different sets of numbers, you can prepare for the best case and worst case scenarios.

The first step in the process is to create a worksheet that includes all the basic data you want to use in your comparison. Then, you select specific cells you want to part of each scenario. (The changing cells are usually part of one or more formulas in the sheet.)

1. Select the cells that will change in each scenario. For example, select cells B3, B4 and B5 (Leave B2 the same, because the price of the home is a constant in
all scenarios.) This step is optional however, if all you scenarios involve changes to the same cells, then selecting the cells first is much more convenient. Pull down the Tools menu and select Scenarios.

2. In the Scenario Manager dialog box click the Add button to display the Add Scenario dialog box as shown in Fig.

3. In the Scenario name box type a name that describes the scenario you’re creating.

4. Make sure the changing cells box contains the cells you selected if necessary click the Collapse Dialog button and change the selection.
5. By default, the comment box contains your name and the date you create the scenario. Edit this comment if you want to describe the scenario in more detail, then click OK. The scenario values box appears, as shown in figure

![Scenario Values](image)

6. Enter the value you want to use for each of the changing cells in this scenario. Because this worksheet contains named ranges, the example shows cell names rather than addresses, making the task even easier. (If cell contain data, the dialog box displays their current values) Click OK to return to the Scenario Manager dialog box.

7. Repeat steps 2-6 to create additional scenarios.

8. Select any scenario and click the show button at right (or double-click the scenario name) to show the worksheet using those values. Others buttons let you add remove and edit scenarios.

After creating scenarios, you can add new scenarios or change existing ones using the same set of dialog boxes. Pull down the tools menu and choose scenarios. To create a new scenario click the Add button. To edit an existing scenario select its name in the scenarios list and click the Edit button.

12.4 Goal Seeking & Solver

After you've constructed a worksheet and built all your formula, you may discover that you can't easily get the answer you're looking for.

But what if you want to calculate how much home you can afford based on a maximum monthly payment? You could construct a new formula. Or you could use the trial and error method, entering different home prices until you find the right one. But the fast and easy way is to use Excel's Goal Seek tool to do the calculations in one operation.
Using Goal Seek to Find a Value

1. Open the worksheet that contains the formula you want to work with then pull down the tools menu and select Goal Seek.

2. Fill in the three boxes in the Goal Seek dialog box to match the results you’re trying to achieve. For example I asked Excel to set cell B14 which contains the total monthly payment to 2000 my maximum monthly budget, by adjusting the purchase price in cell B2.

3. When you click ok, Excel runs through all possibilities and displays the Goal Seek Status dialog box, a shown in figure. If you look at the worksheet itself, you’ll see the values have changed to reflect the result you were looking for.

4. Click ok to incorporate the changed data into your worksheet click Cancel to close the dialog box and restore the original data.

12.5 Short Summary

♣ A pivot table is used to summarize and view information in different ways.

♣ Scenarios help you plan the future when you’re uncertain about some of the assumptions that go into your worksheet. Excel experts call this what if analysis.
Lecture 13

Microsoft PowerPoint

Objectives

In this Lecture you will learn the following:

- Features Of Power Point
- Using Auto Content Wizard
- Creating Blank Presentation
- Power Point View
- Inserting Objects
- Applying Slide Transition
- Saving the Presentation
Coverage Plan

Lecture 13

13.1 Snap Shot
13.2 What is Power Point
13.3 Auto Content Wizard
13.4 Creating Presentation Using Design Templates
13.5 Creating Blank Presentation
13.6 Inserting Objects
13.7 Power Point Views
13.8 Saving & Printing Your Works
13.9 Working With Colors & Transitions
13.10 About Slide Show Timings
13.11 Navigating During Presentation
13.12 Short Summary
13.1 Snap Shot

Microsoft PowerPoint 2000, which runs under the Windows 95/98 and NT operating systems. From this point forward the common name “PowerPoint” is used. You should be able to create, save, and print many kinds of presentations used to communicate your ideas in an impressive, dynamic way.

This section shows you how easy it is to view your presentation information (or “slides”) in a variety of ways. All that is necessary is to click one of the View buttons located at the bottom left-hand corner of the working area. You can pick the same views using the selections within the View menu.

13.2 What is PowerPoint?

PowerPoint is a full-featured presentation program that is used by millions of people around the world. PowerPoint is used to design presentations for a variety of mediums including computer-based display shows, overhead projection transparencies, and 35 mm slides. You can add sound and animation to your slides to achieve a high level of impact.

PowerPoint gives you the ability to prepare paper-based presentations and handouts for your audience. You can also package and distribute your presentations with a PowerPoint Viewer. You can even package and distribute your presentations in PowerPoint 4.0 (16-bit) format, so those people who are still using Windows 3.x can run your presentations.

As with the other Office 2000 programs, PowerPoint makes use of all of the features available to programs designed specifically to run with a 32-bit operating system such as Windows 95/98 and NT. When acquired as part of Office, PowerPoint uses a number of shared Office resources. This includes fonts, ClipArt, spelling resources, AutoCorrect, Internet Explorer, and more.

Like all other Office 2000 programs, PowerPoint can integrate documents and information created by other Office and Windows programs. For example, you can insert Excel spreadsheets or Word tables directly into a PowerPoint slide. You can also export a slide presentation to a Word document with the click of a button on PowerPoint’s Standard toolbar. The ease and flexibility of performing these operations is impressive.
To start PowerPoint 2000, Perform one of the following:

- Click the Office 2000 Shortcut Bar’s New Office Document button and double-click the Blank Presentation icon to create a new PowerPoint 2000 document.

- (Click the General tab if it is not already selected to see the Blank Presentation icon)

- Click the Office 2000 Shortcut Bar’s Open Office Document button and from its directory select an existing PowerPoint 2000 presentation that you want to edit.

- Use the Windows Start menu to start PowerPoint 2000 by selecting Microsoft PowerPoint from the Programs menu.

- Select a PowerPoint 2000 document from the Windows Start menu’s Document option. Windows recognizes that PowerPoint 2000 created the presentation document, starts PowerPoint 2000, and loads the presentation file automatically. (The Start menu’s Document option holds a list of your most recent work.)

- Click the Office 2000 Shortcut Bar’s PowerPoint 2000 button to create a blank presentation. Depending on your Office 2000 Shortcut Bar’s setup, you might not see the PowerPoint 2000 button.

Unlike the other Office 2000 products, PowerPoint 2000 begins by offering a Wizard-like template query that you can select for the type of presentation you want to create. Press Esc to get rid of the opening dialog box that teaches you about the PowerPoint 2000 screen.

Fig Shows the opening PowerPoint 2000 screen. Your screen might differ slightly depending on the options that you chose during installation. If your PowerPoint 2000 offers a list of options such as opening an existing presentation or creating a new one, select the option that creates a new presentation.
Understanding Presentation and Slides

The primary purpose of PowerPoint 2000 is to help you design, create and edit presentations and printed handouts. A presentation is a set of screen (slides) that you present to people in a group or workbook tutorial. Because PowerPoint 2000 provides a wide variety of predefined templates, you don’t have to be a design specialist to create good-looking presentation.

Note:

A Presentation is a set of screens that you share with a group of people as slide show. A Slide show is a preview of your presentation slides, one at a time, controlled, manually or viewed in a timed presentation.

PowerPoint 2000 slides can contain information from the following:

- Data you type into PowerPoint 2000, including text, charts, graphs, and graphics.
- Word 2000 documents
- Word 2000 document outlines
- Excel 2000 worksheets
- Excel 2000 graphs and charts
Creating a New Presentation

The first Fig shows the opening window that you see when you start PowerPoint 2000 and begin a new presentation. The figure shows several design templates that contains layouts you can use (templates are stored in files that contain the .pot extension) The design template works well for creating a PowerPoint 2000 presentation one slide at a time, but the design template might not be the best place to begin in many instances. The AutoContent Wizard, covered in the next section, is sometimes a better place to start.

13.3 The AutoContent Wizard

Perhaps the best place to begin creating a new presentation, particularly if you are new to PowerPoint, is the AutoContent Wizard. This Wizard contains a sample presentation with sample text and a selected design. Use the Wizard’s dialog boxes to select a design that best suits your needs.

The AutoContent Wizard is a presentation design wizard that contains sample data from which you can select and edit to create your customized presentation.

To use AutoContent Wizard to create your presentation, follow these steps:

2. Cancel the New Slide dialog box.
3. Select File, New to display the New Presentation dialog box.
4. Click the Presentations tab to display several samples presentations.
5. Double-Click the icon labeled AutoContent Wizard to start the AutoContent Wizard’s question-and-answer session.

6. Answer the AutoContent Wizard’s questions to design a presentation shell the best fits your application’s requirements.

For Example If you choose Business Plan the Figure will be looking like this.

The AutoContent Wizard selects the best choice from among these template styles after you complete the Wizard.

♦ Brainstorming
♦ Business Plan
♦ Certificates
♦ Communicating Bad News
♦ Company Meeting
♦ Corporate Financial Overview
♦ Corporate Home page
♦ Corporate Handbook
♦ Employee Orientation
♦ Financial Plan
♦ Organization Management
♦ Marketing Plan
♦ Meeting Facilities Planner
♦ Project Status
♦ Reporting Progress
♦ Sales Flyers
♦ Team Motivation
♦ Technical Reporting
♦ Training
♦ Who’s who

All these AutoContent Wizard templates are available to you if you don’t want to run the wizard first. PowerPoint 2000 supplies two styles for each template: One for an online Intranet or Internet PowerPoint 2000 presentation, and one for a standalone PowerPoint 2000 presentation known as a standard presentation.

After PowerPoint 2000 creates the presentation outline, you have to fill in the details. Click any slide’s icon in the left column of the presentation outline that the AutoContent Wizard produces to edit that specific slide.

### 13.4 Creating Presentation Using Design Templates

If you start PowerPoint 2000 and select File, New, PowerPoint 2000 presents you with the New Slide dialog box. The New Slide dialog box contains several templates that you can use to start your presentation’s first slide.

Display the New Slide box whenever you need to create a new slide for a presentation. A presentation contains one or more slides, so you need to display the New Slide dialog box every time you are ready to add the next slide to the presentation. To display the New Slide dialog box at any time, click the New Slide option in the Common Tasks menu.
As you click through the templates, the New Slide dialog box displays a description in the lower-right corner, such as Chart & Text, that describes the template’s most common use. Note that the AutoContent Wizard uses several of the templates for its individual slides.

Fig Represents a template’s generated slide when you select a template.
13.5 Creating Blank Presentation

When you create a new presentation from scratch, you can still take advantage of the design templates. One of the design templates in the New Slide dialog box selects list is the Blank templates, shown in Fig.

Blank presentation require that you manually create every slide element, including the text, titles, and body. Most slides have a title, text, and an optional graphic image.

If you design your own slide from a blank template, you can later apply one of the template styles to the slide! Therefore, if you don’t like what you generate from scratch, PowerPoint 2000 enables you to redesign the slide without requiring you to re-enter the slide’s text. If you save a presentation as a template file, you can use that presentation’s format for subsequent, presentation.

13.6 Inserting Objects

As with other Microsoft Office products, you can import objects from other programs right into your presentation slides. For example, you can insert clip art, media clips, and drawings created by other programs. You can also insert financial data from an Excel worksheet and tables from a Word document. And you can call on Microsoft Graph to create and insert charts into your presentations. Once a presentation is finished, you may want to convert it to a text document. PowerPoint also provides the ability to export the text content
of your slides to Microsoft Word. This section shows you how to accomplish all of these powerful capabilities.

The Tool Set

Like many controls, PowerPoint gives you alternative ways to insert objects from external resources. You can use the Insert menu or buttons on the Standard toolbar. Notice that the bottom group of selections on the Insert menu provides options for inserting a variety of items. You can insert slides from existing presentations using Insert|Slides from Files and Insert|Slides. Selecting Insert|Object displays the Insert Object dialog from which you may select Microsoft Excel data and many other objects for insertion into your presentation.

There are a few buttons used for inserting objects on the toolbar, as well. From left to right, beginning with the Insert|Hyperlink button, you can insert a Word table, a chart, or a new slide (from this or another presentation). The following paragraphs guide you through the operation of each of these features.

Clip Art

Office 2000’s clip art library is available to PowerPoint as well as the other Office 2000 applications. The Office 2000 CD contains clip art, media clips, and other resources. Also, you may download material from the Internet to give you access to a large collection of clip art, media clips, and other resources over the World Wide Web. You have a good assortment of resources from which to choose. To insert clip art, display a slide in the Slide View. The first time you use the Insert|Picture|Clip Art menu selection, the following dialog may be displayed if you have not previously installed clip art. Place your Office disk in the CD-ROM drive and click OK.

If clip art was previously installed, you will see the following dialog. There are 16 categories from which to choose an array of clip art. Also, you can designate a new category by clicking on the New Category image and specifying a name
for the category in the subsequent dialog. Then, using the Import Clips feature located at the top of the dialog, you can customize to your heart’s content.

Also, choose Insert|Picture|From File and look in the C:\Program Files\Microsoft Office\Clipart directory to find additional clip art. This is an example Insert Picture dialog looking in the Popular subdirectory of the C:\Program Files\Microsoft Office\Clipart directory. Of course, you may have more clip art elsewhere on your computer.

Pick the clip art, picture, sound, or video clip of your choice and click Insert. The selected object is placed on your slide.

Notice that this dialog includes a list of categories and a clip art gallery. Simply select a category, then scroll through the gallery until you find the clip art you want. Click the Preview button to see the image full size. Click the picture and then Insert, or double-click the picture itself to insert it on the current slide. Once it’s on the slide, you can drag it, scale it, or even cut and paste it as with other objects.

Excel Worksheets

There are two ways to insert an Excel worksheet onto a slide. Both are described in the following general procedures.
**Direct Method:**

1. Place your cursor where you want the worksheet to go. Click Insert | Object and select Microsoft Excel Worksheet. Click on OK. Notice you can also insert an Excel chart using this same procedure. An Excel worksheet is now displayed.

2. Enter the information in the cells, including standard Excel formulas. Note that you can drag the borders of the worksheet object to see more cells.

3. Drag the edges of the worksheet object so that only the completed cells are displayed (in other words, hide the unused cells).

4. Click away from the worksheet to display the worksheet data. This also redisplays the PowerPoint toolbars and hides the Excel borders.

5. Now you can drag and scale the worksheet object using the handles. You can edit worksheet values by double-clicking on the worksheet object.

6. **Cut and Paste Method:**

7. Launch the Excel program and display a worksheet.

8. Select the cells you want inserted into a slide and press <Ctrl+C> to copy them.

9. Launch PowerPoint (or switch to it if it is already running) and display a blank slide.

10. Place the cursor at the intended location to insert the worksheet. Press <Ctrl+V> to insert the worksheet object.

11. Drag and scale the worksheet object as necessary.

Use either of the above techniques to insert Excel worksheet data into your presentations.
Tip:
You can use Edit|Paste Special if you want the worksheet object linked to the source file. When this is done, changes to the source worksheet automatically update the worksheet object on your PowerPoint slide. This is a good illustration of object linking and embedding, or OLE.

Word Tables

Like Excel worksheets, there are also two ways to insert a Word table onto a slide: the direct and cut and paste methods. Although similar, the cut and paste method varies, as you can convert the table to an editable PowerPoint picture object. Examine both methods in the following general procedures.

Direct Method:

1. Click the Insert Microsoft Word Table button. Set the number of columns and number of rows to the desired number of rows and columns in the Insert Table dialog.

2. Click on OK.

3. Type your tabular information into the cells of the table. You can add more rows and columns to the table by selecting an entire row or column and then copying and pasting it (just like in Word). Another way to add rows is to click on the last row and column and then press <Tab>.

4. When you finish typing your tabular data, display it properly by clicking away from the table. This also redisplayes the PowerPoint toolbars and hides the Word table rulers.

5. Now you can drag and scale the table object using the handles. You can edit tabular values by double-clicking on the table object.

Cut and Paste Method:

1. Launch Microsoft Word and display a table document.

2. Select the cells you want inserted into a slide and press <Ctrl+C> to copy them.
3. Launch PowerPoint (or switch to it if it is already running) and display a blank slide.

4. Press <Ctrl+V> to insert the table object.

5. Double-click on the table object. Press and hold <Shift> and drag the handles as necessary to crop out (or remove) the extra space around the table. Release Shift.

6. Drag the handles to resize (scale) the pasted table. Then click off the table to remove the displayed table borders.

7. Drag and scale the table object as necessary. If an exterior rule is missing, use the Drawing toolbar’s Line tool to add a new one.

Use either of the above techniques to insert Word tables into your presentations.

Tip:

As with worksheets, you can also use Edit|Paste Special if you want the table object linked to the source file. You can insert it as either a Word document or a picture. If inserted as a picture, you may want to group it, as the table may be made up of hundreds of individual line and text objects. For more information, see the tip following the cut and paste method of the Excel worksheets paragraph.

Microsoft Graph

Microsoft Graph 2000 is a companion program that lets you create and insert charts into your slides, as well as into other Office 2000 applications. The general procedure for creating a chart is given in the following steps.
1. Click the Insert Chart button on the Standard toolbar. A data table is displayed, with a graph behind it. Alternately, you can click on Insert | Object | Microsoft Graph 2000 Chart and click on OK.

2. Type the values in the table; check the displayed result by clicking the View Datasheet button on the Standard toolbar (or use View | Datasheet from the menu).

3. Go between the table and the chart using the View Datasheet button (or View | Datasheet) until you’ve typed all necessary values.

4. Use the Chart toolbars to control the appearance of your charts. Toolbar selections unique to Microsoft Graph are described below:

   **View** — Move between the chart and datasheet views.

   **Insert** — Insert titles, data labels, legends, axes, and gridlines.

   **Format** — Format control for fonts, numbers, object placement, column widths, chart types, and 3-D views.

   **Tools** — Adjust Microsoft Graph default settings using the Options dialog.

   **Data** — Switch between series in rows or series in columns (chart orientation); choose to include or exclude selected cells in the chart.

   **Chart** — Select a different chart type, or use Chart Options to access a variety of chart features including titles, axes, gridlines, and legends.

   **Window** — Open a new window or arrange, fit, or cascade existing windows.

The Standard toolbar buttons unique to Microsoft Graph are described below: (first row)

   **Chart Area** — Select the chart element you want to change.

   **Format Chart Area** — Formats the selected chart item.
Import File—Imports a selected range of data, an entire data sheet, or a file.

View Database—Displays the datasheet window where data is entered and/or formatted.

By Row—Plots chart data series from data across rows.

By Column—Plots chart data series from data down columns.

Data Table—Displays data series values below the chart in a grid.

Chart Type—Changes the chart type for an individual data series, a chart type group, or an entire chart.

Category Axis Gridlines—Hides or shows category gridlines in charts.

Value Axis Gridlines—Hides or shows value axis gridlines in chart.

Legend—Adds a legend to the right of the plot area. Resizes the plot area to accommodate the legend. If a legend is already present, clicking this button will remove the legend.

Drawing—Hides or displays the Drawing toolbar.

1. Use the buttons as shortcuts to the menu items. The purpose of each button is described by a fly-out label.

2. Click away from the chart when it is ready. This displays the chart and redisplays the PowerPoint menus and toolbars.

3. To change the data or appearance of your chart, just double-click the chart object to return to the Microsoft Graph environment.
Inserting Movies and Sound

Media clips, sound, and CD-based audio objects are quickly inserted using the Insert | Movies and Sounds menu.

The Movie from Gallery and Sound from Gallery selections use the same dialog that is used to insert clip art and pictures. Be sure that the Office 2000 CD is inserted in your CD-ROM drive, as a number of media clip and sound resources are available there. The Movie from File and Sound from File selections display dialogs in which you select folder and filenames.

The Play CD Audio Track option displays the dialog shown here.

This dialog operates with a standard audio CD plugged into your CD-ROM drive. It is ideal for background music or other sound effects.

Record Sound is used to make a recording of an audio source such as a tape or CD player or a microphone.

Now that you have some ideas about how PowerPoint works with external objects, it’s time to try the hands-on activity so you can actually see how easy it is to embed these objects into your slides.
Hands-on Activities

Creating Slides

In this activity you create four blank slides. As each is created you insert clip art, an Excel worksheet, a Word table, and a Microsoft Graph chart. Begin by launching PowerPoint and starting a blank presentation.

1. Click the Blank slide template (third row, fourth column) in the New Slide dialog and click OK.

2. Click the Insert | Picture | Clip Art button on the Standard toolbar to display the Insert ClipArt dialog.

3. Go to the Map category and click the World map picture. (If you don’t have this, use another.)

4. Click the Insert button and the clip art is inserted onto the slide. Drag and scale the clip art object to a size suitable for viewing on your monitor.

5. Click the Insert | New Slide button on the Standard toolbar, pick the Blank slide, click OK, and notice that slide 2 is added.

6. Click Insert | Object and select Microsoft Excel Worksheet; drag a 4 x 4 sheet. Then type the labels, numbers, and formulas as shown.

7. Select (or drag across) the labels in column A and row 1 and click the Bold button. Select the cells on the Expenses row (row 3, columns A through D) and click the Borders button to add an underline. Select row 1, columns A through D and click the Borders button again.

8. Click away from the worksheet. Drag and scale the worksheet object into position so that it resembles the following illustration.

9. Click the Insert | New Slide button on the Standard toolbar, pick the Blank slide, click OK, and notice that slide 3 is added.
10. Click the Insert | Table button; set the number of rows to 4 and the number of columns to 4; type the information as shown. Then select the entire table with <Alt+A, A> and set the font size to 28.

Tip:
In step 11 the column and row labels are set to bold. In step 12 you apply an AutoFormat to the table. This replaces existing format settings with those applied by the new format. Step 11 is simply for practice.

1. Select the column labels and click the Bold button, then click the Italics button. Then click the row labels and click the Bold and Italics buttons again.

2. Highlight the data fields, then click the Center Text button.

3. Click away from the table. Drag and scale the table object into position so that it resembles the following illustration.

4. Click the Insert | New Slide menu selection on the Standard toolbar, pick the Blank slide, click OK, and notice that slide 4 is added.

5. Click the Insert | Chart button; notice that Microsoft Graph is launched and a data sheet is displayed.

6. Change the values as shown in the following illustration.

<table>
<thead>
<tr>
<th>Category</th>
<th>1988</th>
<th>1999</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>125</td>
<td>130</td>
<td>225</td>
</tr>
<tr>
<td>Expenses</td>
<td>100</td>
<td>110</td>
<td>210</td>
</tr>
<tr>
<td>Net Profit</td>
<td>25</td>
<td>20</td>
<td>45</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category</th>
<th>1988</th>
<th>1999</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>125</td>
<td>130</td>
<td>225</td>
</tr>
<tr>
<td>Expenses</td>
<td>100</td>
<td>110</td>
<td>210</td>
</tr>
<tr>
<td>Net Profit</td>
<td>25</td>
<td>20</td>
<td>45</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>High</th>
<th>Low</th>
<th>Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>1997</td>
<td>103</td>
<td>4</td>
<td>76</td>
</tr>
<tr>
<td>1998</td>
<td>101</td>
<td>21</td>
<td>73</td>
</tr>
<tr>
<td>1999</td>
<td>99</td>
<td>16</td>
<td>75</td>
</tr>
</tbody>
</table>

7. Click Chart | Chart Type menu selection. In the Standard Types folder of the Chart Type dialog, choose Line. Then click away from the data sheet. Drag and scale your chart so that it resembles the following illustration.
Note:

To change the chart lines from the light-colored default colors to black, I double-clicked on the chart, then clicked on each line in turn. When a line was selected, I clicked on Fill Color and selected black. Now the lines are black but the color of the circles, rectangles, etc., designating each line remain unchanged. But you will only see black on this page as it is not printed in color.

8. Press <Ctrl+Home>. Then start the Slide Show view and page through the four slides.

9. Use File | Save, give the slide show the name Objects, and click Save.

Using Cut and Paste to Create Slides

If you want to learn how to cut and paste a Word table or Excel worksheet into a PowerPoint slide, perform the following steps. If not, skip directly to the summary.

1. Leave PowerPoint running; use the Windows Explorer to launch the Monthly Utilities document copied from the CD to the \MSOffice\Files subdirectory.

2. Click inside the table. Then use Table | Select Table to select the entire table.

3. Press <Ctrl+C> to copy the table. Then use File | Exit to exit Word.

4. Click the PowerPoint button on the taskbar. Press <Ctrl+End> to display the last slide.

5. Click Insert New Slide and add new blank slide 5 of 5 to your presentation.

6. Press <Ctrl+V> to paste the table on the slide.

7. Use View | Toolbars and activate the Picture toolbar. Click the Crop tool and drag the right side of the table toward the center to remove the excessive blank space. Then hide the Picture toolbar.
8. Center the table on the slide and click away from the table.

9. Now use the Windows Explorer to launch the Monthly Utilities worksheet copied from the CD to the \MSOffice\Files subdirectory.

10. Drag (select) cells A1 through F14. Press <Ctrl+C> to copy the selected range of cells.

11. Click the PowerPoint button on the taskbar.

12. Click New Slide and add new blank slide 6 of 6 to your presentation.

13. Use Edit | Paste Special to display the Paste Special dialog. Click the Paste option button. Then select Microsoft Excel Worksheet Object and click OK.

14. Drag the handles to enlarge and center the worksheet on the slide. Click away from the worksheet to remove the handles.
Tip:

The gridlines are displayed if Excel’s Gridlines option is selected.

15. Press $\text{Ctrl+S}$ to save the added slides with your presentation.

16. Press $\text{Alt+F4}$ to close PowerPoint.

This concludes the activity. Note that you could have easily added background colors, textures, shading, and transitions using the skills you learned in previous sections. However, these additions would have taken considerably more steps. If you would like to exercise these skills, feel free to reopen the Objects presentation and begin adding title text, backgrounds, and transitions.

### 13.7 Power Point Views

**The View Buttons**

The following illustrations show each of the View buttons. The purpose of each of the buttons follows the illustration, along with an example of the corresponding screen. Notice the Normal, Slide Show, and Slide Sorter view selections are available both from the View menu selection and from the View icons located on the bottom left of the view window.
**Normal View**—Normal view displays three panes—the outline pane, the slide pane, and the notes pane. The three panes allow you to work on all aspects of the presentation in one place. The sizes of the different panes are adjusted by dragging the pane borders.

**Outline View**—The Outline View is used to display an outline format of your slide show. The slide number and text contents are displayed here. In this view you can edit the displayed text, delete slides, and even cut and paste slides from one location to another. Cutting and pasting is possible within the same presentation or between different presentations. Work in Outline View when you wish to organize and develop the content of your file.

**Slide View**—The Slide View is used to create and edit your slides. This is the default view when you first open PowerPoint. In this view, all of the menus and toolbars are available for use. Use this view to insert and edit the contents of your slides.

**Slide Sorter View**—The Slide Sorter View gives you a miniature picture of each slide. You can use this view to select and drag slides from one position to another within your slide show. In this view you can even display two sets of slides simultaneously and then drag and drop slides from one presentation to the other.

**Slide Show**—This view displays the slides full screen. It is used to show or simply review your slide presentations. Use this view to check final sizes, colors, animation, transitions between slides, sounds, and other controls. To check the timing of a self-running presentation, use the View | Slide Show menu selection. You can also distribute your presentations with the PowerPoint Viewer program, used to run presentations without the actual PowerPoint program.

The following two submenus allow you to adjust the size, orientation, and properties of the various views.

**File | Page Setup**—File | Page Setup displays the Page Setup dialog. Use it to adjust the size and orientation of your displayed slides, as well as the beginning page number. You can adjust the size of your slides for use as an on-screen show (default), a 35 mm slide show, a paper-based letter- or A4-size
presentation, overhead, banner, or custom size slide show. The Height and Width boxes let you set the custom sizes. You can also change the orientation from landscape (horizontal) to portrait (vertical).

**File | Properties**—Use this menu selection to display general information and detailed statistics about the current slide presentation. Five different tabs are available in this dialog. Each displays a different set of information. The best way to determine the kind of information provided is to open and browse the Properties dialog when a slide presentation is open.

### 13.8 Saving and Printing Your work

Be sure to save your presentation after creating and finalizing it. PowerPoint 2000 saves your presentation with .ppt document filename extension unless you override the default file type and save your presentation in the Web-based HTML format.

Of course, you also need to print your presentation, either to paper, to a color printer, or to a printer that supports transparencies. The File, Print dialog box works differently in PowerPoint 2000 than in Word 2000 and Excel 2000. Instead of globally printing the presentation, you must indicate in PowerPoint 2000 exactly how and what you want to print.

### 13.9 Working with Colors and Transitions

This section shows you how to add snap to your slides with color variations, shading, highlighting, and attractive transitions between slides. The following paragraphs discuss the PowerPoint controls used to modify colors, shading, and transitions.

**Background Color Control**

In the previous section you learned how to control the color of text and text object fills and borders. You used the Formatting and Drawing toolbars and the Menu Bar. The Format menu selection is also used to color the background of your slides. Recall that the color of text is quickly changed by selecting (highlighting) the text and then clicking the Drawing toolbar’s Font Color button. Clicking the More Font Colors option on the Font Color palette
accesses many additional colors. A palette of standard colors is available, as is a custom dialog where you can vary standard colors to suit your personal taste.

These two palettes are also available for background coloring. The Format menu selections associated with background color control were listed in the last section. These are the Slide Layout, Slide Color Scheme, and Background selections. Recall that the Slide Layout dialog provides 24 different layouts from which to choose.

**Format|Slide Color Scheme**—Use this dialog to choose a standard color scheme or to create a custom color scheme of your own. The Standard tab of the Color Scheme dialog offers three choices of schemes. Each scheme shown represents the colors used by that scheme for the particular items displayed. The middle scheme shows black text on a white background and several muted colors used for charting. The three schemes are pretty basic and are useful for getting started, but they are not really eye-catching. But then, eye-catching may not be appropriate for the particular topic and audience. The use of visual stimulation is context sensitive. What may work for one presentation and audience will not necessarily work for another. Know your audience and your intended purpose.

The Custom tab of the Color Scheme dialog provides an opportunity to enhance your presentations with much more stimulating colors. Here, you can change the colors of any of the items in the Scheme colors list by clicking an item, clicking the Change Color... button, and making a new color selection.

After clicking the Change Color... button a Color dialog appears with a Standard and a Custom tab. The one shown here is the Background Color dialog.

The Standard and Custom tabs are used to change the colors of the feature selected in the Color Scheme dialog. The Standard dialog offers a variety of fixed colors. Just click on the desired color and then click OK.

The Custom dialog lets you adjust the hue, saturation, lumination, and percentage of red, green, and blue of a color. Simply move the cross hair, slide the triangular pointer, or change the numerical values in the spin boxes until you see a color you like.
Once you select your color, use either the Apply or Apply to All button as desired. The Apply button affects the current slide, while Apply to All applies the color scheme to all slides in the current presentation.
Format | Background — Use this dialog to apply a custom background fill to one or all of your slides. Click the down arrow to display more colors or special fill effects.

Format | Apply Design Template — Use this selection to pick a slide design template from a list of 22 different designs.

You can also use the Look In drop-down box to find a presentation or template file. Then, you can apply the format of an existing slide presentation to the current presentation.

Transition Control

A transition from one slide to the next can be anything from a quick replacement, or cut, to an attention-getting dissolve or wipe. For example, a checkerboard dissolve or a horizontal sweep both make for an interesting introduction to the next slide in a series.

PowerPoint’s Slide Transition dialog, which is accessed using the Slide Show | Slide Transition menu selection, offers a list of 41 different transitions. These include wipes, covers, uncovers, strips, checkerboards, dissolves, and more. A Random transition is also included, which randomly picks various effects.
The Sound option allows you to apply sound effects to your presentation when the slide is transitioning. There are 16 included sound effects for emphasizing or entertaining when transitioning to another slide. You may also choose a sound from another source.

You can automatically advance each slide after an allocated period by setting Advance to Automatically after: and specifying the number of seconds to wait. Or, by checking the On Mouse Click option you can control the slide display time by clicking the mouse when you are ready to move on to the next slide.

The amount of time a slide takes to transition to another slide is determined by the Slow, Medium, and Fast radio buttons.

Finally, you can apply the settings to the currently selected slide or you can apply the settings to every slide in the presentation.

**Applying a Slide Transition**

To apply a slide transition, first display the desired slide in the Slide View. Then click Slide Show | Slide Transition to display the Slide Transition dialog. Click the arrow at the right of the Effect text box to display a list of transitions. Click on the down arrow (or move down with the down arrow) to see the different effects. You can check the effect by watching the preview box. Then set the speed to Slow, Medium, or Fast; again, check the preview box for speed.

If your computer is equipped with a sound card and you want to add sound, pick a sound effect from the Sound pick list.

If you are developing a self-running presentation, use the Advance section of the dialog to set the time, in seconds, that the current slide is displayed. When the set time expires, the next slide is displayed.

Like background colors, slide transitions are also easy to use. The following hands-on activity guides you through the use of both background colors and transitions.

**Hands-on Activity**

In this activity you use the Sales Points presentation. First you add transitions and change color schemes. Then you run the presentation to see how the
changes look. Finally, you save the presentation under a new name. Begin by starting PowerPoint and opening the Sales Points presentation.

1. With the Sales Points presentation displayed in the Normal View, check that slide 1 of 4 is displayed.

2. Use **Slide Show|Slide Transition** and pick the **Box Out** effect. Set speed to **Medium**. If you have a sound card, set Sound to **Drum Roll**. Leave Advance set to **On mouse click**. Finally, click **Apply**.

3. Press **<Page Down>** to advance to slide 2.

4. Use **Format|Slide Color Scheme**, pick the right-hand color scheme, and click **Apply**.

5. Use **Slide Show|Slide Transition**, and pick the **Blinds Horizontal** effect, **Medium** speed, and **Whoosh** sound. Click **Apply**.

6. Press **<Page Down>** to advance to slide 3.

7. Use **Format|Background**, pick the down arrow, click **Fill Effects**, and then click the **Texture** tab. Pick the **Walnut** texture (second column, sixth row) click **OK** then **Apply**.

8. Use **Slide Show|Slide Transition**, and pick the **Checkerboard Down** effect, **Medium** speed, and **Ricochet** sound. Click **OK**.

9. Press **<Page Down>** to advance to slide 4.

10. Use **Format|Background**, pick the down arrow, and click **More Colors**. Then click the **Standard** tab.

11. Pick a dark green swatch (outlined in the adjacent illustration) and click **OK**.

12. Click the down arrow again and then click **Fill Effect**. Pick the **Gradient** tab, the **Horizontal** shading style, and the upper left-hand variant; click **OK**, then **Apply**.
13. Use Slide Show|Slide Transition, and pick the Cover Right effect, Medium speed, and Screeching Brakes sound. Click OK.

14. Press <Ctrl+Home> to display the first slide. Then click the Slide Show View button, and page through the slides by clicking the mouse when you are ready to view the next slide, checking the colors and transitions of each. Then press <Esc> to return to the Slide view.

15. Use File|Save As and save the modified presentation as Sales Show.


Consider varying the color of each slide to make your presentation more interesting to your audience. You should also vary your transitions for the same reason.

13.10 About Slide Show Timings

You can set timings for your slides before you rehearse, or you can set them automatically while you rehearse. If you set them before you rehearse, you'll find it easiest to work in slide sorter view where you see miniatures of each slide in your presentation. You can set the timing for one or more selected slides by clicking Slide Transition on the Slide Sorter toolbar, and then entering the number of seconds you want the slides to appear on the screen. You can also set a different timing for each slide — for example, you can have the title slide appear for 10 seconds, the second slide for 2 minutes, the third for 45 seconds, and so on.

To rehearse your timings, just click Rehearse Timings on the Slide Show menu. You can use the buttons in the Rehearsal dialog box to pause between slides, restart a slide, and advance to the next slide. PowerPoint keeps track of how long each slide appears and sets the timing accordingly.

Set slide show timings manually

1. In normal or slide sorter view, select the slide or slides you want to set the timing for.

2. On the Slide Show menu, click Slide Transition.
3. **Under Advance**, click **Automatically after**, and then enter the number of seconds you want the slide to appear on the screen.

4. To apply the timing to the selected slides, click **Apply**.

5. To apply the timing to all the slides, click **Apply to All**.

6. Repeat the process for each slide you want to set the timing for.

To view the timings, click **Slide Show** at the lower left of the PowerPoint window.

**Tips**

- If you want the next slide to appear either when you click the mouse or automatically after the number of seconds you enter — whichever comes first — select both the On mouse click and the Automatically after check boxes.

- If you have a self-running presentation and you want to restrict viewers to using action buttons you have set up with hyperlinks to navigate to the next slide, clear both the On mouse click and the Automatically after check boxes.

**Set slide timings automatically while rehearsing**

1. On the Slide Show menu, click **Rehearse Timings** to start the show in rehearsal mode.

2. Click the advance button when you're ready to go to the next slide.

3. When you reach the end of the slide show, click Yes to accept the timings or No to try again.

**Tip** If you know the timing you want for a slide, you can enter it directly in the Rehearsal dialog box.

### 13.11 Navigating During Presentation

One of the best ways to see the overall effect of your presentation is to run Slide Show. Slide Show displays your slides in sequence, moving from one slide to another, transitioning (changing) with special effects that you have set up, and moving at a preset timing that you can control.

**Note:**
Slide Show is the PowerPoint 2000 slide projector that displays your presentation slides in sequence, with optional transitions between the slides.

Follow these steps to start Slide Show:

- Finish editing your presentation and save it.
- Select the Normal View.
- Display the first slide in the presentation. (The Home key always takes you to the first slide, and the End key takes you to the last.)
- Click the Slide Show view button. PowerPoint 2000 prepares the slides and displays each slide, full screen, one at a time, as you click the mouse or press PageUp and PageDown.
- PowerPoint 2000 halts at the last slide in the presentation.
- Press Escape to return to the Normal view.

**13.12 Short Summary**

- PowerPoint is used to design presentations for a variety of mediums including computer-based display shows, overhead projection transparencies, and 35 mm slides
- The AutoContent Wizard is a presentation design wizard that contains sample data from which you can select and edit to create your customized presentation.
- You can set timings for your slides before you rehearse, or you can set them automatically while you rehearse
Lecture 14

Microsoft Access

Objectives

In this Lecture you will learn the following:

- What is Access?
- Database and Tables
- Data Access Page
- Working with Access Data and Database Design
# Coverage Plan

<table>
<thead>
<tr>
<th>Lecture 14</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.1 Snap Shot</td>
</tr>
<tr>
<td>14.2 Introduction</td>
</tr>
<tr>
<td>14.3 Terms and Definitions</td>
</tr>
<tr>
<td>14.4 Data Access Pages</td>
</tr>
<tr>
<td>14.5 Working with Data and Database Design</td>
</tr>
<tr>
<td>14.6 Short Summary</td>
</tr>
</tbody>
</table>
14.1 Snap Shot

In this lecture, you will learn about what are a Table, Query, Forms and Reports. In simple words what is an access or about access.

14.2 Introduction

Access is a full-featured relational database management system that is used by millions of people around the world. Database management programs are designed to store, manipulate and report large volumes of information. Typical examples of data include the information that comprises a telephone and address directory, large inventory databases order records, contact lists and much more. A common misuse of spreadsheet programs is that of data storage. However once people realize what can be done with a database management program they understand the folly of storing large volumes of data in spreadsheets. Like the other programs in the Office 2000 suite, Access makes use of all of the features available to programs designed specifically to run with a 32-bit operating system such as Windows 95/98 and Windows NT. As part of Office 2000, Access uses a number of shared Office resources as do the other applications. These include fonts, Clip Art spelling resources, AutoCorrect, and more.

As with other Office programs, Access can also integrate documents and information created by other Office and Windows programs. For example you can insert Excel spreadsheet documents directly into an Access table. The ease and flexibility of doing this is impressive. For example, you can cut a portion of a document created by another program and then paste it into an Access table. Or, you may prefer to “drag and drop” part of one document into another using your mouse. Finally, you may simply import one kind of document into another. This flexibility gives you the ability to work in ways that best suit your personal tastes.

14.3 Terms and Definitions

Database software comes with a lot of new terminology. This section clarifies some definitions that are specific to Access. Here, you’ll see the actual structure of a few different database tables. You also see how they are created and how information is entered into tables and ultimately displayed. The creation and use of these clarifies may database concepts in a relatively short time.
Databases and Tables

In Access, a database is a collection of information. Examples of databases include private telephone directories, lists of customers and suppliers, parts in a warehouse or store, and even private tape, book, and compact disk collections. The information in an Access database is retained in tables. Tables consist of rows and columns. Each row is called a record and pertains to a specific person or supplier, inventory item, or event. Each column contains a discrete element of information, called a field. A field might be a name, telephone number, stockkeeping unit number, unit cost, or any other piece of information. The following table example helps to illustrate records, fields, and some RDBMS concepts.

A tennis and swim club must maintain a database for each of its members. Within the database, different tables are used to store:

- Names, addresses, and telephone numbers (Member table)
- Billing information (Billing table)
- Detailed purchases and fees (Fees table)
- Tennis proficiency ratings (Rating table)

The first database table (Member table) contains names, member numbers, addresses, telephone numbers, dates of birth, and membership dates. The number can include member name and privilege codes. For example, the first letter of the member number is the first letter of the member’s last name. The last letter of the member number designates whether the member has a tennis (T) or swim (S) membership.

<table>
<thead>
<tr>
<th>Number</th>
<th>FirstName</th>
<th>MiddleName</th>
<th>LastName</th>
<th>SpouseName</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1465T</td>
<td>John</td>
<td>Gregory</td>
<td>Smith</td>
<td>Sheila</td>
<td>1234 Country Club Dr.</td>
</tr>
<tr>
<td>J1050S</td>
<td>Bill</td>
<td>T. Johnson</td>
<td>Betty</td>
<td></td>
<td>1112 San Pedro Avenue</td>
</tr>
<tr>
<td>S1300T</td>
<td>Lisa</td>
<td>Anne</td>
<td>Stanley</td>
<td></td>
<td>985 Trenton Circle</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>City</th>
<th>State</th>
<th>PostalCode</th>
<th>HomePhone</th>
<th>WorkPhone</th>
<th>Birthdate</th>
<th>Joindate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Houston</td>
<td>Texas</td>
<td>78905-3609</td>
<td>(713) 555-7890</td>
<td>(713) 232-2323</td>
<td>10/21/37</td>
<td>5/1/88</td>
</tr>
<tr>
<td>Cypress</td>
<td>Texas</td>
<td>78855-1005</td>
<td>(713) 555-6556</td>
<td>(713) 222-3333</td>
<td>1/24/63</td>
<td>6/1/95</td>
</tr>
<tr>
<td>Houston</td>
<td>Texas</td>
<td>78905-1015</td>
<td>(713) 555-1227</td>
<td>(713) 423-0908</td>
<td>3/29/50</td>
<td>11/1/96</td>
</tr>
</tbody>
</table>

The first line in the preceding table displays the name of each field. Then, three member records are shown. Notice how each field contains a different value.
Note:
The field list could be expanded to contain other information such as children’s names and ages, other affiliations, etc.

The Billing table contains billing information. Here, the total monthly charge accrued to each member’s account is maintained. This is used as a basis for each member’s monthly bill. It maintains the member number, total monthly charge, invoice date, and the date that the member’s payment is received.

<table>
<thead>
<tr>
<th>Number</th>
<th>Amount</th>
<th>Invoice Date</th>
<th>Payment Date</th>
<th>Amount Received</th>
<th>Past Due</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1050S</td>
<td>209.90</td>
<td>05/31/00</td>
<td>00/00/00</td>
<td>0.00</td>
<td>209.90</td>
</tr>
<tr>
<td>S1300T</td>
<td>210.00</td>
<td>05/31/00</td>
<td>06/08/00</td>
<td>210.00</td>
<td>0.00</td>
</tr>
<tr>
<td>S1465T</td>
<td>270.00</td>
<td>05/31/00</td>
<td>06/05/00</td>
<td>270.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

The billing information is derived from a third Fees table that itemizes membership charges for dues, food and beverages, league fees, tournament fees, pro shop merchandise, and other charges. These can be itemized on the member’s monthly statement.

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>Date</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>J1050S</td>
<td>Dues for May</td>
<td>5/31/00</td>
<td>35.00</td>
</tr>
<tr>
<td>J1050S</td>
<td>Service, Massage</td>
<td>5/01/00</td>
<td>5.00</td>
</tr>
<tr>
<td>J1050S</td>
<td>Food &amp; Beverage</td>
<td>5/05/00</td>
<td>16.40</td>
</tr>
<tr>
<td>S1300T</td>
<td>Pro Shop, Merchandise</td>
<td>5/31/00</td>
<td>148.50</td>
</tr>
<tr>
<td>S1300T</td>
<td>Dues for May</td>
<td>5/31/00</td>
<td>125.00</td>
</tr>
</tbody>
</table>

Finally, a Rating table is used to maintain tennis proficiency ratings for the tennis members. The ratings are used to place tennis members in the appropriate leagues.

<table>
<thead>
<tr>
<th>Number</th>
<th>Date</th>
<th>Rating</th>
<th>Rated By</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>S1300T</td>
<td>01/30/97</td>
<td>3.5</td>
<td>L. Byers</td>
<td>Needs to improve backhand</td>
</tr>
<tr>
<td>S1465T</td>
<td>02/06/97</td>
<td>4.0</td>
<td>L. Byers</td>
<td>Move to next league level</td>
</tr>
<tr>
<td>J1200T</td>
<td>03/16/97</td>
<td>3.0</td>
<td>L. Byers</td>
<td>Schedule lessons</td>
</tr>
<tr>
<td>A1080T</td>
<td>04/12/97</td>
<td>4.0</td>
<td>L. Byers</td>
<td>Strong serve and volley</td>
</tr>
<tr>
<td>S1465T</td>
<td>02/06/97</td>
<td>4.5</td>
<td>L. Byers</td>
<td>Nominate for 5.0 team</td>
</tr>
</tbody>
</table>

A unique field is used to tie all four databases together. The Name field might be considered, but there could be two or more members with the same name. Therefore, the Number field is used, because no two members have the same
number. Requests for information, or queries, can be made based on the member number. All four tables can be joined as if each member had one big record. However, since swim members don’t have tennis proficiency ratings, there’s no point in reserving space for empty fields. The same fact holds true for purchases. In addition to the member number, all that’s needed is the date, purchase amount, and a brief item description. Adding fields for the member’s address, phone number, or date of birth to each purchase record would be a duplication of information and a waste of disk space. This information already exists in the Member table. Therefore, the member number is used to tie charges in the Fees table to the Billing and Member tables.

Similarly, the Rating table contains member numbers, dates, ratings, the name of the person doing the rating, and comments. Tennis ratings are used to place players at the proper level for both tournament and league play.

**Forms**

Forms are designed to display certain fields and descriptive levels in a convenient format. For example, you can create a form that contains member names and telephone numbers. Here, you’ve omitted member number, address, and age information. A form lets you focus on the information you need without cluttering up the screen or printed output with unwanted text. Once a form is designed and saved, you can open and use it to add, edit or delete information within the corresponding table.

**Query**

A question about the data stored in your tables, or a request to perform an action on the data. A query can bring together data from multiple tables to serve as the source of data for a form, report, or data access page.

In a Microsoft Access database (.mdb), you can create a query, which is stored as a separate object and listed in the Database window. Or you can create a query as an SQL statement in the RecordSource property of a form, report, or a section of a data access page. An SQL statement is not listed in the Database window; it’s stored in a form or report in an Access database, or in a data access page outside the Access database.
In a Microsoft Access project (.adp), you can create a query as a view or stored procedure, which is listed as a separate object in the Database window. Or you can create a query as an SQL statement in the RecordSource property of a form, report, or a section of a data access page. Views and stored procedures are stored in the Microsoft SQL Server database, not in the Access project. SQL statements are stored in a form or report in the Access project, or in a data access page outside the Access project.

**Reports**

Reports are used to display and or print information. With Access you can produce spectacular reports by including graphics, charts and a variety of type styles and fonts. These features give Access may advantages over the old, DOS-based flat file database programs. Like a query a report is also a dynaset, as it is dependent on the current contents of supporting tables.

14.4 Data Access Pages

A data access page is a Web page that you can use to add, edit, view, or manipulate current data in a Microsoft Access database or an SQL Server database. You can create pages that are used to enter and edit data, similar to Access forms. You can also create pages that display records grouped hierarchically, similar to Access reports.

- Collect and distribute current data in several ways  You can use pages to add, edit, and view data within a Microsoft Access database or Microsoft Access project; you can use them on the Internet or on an intranet, and you can send them in e-mail.

- View grouped records interactively  On grouped pages, you can view just the details you want by expanding and collapsing group headers. You can also sort and filter records.

- Analyze data and make projections  You can organize data in different ways using a PivotTable list, make projections and do complex calculations using a spreadsheet control, and view data graphically in a chart.

- Display HTML text  You can store HTML code in fields in your database and display it as formatted HTML text on the page. For example, if a value
in a field includes the HTML tag that formats text as italic, <I>Text</I>, you can use a bound HTML control on the page to display the value in italic text.

- **Use familiar design tools**  In Design view, create pages using toolbars, the toolbox, themes, and other features that are similar to the tools you use to create forms and reports.

### 14.5 Working with Data and Database design

Microsoft Access 2000 provides many new features that make working with data and designing a database even easier.

- **Use record-level locking**  A Microsoft Access database now supports record-level locking, in addition to page-level locking (which locks all records on a 4K page). You enable the locking level with the new database option, Open databases using record level locking (Tools menu, Options command, Advanced Tab). The actual level that is used depends on how the Access database is programmed.

- **Find and replace**  You can now move freely between the Find and Replace dialog boxes and the data in the view or window.

- **View related data in a subdatasheet**  Use a subdatasheet to view and edit related or joined data in a table, query, or form datasheet, or in a subform all from the same view. For example, in the Northwind sample database the Suppliers table has a one-to-many relationship with the Products table; so for each row of the Suppliers table in Datasheet view, you can view and edit the related rows of the Products table in a subdatasheet.

- **Automatically fix errors caused by renaming fields**  Name AutoCorrect automatically corrects common side effects that occur when you rename forms, reports, tables, queries, fields, text boxes or other controls.

- **Take advantage of Unicode support**  Use the characters of any language that Unicode supports in your data. Use Unicode compression to offset the effect of Unicode's increased storage space requirements. Take advantage of dual-font support — specify a substitute font that you can use in addition to your default font to properly display all of the characters in your data.
Work with the euro To easily display euro amounts with other currencies, you can use the euro setting (#,###,##) of the Format property to indicate a euro amount. Alternatively, you can enter the euro symbol by pressing ALT+0128 on the numeric keypad with NUM LOCK on. When you paste or import data that contains the euro symbol from Microsoft Excel 2000 into Microsoft Access, Access stores the euro symbol regardless of the currency symbol defined in Regional Settings in Windows Control Panel. Finally, you can use the EuroConvert function to convert one currency to another by using the euro as an intermediary. More about working with the Euro.

Print relationships Print a report of the relationships in your Access database as they appear in the Relationships window.

Use the keyboard to manage relationships Use the keyboard to create, edit, and delete relationships and joins.

Use Microsoft ActiveX Data Objects (ADO) Use Microsoft ActiveX Data Objects (ADO) to access and manipulate data in a database server through any OLE DB Provider.

14.6 Short Summary

- Database management programs are designed to store, manipulate and report large volumes of information
- Database is Collection of Information. The information in an Access database is retained in tables. Tables consist of rows and columns.
- Each row is called a record and pertains to a specific person or supplier, inventory item, or event. Each column contains a discrete element of information, called a field.
- Forms are designed to display certain fields and descriptive levels in a convenient format.
- A question about the data stored in your tables, or a request to perform an action on the data
- Reports are used to display and or print information.
Lecture 15

Microsoft FrontPage

Objectives

In this Lecture you will learn the following:

- Microsoft FrontPage 2000 Controls
- The Web and Web Pages
- FrontPage Server Extension
- Creating your own WebPage.
## Lecture 15

15.1 Snap Shot

15.2 Introduction

15.3 Starting FrontPage

15.4 Microsoft FrontPage 2000 Controls

15.5 FrontPage Fundamentals

15.6 The Web and Web Pages

15.7 FrontPage Server Extensions

15.8 Creation your own WebPage

15.9 Short Summary
15.1 Snap Shot

When you complete the sections of this part, you should be able to create, save, and load web pages needed in your work or personal use.

15.2 Introduction

FrontPage is Microsoft’s web authoring tool. Using FrontPage, you can create a wide variety of web pages using the by now familiar wizard process. Or, you may elect to create web pages from scratch, using the rich selection of authoring tools. In either case, using a wizard or starting from scratch, you will find everything you need to generate that special personal or company web page.

15.3 Starting FrontPage

If you installed the Office toolbar, the easiest way to launch FrontPage is to click on the Frontage button. Otherwise, go to the Programs group (or the group in which you installed FrontPage) and start FrontPage by clicking the Microsoft FrontPage line. When FrontPage starts, the program begins with a blank page ready for you to begin work.

The first time you start FrontPage you are invited to review “What’s New,” and the Office Assistant offers help. If you are familiar with previous versions of FrontPage you may want to close the Office Assistant for now. Go to the Menu bar and click on Help, then click on Hide the Office Assistant. Now a FrontPage dialog will appear. Close the FrontPage dialog and compare your display to the following illustration, which labels the various parts of the FrontPage screen.

The above screen illustrates the Page view. If you wish, you can use the View menu to change the view. Detailed descriptions are found in the following sections of this book where you are guided through hands-on learning activities.
15.4 Microsoft FrontPage 2000 Controls

The keyed screen illustration shows each of the various controls which are summarized in the list that follows.

<table>
<thead>
<tr>
<th>Key</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Menu Bar</td>
<td>Used to access the FrontPage menus and the Office Assistant (Help).</td>
</tr>
<tr>
<td>2</td>
<td>Standard Toolbar</td>
<td>Includes buttons to perform the most frequently used file, editing, web and hyperlink, borders, inserting tables, charts and slides, zoom, and Office Assistant (Help) operations.</td>
</tr>
<tr>
<td>3</td>
<td>Formatting Toolbar</td>
<td>Includes buttons to perform the most frequent file formatting operations such as specifying fonts and font size; specifying text characteristics such as bold, italic, underling; text positioning (left margin, center, right margin); bullets and numbering, and formatting indentation operations.</td>
</tr>
<tr>
<td>4</td>
<td>Viewing Pane</td>
<td>Window pane displays the current html page you are working on.</td>
</tr>
<tr>
<td>5</td>
<td>Viewing Mode</td>
<td>Displays the various viewing modes available.</td>
</tr>
<tr>
<td>6</td>
<td>Status line</td>
<td>Displays messages.</td>
</tr>
</tbody>
</table>

15.5 FrontPage Fundamentals

FrontPage is Microsoft’s application program for creating web pages. Using FrontPage, you can create personal or business web pages with no previous experience. FrontPage utilizes the Microsoft wizard approach to help you create many styles and types of web pages with not much more effort than the click of a mouse button. However, to take full advantage of the opportunities offered by the Internet and to polish your pages for that finished professional look, some skill using HTML tags is necessary. This section does not endeavor to present HTML tags, or their format or usage.

You must have an Internet service provider or other web page-hosting server carry your web page before it can be viewed by other people. Just creating a web page does not automatically get you on the web. You must engage and get instructions from a service provider regarding the procedure for transferring the files, or “web pages,” from your computer to the service provider’s computer before you can boast of a “web page.”
15.6 The Web and Web Pages

Historically, “web” means the interconnection of the diverse computing resources around the world that form the Internet. Microsoft attempts to redefine web in the FrontPage application as a set of documents, always known elsewhere as “web pages,” that reside on your computer or some other computer. Microsoft’s use of the term “web” in FrontPage documentation can therefore be confusing if you are accustomed to the historical and normal usage of “web.” To avoid confusion, everywhere you see the term “web” in FrontPage and associated Microsoft documentation, mentally add the word “page” following “web” and there will be no confusion. For clarity, I use the terms “web” and “web page” in the historical sense. The use of the two terms in this section distinguishes between the interconnected computing devices (the web) and what is usually present on them (web pages).

15.7 FrontPage Server Extensions

FrontPage has many features that are only available if the server hosting the web page is using Microsoft’s FrontPage Server Extensions. Due to security reasons, many service providers do not allow FrontPage server extensions. You must check with your service provider and determine if extensions are enabled. If a web-based server is using the FrontPage Server Extensions, you can increase the functionality of the page by adding FrontPage elements such as hit counters, search forms, and confirmation fields. To ensure compatibility with
all servers whether using FrontPage Server Extensions or not, you can enable or
disable the commands relying on the presence of the server extensions on the
server. If you disable the server extensions for any particular page, the related
commands will be unavailable on the FrontPage menus.

To enable or disable FrontPage Server Extensions, click on the Tools | Page
Options menu selection, then click on the Compatibility tab of the Options
dialog. If you want to enable FrontPage Server Extensions, select the Enabled
with Microsoft FrontPage Server Extensions check box.

**Note:** If your service provider uses the FrontPage Server Extensions and you
check the Enabled with Microsoft FrontPage Server Extensions check box, the
following commands will be available:

- Hit Counter (Insert | Component menu selection)
- Search Form (Insert | Component menu selection)
- Confirmation Field (Insert | Component menu selection)

However, if you have checked the box and your service provider does not
support the extensions, the three extensions will not work even if you have
included them on your web page. In this case, clear the check box, and ask your
service provider what HTML tags you can include in your web page to provide
the same functionality.

**15.8 Creating your own WebPages.**

The following activity demonstrates the basic features of FrontPage by creating
a personal home page with a hyperlink to another personal page.

1. Begin by starting FrontPage. Click on Start | Programs | Microsoft FrontPage
   on the Windows taskbar.

2. Click on File | New | Page. In the New dialog, highlight the One-column
   Body with Contents and Sidebar selection. In the Preview area of the dialog
   (bottom right side), observe the location of the contents section (left side),
   the side bar (right side), and the body (in the center).
3. Click on **OK**. Your FrontPage display should resemble the following illustration.

4. Now click in any area where you wish to change the text, delete the text, and type in the text you want. Be careful though. When editing text in an HTML document, you will not necessarily get the results you have come to expect when editing other documents. For example, if the cursor is placed...
after the line “Title 1” and carriage return is pressed, a carriage return is inserted, but now the line spacing is different. Unless you understand HTML tags and can edit your document in native HTML language, you may be faced with a frustrating experience, as HTML formatting just doesn’t work the same as the usual DOC formatting. You can only use trial and error at this stage to get a result that may be close to what you are looking for. Usually, people just get tired of trying and accept things the way they are. Just go slowly, save often, and go back to an earlier version if you accidentally mess it up.

The following illustration shows what you can accomplish with a little patience and careful text editing. I inserted my new text on the same line before deleting the old text. If you adopt this method, you will notice that the text will word-wrap to the next line if at least one space is inserted in the new text. If there are no spaces in the text, word-wrapping does not happen and the body is pushed to the right. If you decide to place a carriage return to force a wrap, then the line spacing gets out of whack. Welcome to the world of HTML tags.

Look at the HTML code for the lines starting with “Childhood” and ending at “Education.” To see the HTML code, click on the HTML tab at the bottom of the screen. (To return to the normal view, click on the Normal tab at the bottom of the screen.) Scroll down the code until you see the following lines:
Note: An HTML tag refers to the text enclosed by lesser than (<) and greater than (>) signs. This text string is actually an instruction telling a browser program what to do.

The “</font></p> <p><font size="2">” is a result of entering the carriage return. The “<p>” tells HTML to insert a new paragraph, which results in a certain line spacing different from a new line when created from word-wrapping. So, be aware that strange things may happen. Unless you have the desire to learn the complexities of HTML, just chalk them up to the weird stuff computers do. However, if you do have a little patience and desire to learn at least some HTML, then look at your pages in the HTML view from time to time. With a little trial and error you can make changes to your page and observe the resultant HTML code changes by switching between Normal and HTML views, thereby learning which HTML tags perform a particular function.

Note: You can resize your pictures after inserting them by clicking on the picture, then dragging a corner handle toward the center of the picture to reduce the size or dragging it away from the corner to enlarge it. Be aware that the larger the picture the more time it takes to download. A recommended picture size is about 50K bytes maximum. Color pictures require more bytes than a gray scale or a black and white picture of the same size.

After some trial and error and maybe a little hair pulling you should have a home page resembling the previous illustration. Perhaps you used different headings or maybe you deleted some that were not useful for you. But in any case you now have a home page.

5. Save your home page by clicking on File | Save As. Enter a descriptive name such as MS University, then click on Save. We will now extend the functionality of your home page.

6. We wish for the Contents section of the home page to be hyperlinks to documents that provide additional detail regarding the appropriate headings. The “CIT” heading should link to a document that contains material relative to my life.
Highlight CIT, then right-click. Click on Hyperlink.

7. We are going to create a new HTML document that includes the “CIT” material and name it CIT. In the URL box, delete http:// and enter the path to where the “CIT” document will reside.

Note: My path is file://D:/My Documents/Books/Office2000/ FrontPage/CIT.htm. You do not need to add the file:///, as FrontPage adds it automatically. If you do not know your path, click on File|Save As in FrontPage, then click on the down arrow of the Save in box and write down the path to the folder that the document will be saved in. Be sure to include the filename at the end of the path. Then click on Cancel. However, when you load the files onto a web page server, the path name of the hyperlink must be where the document will be found on the server, not on your computer. You will need to change the path of all the hyperlinks when you are ready to load the pages onto the server. If your web page server is on the Internet, the path will begin with http://. If the server is a LAN, the path will be different. In any case, the service provider will give you the correct pathname. Then you have to reverify all the hyperlinks by using your browser and surfing your pages via the service provider connection. Remember if you need to change anything on a web page after you have loaded it onto a server, you must save the changes, then load the changed documents onto the server again, then refresh your browser’s view to be able to see the changes over the Internet.

Click on OK. On the “MS University” page, deselect “CIT” and observe that the text is now blue, signifying that the text is a hyperlink to another document, which still needs to be created.

8. Click on File|New|Page. In the New dialog click on the General tab, then highlight the Wide Body with Headings template. Click on OK.
9. Change the headings and text as desired. Again, place the cursor at the point you want to make changes, add the new text, then use the Delete key to delete the unwanted text. Do not use carriage returns. Let the text automatically word-wrap to maintain the line spacing. At any point you place the cursor you can insert pictures. Inserting a picture is the same in FrontPage as it is in Word (click on Insert|Picture|From File, then select the picture desired). Your “CIT” page should look something like the following illustration.

10. Save the document by clicking on File|Save As and typing in CIT in the filename box. Click on Save.
11. Now we want to go back to “MS University” document and check the validity of the “CIT” hyperlink. Click on Window in the menu bar and select the “MS University” document.

12. Click on File|Preview in Browser. You may see the following dialog if you have more than one browser loaded on your machine. Highlight the browser of choice and click on Preview.

![Preview in Browser dialog]

**Note:**
Using Netscape Navigator will give you a somewhat different view of the page due to formatting nuances between Explorer and Netscape. It is best to switch between the two browsers to achieve a result that is acceptable in both browsers, as both are commonly used.

13. Your browser should display your home page. Now click on the blue “MS University” hyperlink.

![Home page screenshot]
14. If you have entered the correct path to the “CIT” document in the “MS University” document “MS University” hyperlink, you should see your “CIT” page. Note the path to the document in the Address box of the browser.

15. Now we will add a way of returning to the home page from “CIT.htm.” On the “CIT.htm” document (click on Window and select the “CIT.htm” document if it is not the current view in FrontPage) scroll to the bottom of the page and place the cursor at the end of the last line of text. Press <Enter> twice. Type the word Home. Highlight “Home,” then press the right mouse button. Click on Hyperlink Properties. Add the path to the “MS University.htm” document in the box.

My path is file:///D:/My Documents/Books/Office2000/FrontPage/MyHomePage.htm. Click on OK.

16. Save the change just made to “CIT.htm” by clicking File | Save.

Now in the browser, click on Refresh (Explorer) or Reload (Netscape). Go to the “Home” hyperlink you just added to “CIT.htm” document and click on it. Your home page will load into the browser if the pathname to the home page was entered correctly in the “Home” hyperlink URL.
15.9 Short Summary

- You have learned how to create a web page and how to add links to navigate from one page to another.

- Following this general procedure, you can create any number of pages and link them together.

- Another technique is to add a “Back” link to navigate to the previously viewed page. Simply type the word “Back” somewhere on a document and add the correct path to the document as we did with the “Home” example using the Hyperlink Properties. Of course, you are not limited to just “Home” and “Back” hyperlinks.

- Experiment with the various templates and tools. If you are adventurous, you will soon be creating stylish and attractive page designs.
Lecture 16

Microsoft Outlook and Binders

Objectives

In this Lecture you will learn the following:

- Features Of Out Look
- Working With Calendars
- Working With Tasks
- Using Notes
- Using Binders
## Coverage Plan

### Lecture 16

16.1 Snap Shot

16.2 Features Of Outlook

16.3 Outlook Interfaces

16.4 Using Calendars

16.5 Using Tasks

16.6 Using Notes

16.7 Binders

16.8 Short Summary
16.1 Snap Shot

In this lecture you will be introduced to the world of Outlook, How to use calendars, Tasks, Notes, Binders and Making Web with Office 2000

16.2 Features of Outlook?

Outlook is a full-featured information management program used to organize information on your desktop and to share information with others. You can use Outlook to manage your messages, appointments, contacts, and tasks, as well as track activities, and view and open files.

Outlook information is organized in folders. When you first start Outlook, the Inbox folder is displayed. Use Mail’s Inbox and Outbox to read and send mail messages, meeting requests, and task requests.

To create a message, point to New on the File menu, and then click Mail Message.

You can also use Outlook in place of Windows Explorer to see the files on your hard disk. This is accomplished by clicking Other on the Outlook Bar, and then clicking My Computer, My Documents, or Favorites.

Outlook uses views to sort and organize items in a folder. Click a view in the Current View box on the Standard toolbar to display a different view.

You can use Microsoft Word and Outlook together to produce high-quality e-mail messages. You can turn Word on or off as your editor by closing any displayed message, clicking Options on the Tools menu, and then clicking the Use Microsoft Word as the e-mail editor check box on the E-mail tab of the Options dialog.

When Outlook help is started, a dialog is displayed. By clicking on “Finding out what’s new in Outlook 2000” you will be guided to another dialog that lists many of the new features not found in previous Outlook versions.

After clicking on “Finding out what’s new…” in the dialog that appears, Outlook help displays the “What’s new…” dialog. Click on any topic of interest
for a detailed explanation of the new feature and how it may improve your productivity.

With this overview in place, you’re ready to examine the component parts of Outlook.

16.3 Outlook Interfaces

**Mail**

Here you display and read your messages located in the Inbox, Outbox, or Sent Items folder. Just double-click on a message line to see the full text. Your messages can be printed, moved to another folder, archived, or deleted as appropriate.

![Outlook Window](image)

Fig Represents the OutLook Window

**Calendar**

The Calendar is displayed in day, week, or month format by simply clicking the corresponding toolbar button or View menu selection. You can also drag the calendar to see an entire year. The Calendar is used to make appointments, making an excellent daily, weekly, or monthly planner. You can also store notes with your appointments. Appointments are easily entered and viewed. It’s also a simple matter to move or delete appointments when the need arises.
Reminders can be set to alert you about a pending appointment. You can also set the reminder to give you an audible alarm in advance of a planned event.

**Tasks**

The Tasks feature lets you add, edit, and print details about planned projects and projects in progress. It ties your project to the calendar, making it easy to plan and update individual events, or tasks, associated with a project. All tasks that comprise a project can be assigned individual attributes, such as the planned and actual time required to complete a task, percent complete, and responsibility. You can group tasks in a number of different ways to provide a large variety of views of your projects and tasks. Once you’ve organized and entered your projects into Outlook, you can print and distribute your project plans to others in your work group. You can also use the information to guide you and those who work with you relative to which tasks require your attention as well as which ones are most critical or prerequisite to others.

**Contacts**

The Contacts portion of Outlook adds a full-featured address book and contact manager. You can enter names, addresses, telephone and fax numbers, e-mail addresses, notes, important dates, and more for all of your personal and business acquaintances. A fast find feature is also provided so you can jump directly to the entry you want to see. You can sort the contents of the address book in a variety of ways. It can be viewed in list format or as detailed information. You can enter and display the detailed information by accessing any of five tabs. These tabs are labeled Business, Phone, Address, Personal, and Notes. If you have a modem, you can even use the address book to dial selected telephone numbers.

**Journal**

The Journal portion of Outlook collects and displays an audit trail of the various documents on which you’ve worked. It collects the information by application, and displays each time that a document was opened and saved. Just click on an application button and scroll the time line horizontally to see the document names and corresponding dates. Double-click a document to open it via a shortcut.
Notes

The Notes portion of Outlook is like having access to “sticky notes” on your desktop. You can create a new note by clicking the New Note button on the Office 2000 Shortcut Bar. Type your note and save it for later reference. Notes are ideal for writing down ideas, questions, or reminders. Use the Notes portion of Outlook to view, print, and export your notes. You can click the Note button in the upper left-hand corner of the screen to print, delete, or create a new note without having to go through Outlook.

16.4 Using Calendars

Appointment calendars are used to enter and display appointments by day of the month and the starting and ending time of your appointment or meeting. You can select the desired appointment calendar by clicking the Day, Week, or Month buttons on the toolbar. You can also print appointments, which is useful if you are using a desktop computer and wish to carry a paper copy of your itinerary during your travels.

You may schedule appointments, meetings, and events using Outlook. The appointment, meeting, or event may be a single instance or it may be a recurring instance. Outlook views an appointment as a singular type of meeting between you and one other person—say, a dental appointment. A meeting is viewed as a gathering of more than two people at some location that can be specified, such as a specific conference room. An event is viewed as a daylong gathering. Using Calendar, you can easily track all your appointments, meetings, and events, even sending meeting invitations automatically to invitees using the messaging features of Outlook.

Menus and Toolbars

The menu bar and toolbars are the same as previously discussed in other parts of the book with two menu exceptions. The View and Actions menus contain Calendar-specific buttons. These two menus and the functions of their buttons are provided here.
Microsoft Outlook and Binders

View Menu

Current View — Changes the view to one of seven views or customize the view.

Go To — Goes to one of 12 destinations including Outlook applications.

Outlook Bar — Displays or hides the Outlook bar.

Folder List — Displays or hides all the Outlook folders.

Day — Displays the day view.

Work Week — Displays the five-day workweek view.

Week — Displays the seven-day week view.

Month — Displays the month view.

TaskPad View — Displays tasks.

Preview Pane — Displays or hides the preview pane.

Toolbars — Displays or hides the toolbars.

Status Bar — Displays or hides the status bar.
### Actions Menu

**New Appointment** — Creates and records a new appointment.

**New All Day Event** — Create and record a new all-day event.

**New Meeting Request** — Create and record a meeting request.

**Plan a Meeting** — Extend invitations to a meeting and display invitees’ schedules.

**New Recurring Appointment** — Create and record a new appointment that repeats at a specified interval.

**New Recurring Meeting** — Create and record a new meeting that repeats at a specified interval.

**Add or Remove Attendees** — Add and remove meeting attendees.

**Forward as iCalendar** — Forward calendar to recipient.

**Forward** — Forward icalendar to a recipient.

### 16.5 Using Tasks

Use Tasks to organize your business and personal to-do lists in one easy-to-manage place. Quickly sort and prioritize tasks, set reminders for when tasks are due, and assign tasks to others. To start Tasks, click on the Tasks button in the Outlook Shortcuts pane. To record a single new task, click on the File | New | Task menu selection when in any Outlook application.
To create a task in the Task application, click in the text box below subject in the Tasks pane (alternately choose File | New | Task), type a description, and press <Enter>. Then click on the task description and press <Ctrl+O>.

At this point you can enter details about your tasks, including a start date, due date, status, priority, percent complete, and comments about the task. Notice that the due and start dates make use of the calendar. Your tasks are displayed with your calendars as reminders of what needs to be done. The Tasks application also lets you put your to-dos in a number of different categories including Business, Personal, Phone Calls, and Time and Expenses. This is done by clicking the Categories button.

Once your task information is complete, click Save and Close. You can drag your tasks to adjust their position in the list. Dragging them is useful if you want to move only one or two tasks. If you need to move more than a couple, you can sort tasks using the View / Customize Current View menu selection. See the general procedure for sorting detailed below.

**Toolbars and Menus**

Below are the toolbars and menus associated with Tasks.

**Menu Bar**

The Menu bar and Standard toolbars include the usual and by-now-familiar File, Edit, View, Favorites, Tools, and Help buttons and task management tools. However, the toolbar does include one new item, the Actions menu. The Actions menu includes four tools, which are shown in the boxes below.

- Use this tool to create a new task for yourself.
- Use this tool to create a new task for someone else, such as a subordinate.
- Save the task order after ordering the tasks by some criteria, such as priority.
- Send the task to the person responsible for performing the task or to a higher level of management oversight.

**Views**

Pay particular attention to the View menu selections. The available view selections are described here.
Advanced Toolbar

The Advanced toolbar includes management tools for organizing and viewing the tasks.

Outlook Today — Change to the Outlook Today window.
Previous Folder — Return to the previous folder viewed if more than one is open.
Next Folder — Go to the next folder viewed if more than one is open.
Up One Level — Go to the next higher folder.
Folders List — Display/hide the list of folders in a pane on the left side.
Preview Pane — Display/hide the message preview pane.
Print Preview — Display a preview of the item as it will look printed.
Undo — Restore the previous configuration.
Current View — Select the task features the Task pane will display.
Group By Box — Group tasks by a selected column header.
Field Chooser — Select the field to sort tasks for display.
AutoPreview — Display/hide the task remarks.

Sorting

The following procedure is the general procedure for sorting tasks.

- Click on the View | Current View menu selection, and then click on a view that shows items in a table, card, or an icon view type.

- Click on the View | Current View menu selection again, and then click Customize Current View. You will see the following dialog.

- Click on Sort.

- In the Sort items by box, click on a field to sort by.

- If the field you want isn’t in the Sort items by box, click on a different field type in the Select Available fields from box.

- Click Ascending or Descending, as appropriate, for the sort order.
• To sort by an additional field, click on a field in the Then by box. The tasks are sorted using the Then by boxes’ criteria beginning with the uppermost box shown in the Sort dialog, then proceeding in order to the lowermost box.

• Sorting by more than one field sorts all items by the first field selected (the Sort items by selection at the top of the Sort dialog box) and then, within that sort, sorts again by the second field (the uppermost Then by selection in the Sort dialog box). For example, if you choose to sort alphabetically and then by number, the sort structure is A 1 2 3, B 1 2 3. A column created using a custom field or formula field can’t be sorted. The abbreviations RE and FW in the Subject box (the Regarding and Forward responses to messages) are ignored when you sort messages alphabetically by subject.

• If you are in a table view type, such as Detailed List, you can right-click a column heading to sort or group by the column or change the sort direction of the column. The following pop-up box appears when you right-click a column heading, offering not only sort choices but also formatting options.

• The View Summary dialog (accessed through View | Current View | Customize Current View) includes other useful task management tools. A description of the tools follows.

**Fields**—Use this dialog to select which fields are displayed in the task list. The Show Fields dialog is opened when you select the Fields button.

**Group By**—The Group By dialog lets you pick the way your to-do group is sorted and ultimately displayed. It provides for a four-variable sort. Just pick the first, second, third, and fourth variables and whether you want them sorted in ascending or descending order.

**Sort**—The Sort dialog lets you choose to sort by tasks within your groups. It also gives you a four-variable sort in either ascending or descending order.

**Filter**—Use this selection to filter your information so you can limit what is actually displayed in the task list. For example, you can filter out unwanted status information or you can choose to see only those tasks that are from or to a selected individual.
Other Settings—Set font size and types in column headings and row information. Select other cell options such as sizing and grid lines.

Automatic Formatting—Applies the formatting options selected in the View Summary dialog box to the task categories checked in the Rules For This View box. You can have each category with a different font or font size to distinguish it from the others if you wish.

Displaying Project Information

Project information can be displayed in a number of different ways. Displayed information depends on the Current View setting and the Columns, Group By, Sort, and Filter settings. Remember to use Sort after you make changes to rearrange your entries. Use the View|Filter menu selection to display or print focused reports that only show such categories as completed, not yet complete, overdue, etc.

Printing Your Information

Once a task list displays the content and order you like, you can print it. Use Page Setup to select the Table or Memo style. Use Print Preview to examine the resulting arrangement. If you want more information, use View|Current View menu selection and select the available views until you find one you like. Click the Print Preview button to examine the printed format. If you are satisfied with the appearance of your task list, click Print to send it to the printer.

Hands-on Activity

In this activity you create several task entries, change the way they are displayed, and then view them using Print Preview.

1. Select the Task icon to display Outlook’s Task application.

2. Set the View|Current View menu selection to Simple List.

3. Enter the information shown in the following illustration by double-clicking on a blank line in the Task pane or by clicking the New Task button on the Standard toolbar or by clicking the File|New|Task menu selection. Use the calendars to pick the month and day shown in the Due Date column.
Tip: If you are reasonably comfortable now using Office 2000, try entering a similar list of your own tasks and to-dos.

Note: The items with the strikeout through them are those items that are set to 100% complete in the % Complete box on the Task tab of the Task dialog. The user must set the percent complete. Also, the user can set the task as “Not started,” “In progress,” “Completed,” “Waiting on someone else,” or “Deferred” in the Status box.

4. Notice the Categories button on the Task tab is set to Personal. By clicking on the Categories button, you can set the task category to any one of several different categories, including Business. See the Categories dialog for a list of categories available. If you do not set the category, the task is in the default category defined as None.

Tip: When you click on the Categories button you will display the Categories dialog. Clicking on the Master Category List button will display the Master Category List dialog.

5. In the Master Category List dialog, you can enter a new category type such as My Category. Just type the new category name in the New category text box, then click on Add. Click on OK. If you want to delete a category, highlight it in the category text box, and click the Delete button. Then click OK.

6. Check your screen against the preceding illustration when you finish entering the tasks.

7. Use the View |Current View menu selection and the Print Preview button to examine different views of your information. The illustration shown is the Detailed List view.

8. Return to the list view; then use the File |Exit menu selection to exit Outlook.

Now that you know how to enter projects into Outlook, you can begin using it to store your tasks, company projects, and action items. You should examine all
of the available column categories to determine which ones best suit your needs.

16.6 Using Notes

Notes is a simple but extremely useful Outlook application. Outlook’s Notes are just like sticky notes. Use the Outlook Shortcuts pane and click on Notes to open the Notes pane. Double-click on a Notes icon and record a note.

Close the note by clicking the Close button. Review your notes by opening Outlook and selecting the Notes application. Then read and remove your notes or create new ones as desired.

Menus and Toolbars

The Notes menus and toolbars do not have much in the way of new tools or features. The Standard toolbar includes three new buttons that determine the display of the Notes icons. Everything else should be familiar by now.

Large Icons — Displays large Notes icons in the Notes pane.

Small Icons — Displays small Notes icons in the Notes pane.

List — Displays a list of notes in the Notes pane.

Large icons:
Small icons:
List:
Reading, Deleting, and Creating Notes

With the Notes application selected, you can examine all of your notes by simply looking at them. Beside creating new notes from the Office 2000 Outlook Shortcuts pane, you can also create a new note by pressing <Ctrl+N> (File|New|Note menu selection) from the Outlook Notes pane or clicking on the File | New | Note menu selection from any Outlook application.

The information at the top of a note is separated by the note’s body text with a carriage return. Just type a title and press <Enter>. Then type the text without using <Enter>—the text will automatically word-wrap. For example, the third note in the preceding illustration is shown as it is displayed in the Note application window. The text “Call Jim Hill” was typed on the first line and followed by <Enter>.

Double-click a note or select it and press <Ctrl+O> (for File | Open | Selected Items menu selection) to read the entire contents. In the example, the heading and content text is shown at the right.

Close a note by pressing <Esc> or clicking on the Close button in the upper right-hand corner of the note. Delete a note by selecting it in the Notes pane and pressing <Ctrl+D> or <Delete>.

Hands-on Activity

In this activity you create, display, and then delete a note. Begin by launching Outlook and choosing the Notes application.

1. Press <Ctrl+N> to open a new note.
2. Type My Note. Press <Enter>. Then type This is a note to myself.
3. Press <Esc> to close the note. Notice that it is displayed as the first note in the Notes window.
4. Double-click the new My Note note. Notice that it is displayed.
5. Click the Close button to close the note.
6. Select the note one final time and press <Delete>. The note is deleted.
7. Select File / Exit to exit Outlook.
16.7 Binders

Binders help to organize data by holding all the files and folders properly. The concept of binders could well be understood by producing an analogy of a normal binder in which all papers and documents are neatly placed. Binders have documents that are called Sections. You can use the menu bar that contains the option Go, or the Web toolbar in Office Binder to open the World Wide Web start Page or Search page to work with binders on the Internet.

Creating a Binder

You can create a new binder by selecting the MS Binder option from the Program group of the Taskbar’s Start button. A new blank document is displayed automatically. You can add documents, called Sections. Sections can be Excel Worksheets, a Word documents or PowerPoint presentations.

Outlook is intended to be your message center. You can use Outlook to send e-mail messages to and receive messages from users in your workgroup, users with accounts on your LAN or WAN, users who have Internet accounts or who use information services such as CompuServe.

To send a message, follow these steps:

1. Double-click on the Microsoft Outlook icon in your Windows screen to start Outlook with the Inbox displayed.
2. Click on the New Mail Message button in the toolbar to open the Message dialog box as shown in Fig.
3. **Fig** Represents the Message Dialog Box

![Message Dialog Box](image1)

**Fig** Represents the Select Names Dialog Box

4. Click on the **To** button to display the Select Names dialog box as shown in **Fig**

![Select Names Dialog Box](image2)

**Fig** Represents the Categories Dialog Box

![Categories Dialog Box](image3)
You can also assign each note an appropriate category such as Business, Holiday and so on. To do so, click the icon at the top-left corner of the note. Select the Categories option to display the Categories box. Select the appropriate category from those listed in the above dialog box as shown in Fig.

Outlook displays a list of notes in much the same way that it displays contacts, tasks, and so on.

You can display notes in various formats by opening the Current View list in the toolbar. You can select to display notes in the following ways.

- **As icons**
- **Listed with their creation dates**
- **Created within the last seven days**
- **By category**
- **By color**

With notes displayed in any format, you can double-click on an individual note to see it in the Notes Information Viewer.

**Adding Sections**

You can add documents or sections to your binder. To add sections to the binder, the steps are:

- **Select the Add option from the Section menu.**

This displays the Add Section dialog box. Whatever application document you select, the icon of that document gets displayed and its document window gets opened.

You can rename the section, which by default is given the name Section 1, Section 2 and so on.

You are allowed to open any document in the binder, cut and paste from one document to another, create links between sections and perform all operations that are permitted in Office applications.

Then the Print Binder dialog box gets displayed.
There are several options that are listed in the Print dialog box, these are:

➢ Print What: This enables you to print the required sections or section. It has two options called the All Visible Sections and Section(s) selected in the left pane.

➢ Numbering: It allows you to specify whether every section is consecutively numbered or each section page numbers restart. This is facilitated by the two options that it offers which are the Consecutive and the Restart each section options.

➢ Collates: This allows you to print copies in a sequence.

➢ Preview: Allows you to have a view of the pages before they are sent out for a final print out.

➢ Click on the OK button to send the sections for printing.

**Printing**

Binder has several options available for printing. You can print the active section, print headers and footers, all the sections in the binder, and so on.

**Printing the Active Section**

The current section can be printed in much the same way as a normal document would be printed except that the Print option is available not in the File menu but in the Section menu.

To print the active section, the steps are:

- Select the Print option from the Section menu.

- Specify the requirements in the Print dialog box that gets invoked.

- Click on the OK button.
Printing an Entire Binder

You can print multiple sections in a binder by selecting them before issuing the appropriate command, or you can print a few selected sections. The steps to print the documents in the binder are:

• Highlight the sections that you want to print by pressing the Shift key and clicking on the selected sections.

• Select the Print binder option from the File menu.

Sharing Binders

You can share your binders with the other users if you are working in a term as a group, or if you want your data to be available on the network. It is safer to share your binder than your files because it reduces the chances of the files being lost on other user’s hard disk or on the network. Send it, when you want others to review a copy of it online, one after the other. You can send to one recipient one after another, so that each recipient can see the previous revisions, or to all recipients at once. Post a binder to a Microsoft Exchange public folder when you want to make the binder available to others, but you do not want to send it through e-mail. You can also post a binder to a Microsoft Outlook folder.

Binders on the Internet

If you have access to the internet, you can open binders on the World Wide Web or anywhere on the internet. You can also add FTP sites to the list of available Internet sites. If your company has Internet, you can open binders there also. The Web toolbar is available in your office programs to make it easy to browse through documents that contain Hyperlinks. Use the Web toolbar to open a Start page or a Search page in your Web browser.
16.8 Short Summary

♣ You can use Outlook to manage your messages, appointments, contacts, and tasks, as well as track activities, and view and open files.

♣ Notes is a fairly simple Outlook application requiring little in the way of effort to learn or use. Notes is a handy desktop tool that helps you manage your daily tasks. Use Notes for reminders as you would a pen and paper.

♣ Binders help to organize data by holding all the files and folders properly.

♣ Office is also used to create Web pages.
Lecture 17

Exploring the Internet

Objectives

In this Lecture you will learn the following:

- Internet
- Internet Connection
- ISDN
- DNS
### Coverage Plan

#### Lecture 17

17.1 Snap Shot  
17.2 Introduction  
17.3 Web Servers & Clients  
17.4 Looking at Internet Connections  
17.5 Short Summary
17.1 Snap Shot

In this lecture You will learn about what is internet, and how to connect the internet, What are its various connections. These things will introduce you to the world wide web.

17.2 Introduction

If two or more computers are connected together with the capability of exchanging the information, it is called as Network. The networks that usually take the form of a small office network are called as Local Area Network (LAN). The networks that cover a city or some other large physical distance can be called Metropolitan Area Network (MAN) or, more generally, Wide Area Network (WAN).

The most obvious advantage of building networks include

- Communication (for example, e-mail)
- Information sharing (for example, database access)
- Resource sharing (for example, networked printers)

Typically networks are created in the hopes of saving money and increasing efficiency. Buying a laser printer for every computer in a large office, for example, would be cost prohibitive. A single laser printer shared across a network can save money and improve productivity.

Moving beyond a small office network to a large network, things get more complicated. Suppose a company has two LANs, one on the first floor of the building and one on the second that need to be joined together. This can be
done by drilling a hole in the floor, setting up some network equipment, and wiring the two networks. The resulting combination of networks has a special name – an *internet work*, or *Internet* in short.

An *internetwork*, or *Internet* is a collection of two or more distinct networks joined together, typically using a router, to form a larger “network of networks.”

Though the network that contains two or more distinct networks can be called as Internet, this name (Internet) is given to the worldwide collection of networks. The Internet is similar to the international telephone system – no one owns or controls the whole thing, but it is connected in a way that makes it work like one big network.

17.3 Web Server and Clients

**Web Server:**

The computers that host Web sites are called *servers*; their service is to provide the documents that the clients request. The software used on the physical computer to make it a server that can speak the protocols of the Internet and respond accordingly is called *Internet Server Software* or *Web Server* such as Microsoft Internet Information Server.

**Clients:**

*Clients* are the seemingly endless numbers of personal computers connected to the Internet. Web browser, such as Internet Explorer (see Internet Explorer bar) helps to exploit the Web. The way, by which the communication between *Server* and *Client* takes place, is via protocols. A protocol is a set of rules by which the client knows how to pass request for data to the server. Likewise, the server knows how to send responses back to the calling client. Protocols are useful because they don’t rely on platform specifics. A client doesn’t need to know the operating system of the *Server* and vice versa.

17.4 Looking at Internet Connection

Internet connections can be classified as connections for individual users or clients, and connections for servers. A typical client connection goes through an
ISP (Internet Service Provider). You get an account, attach a modem to your
computer, then dial into the ISP and log on. Once logged on, you can use a Web
browser to access the Web. ISPs are everywhere. They basically lease high-
bandwidth lines that connect into the Internet, then sublease the bandwidth to
Internet users and Web sites. Home users connect via modems over dial-up
lines to an access server at the ISP. This data link usually runs the PPP (Point-
to-Point Protocol), which encapsulates and delivers IP (Internet Protocol)
packets to the ISP’s site. IP is an internetwork protocol. It provides a
communication system that works across linked networks. The ISP then
forwards these through a router to the Internet. Businesses that want to set up
Web sites may also go through ISPs.

**ISDN**

Integrated Services Digital Network (ISDN) is an all-digital, circuit-switched
telephone system that was originally designed by the world’s telephone
companies and service providers as a replacement for the aging analog
telephone system. An all-digital system has many advantages, including
reliability, scalability and a good fit for data transmission. ISDN services can
provide end-to-end digital connectivity for consumers. ISDN requires special
ISDN phones that convert voice into digital data. The ISDN is built on two
main types of communication channels: B channels, which carry voice, data, or
images at a rate of 64 Kbps (kilobits per second), and a D channel, which carries
control information, signaling, and link management data at 16 Kbps. Standard
ISDN Basic Rate desktop services is called 2B+D.

**Dial-up or Leased Connection**

A dial-up line is a connection or circuit between two sites through a switched
telephone network (i.e., the telephone network). In the data communication
world, a dial-up line forms a link between two distant computers. There are
several variations to the dial-up account which provide different capabilities,
depending on the protocols used. All these connections require the Internet
Protocol, and are therefore called IP accounts. Dial-up connections are typically
used for individual client browsing and are not recommended for servers. A
connection to the Internet using a telephone line and modem can serve up to 10
simultaneous users. The transmission rate is typically 28,800 bits/sec with the
V.34 standard but higher rates (up to 56 Kbits/sec) are available for download
speeds.
A Leased line is a communication circuit that is set up on a permanent basis for an organization. For all practical purposes we refer to a leased line as a private dedicated circuit. These are fixed point-to-point connections that provide a fixed rate. An organization uses leased lines to build private networks that interconnect its remote sites or the sites of business partners. The downside of this is that companies can’t easily change their lines and the data rate is inflexible.

**Domain naming system**

Domain naming system (DNS) is a hierarchical client/server distributed database management system. In the DNS, the clients are called resolvers and the servers are called name servers. DNS servers are strategically located on the Internet of convert domain names to IP addresses. Your own Internet service provider may do this conversion or connect to a specific DNS server that does. When you type a domain name in a Web browser, a query is sent to the primary DNS server defined in your Web browser’s configuration dialog box. The DNS server converts the name you specified to an IP address and returns this address to your system. From then on, the IP address is used in all subsequent communications. The top-level domains are listed here

<table>
<thead>
<tr>
<th>Top-Level Domain</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COM</td>
<td>commercial</td>
</tr>
<tr>
<td>EDU</td>
<td>education</td>
</tr>
<tr>
<td>GOV</td>
<td>government</td>
</tr>
<tr>
<td>ORG</td>
<td>organizational</td>
</tr>
<tr>
<td>NET</td>
<td>networks</td>
</tr>
<tr>
<td>INT</td>
<td>International treaty organizations</td>
</tr>
<tr>
<td>MIL</td>
<td>U.S. military organizations</td>
</tr>
</tbody>
</table>

DNS address information is stored at many locations on the Internet, not just at one central depositary. These sites “reflect one another” so that similar users can obtain information from the DNS server closest to them.

### 17.5 Short Summary

- The networks that usually take the form of a small office network are called as *Local Area Network (LAN)*.
The networks that cover a city or some other large physical distance can be called *Metropolitan Area Network (MAN)* or, more generally, *Wide Area Network (WAN)*.

*Integrated Services Digital Network (ISDN)* is an all-digital, circuit-switched telephone system.

A *dial-up line* is a connection or circuit between two sites through a switched telephone network (i.e., the telephone network).

A *protocol* is a set of rules by which the client knows how to pass request for data to the server.
Lecture 18

Web with Office 2000

Objectives

In this Lecture you will learn the following:

- Intranet
- Overview Of Web Browsers
- Creating HTML
- Using Web Page Wizard in Word 2000
## Coverage Plan

### Lecture 18

<table>
<thead>
<tr>
<th>Section</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>18.1</td>
<td>Snap Shot</td>
</tr>
<tr>
<td>18.2</td>
<td>Intranet</td>
</tr>
<tr>
<td>18.3</td>
<td>Overview of Web Browsers</td>
</tr>
<tr>
<td>18.4</td>
<td>HTML</td>
</tr>
<tr>
<td>18.5</td>
<td>Creating Html files using Office 2000</td>
</tr>
<tr>
<td>18.6</td>
<td>Create Hyper Links</td>
</tr>
<tr>
<td>18.7</td>
<td>Short Summary</td>
</tr>
</tbody>
</table>
18.1 Snap Shot

In this lecture you will learn about Intranet and What is Hyper Text Markup Language, and How to use Web Page Wizard via Office.

18.2 Intranet

Network of Networks can also form an Intranet. Unlike Internet, which is a global network, Intranet is a private network. But it uses the Internet communication standards and tools to provide information to the restricted users. For example, a company may setup a Web site that is accessible only to its employees who are geographically separated.

18.3 Overview of Web browsers

Web browser, such as Internet Explorer (see Internet Explorer bar) helps to exploits the Web. The Web and its browser interface provide greater ease of use and richness of expression. The Web features many search and directory facilities. These include HotBot, Alta Vista, Yahoo, and dozens of others.

Microsoft Internet Explorer is a Web browser. Just as Microsoft Word is a tool to create and format documents, or Microsoft Excel is a tool to create spreadsheets and perform calculations, Internet Explorer is a tool to navigate and access, or “browse,” information on the web.

The Internet Explorer toolbar provide range of detailed functions and commands for managing the browser. The Address bar below the toolbar displays the address of the current Web page. Typing an address and hitting Enter in it will enable to visit to the page specified in the address. Clicking a hyperlink will also enable to jump to the new page.

18.4 Hypertext Markup Language (HTML) – The Base of the Web

HTML (Hypertext Markup Language) is the language that puts the face on the Web by helping to prepare documents for online publications. HTML documents are also called Web documents, and each HTML document is known as Web page. A page is what is seen in the browser at any time. Each Web site, whether on the Internet or Intranet, is composed of multiple pages. And it is
possible to switch among them by following hyperlinks. The collection of HTML pages makes up the World Wide Web.

**Hypertext and Hypermedia (Hyperlinks)**

Traditional text in the form of a book is typically defined as sequential or linear because there is an order in which the text must be read—page two follows page one, and so on. There are many advantages to this method of presenting information. It provides a logical sense of order. It can, however, be an inefficient way to access large bodies of information. (Imagine reading an entire 20-volume encyclopedia page by page to find a single relevant bit of information.)

A variety of mechanisms can speed a user’s search for information within documents. For example, a book such as this one uses an index, table of contents, and section headings to speed access to various bits of information. The index provides a mapping from an idea to a particular page in the document containing these related pieces of information. Non-sequential ways to access information such as footnotes, references, and indexes are useful ways to deal with navigating and organizing large bodies of related information. With the amount of information available for consumption, exploring an alternative to sequential access seems appropriate. This is where the idea of hypertext comes in.

A hypertext document is an electronic document that contains links to related pieces of information. It could be characterized as providing generalized footnotes.
18.5 Creating HTML Files Using MS Office

Web Page Wizard

1. Pull down the File menu and choose New

2. Select the Web Pages tab on the New dialog box and double click the Web Page Wizard

3. Click the Next button to move past the introductory text and view the first step of the wizard. In the Web site title box, enter a name for your new Web site. By default, the wizard uses the name you specify here to create a new folder in your my Documents folder.

4. Click Next to choose a navigation style for your default page. In the dialog box for this step the wizard asks whether you want to add a frame to your default page or create a separate page with links to your other pages.
• Vertical frame is your best choice if you are planning to add more than three or four pages to your Web site. In this design, all the linked pages appear in a navigation bar at the left of the page; when the user clicks one of the links in this frame, this page appears to its right. The vertical bar generally remains unchanged regardless of what page is shown in the main browser window.

• Horizontal frame is the right choice if your Web site is simple— with no more than three or four linked pages. In this design, the pages that appear when the user clicks a link are easier to read because they use the browser’s full width. As with the vertical frame, the horizontal frame generally remains unchanged regardless of what page is shown in the main browser window.

• Separate page uses no frames at all. This design is appropriate if you expect that anyone who reads your default page will want to choose only one of your linked pages. If you think users will want to explore several pages, use a frame instead, to make navigating easier.

1. Click Next to choose your lineup of pages. If you thought about this before you started, you can make short work of this step. The default page lineup consists of a Personal Web Page and two blank pages, but the choices in this dialog box give you many more options. You can add more blank pages, choose from specific page templates, or import Web pages you have already created. If you make a mistake, select an entry from the list and click the Remove Page button.
- Add New Blank Page creates a new page with absolutely nothing on it, and adds a hyperlink on the default page.

- Add Template Page shows the Web page Templates dialog box, which lets you add one of Word’s readymade Web page designs to your site. When you make a selection by clicking the name of a template in the list, you can see what that type of page looks like in the Word window behind the dialog box as shown in Fig.

- Add Existing File lets you browse for pages you have already created and add them to your new Web site. If you have already saved a collection of Word documents, Excel workbooks, or PowerPoint presentations in Web format, you can add them here, along with a Table of Contents page to make it easy for other people to open them by clicking a hyperlink.

2. Click Next to specify the order of pages in your site and give each page a title. Select any page and pause the Move Up and Move Down buttons to change the order in which it appears in the navigation frame. By default, each page has a dull generic name, like Personal Web Page or Left-aligned Column 3; select each page in turn, click the Rename button, and enter a more descriptive name. When you are finished, the dialog box should look something like the one in Fig.
3. Click Next to display the final step of the Web Page Wizard, which lets you choose a theme to give your Web site a consistent look. If you want to add a theme, click the Browse Themes button to display the dialog box shown in Fig. As you can see from this example, themes consist of fonts, bullets, background, and color schemes. Select a theme and click OK.

4. Click Finish to save all the pages you have created in the location you specified in step 3. Word loads and saves each page then finishes by loading the new Default.htm page ready for you to begin editing.
After running the Web Page Wizard, you can begin editing your new Web site instantly. Select the dummy text and placeholder graphics on this page and replace them with your own text, pictures, and drawings. To edit other pages in your site, click the hyperlinks.

18.6 Create Hyperlinks

You can create a hyperlink that goes to an existing file or to a new file. After you've specified a name for the new file, you can choose to open the file for editing immediately or come back to it later. Either way, the file is created for you.

Select the text or drawing object you want to display as the hyperlink, and then click Insert Hyperlink.

1. Do one of the following: To link to an existing file or Web page, click Existing File or Web Page under Link to. To link to a file that you haven't created yet, click Create New Document under Link to.

2. Do one of the following: If you clicked Existing File or Web Page in step 2, locate and select the file you want to link to. If you clicked Create New Document in step 2, type a name for the new file. You can also specify the path to the new file and choose whether you want to open the new file for editing now or later.

3. To assign a tip to be displayed when you rest the mouse over the hyperlink, click Screen Tip and then type the text you want. Word uses the path or address of the file as the tip if you do not specify one.

4. Click OK twice.

Notes

- You can quickly create a hyperlink to a Web page without knowing the address. Click Web page to switch to your Web browser, open the World Wide Web page you want, and then switch back to Word.
If you know the address to an existing Web page, you can type it directly into the document. For example, type www.microsoft.com, and Word creates the hyperlink for you.

18.7 Short Summary

♣ Unlike Internet, which is a global network, Intranet is a private network.

♣ Microsoft Internet Explorer is a Web browser

♣ HTML (Hypertext Markup Language) is the language that puts the face on the Web by helping to prepare documents for online publications

♣ You can create a hyperlink that goes to an existing file or to a new file
Computer Fundamentals and Office Automation

Lecture 1

Lecture 2

Lecture 3
StartButton-Programs-Documents-Setting-Find-Help-Run-Shut Down.

Lecture 4
Files & Folders-Configuring Printers-Installing Programs-System Tools

Lecture 5

Lecture 6

Lecture 7
Working with Text boxes & frame- Working with Pictures-Working with Objects-Inserting Place Comments-Working with Tables

Lecture 8
Working with Mail Merge-Working with Main Document-Merging Envelops & Labels
Lecture 9
Understanding Books & Sheets-Entering Work Sheet Data-Auto Fill -Editing Work sheet data

Lecture 10
Working With Work Sheets-Working With Ranges-Types Of References-Working With Formulas

Lecture 11

Lecture 12
Pivot Table-Using Scenarios To Perform What-If Analysis-Goal Seeking & Solver

Lecture 13
What is Power Point-Auto Content Wizard-Creating Presentation -Using Design Templates-Creating Blank Presentation-Inserting Objects-PowerPoint Views-Saving & Printing Your Works-Working With Colors & Transitions-About Slide Show Timings-Navigating During Presentation

Lecture 14
Introduction-Terms and Definitions-Database-Tables-Forms-Query-Reports-Data Access Page-Microsoft Access Project

Lecture 15

Lecture 16
Features Of Out Look-Outlook Interfaces- Using Calendars-Using Tasks-Using Notes-Binders
Lecture 17

Introduction-Web Servers & Clients-Looking at Internet Connections

Lecture 18

Intranet-HTML-Creating Html files using Office 2000-Create Hyper Links